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INTRODUCTION
Vision is the primary sense that allows us to understand the world. As we view photographs used 
by the mass media and visual arts we are exposed to some of the most complex ideas within 
our society. The ability to comprehend and communicate this visual information is a basic skill 
for students wishing to express themselves through the medium of photography. Knowledge 
and understanding of design and technique that relate to the creation of photographic images 
enables clarity of expression. These skills are presented as a structured educational framework to 
give students of photography a clear and discerning vocabulary for creative self-expression. The 
emphasis has been placed upon a creative rather than technical approach to the subject.

A STRUCTURED LEARNING APPROACH
The photographic study guides contained in this book offer a structured learning approach that will 
give students a framework for working on design projects and the photographic skills for personal 
communication. The study guides are intended as an independent learning resource to help build 
design skills, including the ability to research, plan and execute work in a systematic manner.  
Students are encouraged to adopt a thematic approach, recording all developmental work in the 
form of background work or study sheets. 

IMPLEMENTATION OF THE CURRICULUM
The guides contain a degree of flexibility in giving students the choice of subject matter. This allows 
the student to pursue individual interests whilst still directing their work towards answering specific 
design criteria. This approach gives students maximum opportunity to develop self-motivation.
The first three study guides that form the ‘Foundations Module’ are intended to be tackled sequentially 
and introduce no more technical information than is necessary for students to complete the work. 
This allows student confidence to grow quickly and enables less able students to complete all the 
tasks that have been set. The activities and assignments of the first three study guides provide the 
framework for the more complex assignments contained in the advanced section.
In the ‘Resources’ chapter of this book there are sections covering darkroom design and digital set-
up. The chapter also includes a work sheet and progress report which students can complete with 
the help of a teacher. This process will enable the student to organise their own efforts and gain 
valuable feedback about their strengths and weaknesses. 

PHOTOGRAPHIC EDUCATION
Stewart Mann in 1983 conducted extensive research to establish how photography was being 
used. He concluded that processing and printing from black and white negatives could consume 
most of the time available for students at school, giving them little time to consider ‘why and 
what should be photographed.’ Value, he found, was being given to form rather than content. 
‘Photography should be seen as a vehicle for visual communication not an exercise in times and 
temperatures. Teachers aims to use photography primarily as a means of creative expression 
were compromised by the emphasis upon how to produce a given result technically with less 
consideration given to why and what should be photographed.’ Stewart Mann. 1983
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INTRODUCTION TO STUDENTS
The study guides that you will be given on this course are designed to help you learn both the 
technical and creative aspects of photography. You will be asked to complete tasks including 
research activities and practical assignments. The information and experience that you gain will 
provide you with a framework for your future photographic work.

WHAT IS DESIGN? 
Something that has been designed is something that has been carefully planned. When you are 
set a photographic design assignment you are being asked to think carefully about what you want 
to take a photograph of, what techniques you will use to take this image and what you want to say 
about the subject you have chosen. Only when the photograph communicates the information that 
you intended, is the design said to be successful.
By completing all the activities and assignments in each of the study guides you will learn how 
other images were designed and how to communicate visually with your own camera. You will be 
given the freedom to choose the subject of your photographs. The images that you produce will 
be a means of expressing your ideas and recording your observations. 
Design is a process which can be learnt as a series of steps. Once you apply these simple steps 
to new assignments you will learn how to be creative with your camera and produce effective 
designs. 

USING THE STUDY GUIDES
The study guides have been designed to offer you support during your design work. On the first 
page of each study guide is a list of aims and objectives laying out the skills covered and how they 
can be achieved.
The activities are to be undertaken after you have first read and understood the supporting section 
on the same page. If at any time you feel unclear about what is being asked of you, consult a 
teacher. 

EQUIPMENT NEEDED
The course that you are following has been designed to teach you photography with the minimum 
amount of equipment. You will need a camera with manual controls for aperture and shutter speed. 
Consult your teacher or a photographic specialist store if you are in doubt. Many dealers can 
supply second-hand equipment complete with a guarantee at reasonable prices. Large amounts 
of expensive equipment will not make you a better photographer. Many of the best professional 
photographers use less equipment than some amateurs. There are some areas of photography, 
however, which do require some very specialist equipment. These include some areas of sport 
and wildlife photography where you are unable to get very close to your subject. If these areas 
are of particular interest, you will need to think carefully about which of these sporting activities or 
animals are possible with the equipment you intend to use. 
Access to a darkroom or computer and inkjet printer will be required if you are to have control over 
the production of the finished artwork.
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RESEARCH AND RESOURCES
The way to get the best out of each assignment is to use the activities contained in the study guides 
as a starting point for your research. You will only realise your full creative potential by looking at a 
variety of images from different sources. Creative artists and designers find inspiration for their work 
in different ways, but most find that they are influenced by other work they have seen and admired.

‘The best designers are those who have access to the most information.’ 
Stephen Bailey - former director of the Design Museum.  

GETTING STARTED
Start by collecting and photocopying images that are relevant to the activity you have been asked 
to complete. This collection of images will act as a valuable resource for your future work. By taking 
different elements from these different images, e.g. the lighting technique from one and the vantage 
point from another, you are not copying somebody else’s work but using them as inspiration for your 
own creation. Talking through ideas with other students, friends, members of your family and with a 
teacher will help you to clarify your thinking, and develop your ideas further.

CHOOSING RESOURCES
When you are looking for images that will help you with your research activities try to be very 
selective, using high quality sources. Not all photographs that are printed are necessarily well 
designed or appropriate to use. Good sources of photography may include high quality magazines 
and journals, photographic books and photography exhibitions. You may have to try many libraries 
to find appropriate material. Keep an eye on the local press to find out what exhibitions are coming 
to your local galleries.

Student study sheet
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PRESENTATION OF RESEARCH
In each assignment you are asked to provide evidence of how you have developed your ideas 
and perfected the techniques you have been using. This should be presented neatly and in an 
organised way so that somebody assessing your work can easily see the creative development of 
the finished piece of work. You should: 

Edit your proof sheet including any alterations to the original framing with a chinagraph 
pencil or indelible marker pen. Make comments about these images to show how you 
have been selective and how this has influenced subsequent image capture. You 
should clearly state what you were trying to do with each picture and comment on its 
success. You should also state clearly how any theme which is present in your work has 
developed. 

Make brief comments about images that you have been looking at and how they have 
influenced your own work. Photocopy these images if possible and include them with 
your research. Acknowledge the sources of your information (magazines, books, 
websites, etc.) and any primary sources such as gallery visits.
 
All proof sheets and photographs should be easily referenced to relevant comments using 
either numbers or letters as a means of identification. This coding will insure that the 
person assessing the work can quickly relate the text with the image that you are referring 
to. Research and all proof sheets should be carefully organised for presentation with the 
final work. 

PRESENTATION OF FINISHED WORK
The way you present your work can influence your final mark. Design does not finish with the print. 
Try laying out the work before mounting it on your card. Use rulers or a straight edge in aligning 
work if this is appropriate. Make sure the prints are neatly trimmed and that any writing has been 
spell-checked and is grammatically correct. 
Final work should be mounted on card using a suitable adhesive. Adhesives designed to stick 
paper do not work efficiently on resin-coated photographic paper. Photographic prints are normally 
either dry mounted using adhesive tissue and a dry mounting press or window mounted. Both 
are time consuming and require a fair amount of skill. A cheaper and quicker alternative is to use 
double-sided tape applied to each corner of the photograph. 
If you choose to write a title on the front of the sheet it is advisable that you either use a lettering 
stencil or generate the type using a computer. Be sure to write your name and project title on the 
back so the person assessing the work can return the work to you quickly.

STORAGE OF WORK
Assignment work should be kept clean and dry, preferably using a folder slightly larger than the 
size of your finished sheets. It is recommended that you standardise your presentation so that 
your final portfolio looks neat and presentable. Negatives should always be stored in negative 
file sheets in dry dust-free environments that will ensure clean reprints can be made if necessary. 
Digital files should be backed up on removable hard disks for storage.

~

~

~
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TALKING ABOUT IMAGES
In talking about photographs it is important to understand the fundamental principles. Everybody 
is allowed an opinion. Listening to people’s opinions helps us understand how different people 
view the world. Understanding how different people view the world helps us to create images that 
communicate clearly.

MIRRORS AND WINDOWS
Subjective analysis
When we talk about a photograph we may make a comment that can be said to be either ‘subjective’ 
or ‘objective’. A subjective comment is one that is someone’s ‘personal opinion’ (something that 
they feel to be true). Someone else may disagree with this opinion because they do not feel or think 
in quite the same way. For example, one person may say, ‘the sky in this image looks threatening’, 
whilst another person may gain only a sense of tranquillity from looking at the same image. No 
matter how they view this image they do not gain the sense of foreboding the first person saw. 
Because we are individuals with unique histories and experiences, the act of viewing an image 
may trigger different emotional responses in different people. When we create a photograph it can 
sometimes be seen to be acting as a ‘mirror’, reflecting who we are, as shaped by our personal 
experiences and unique character.
When you are discussing an image talk about any emotional responses you may experience. 
Comment on what the content means to you or what you understand to be happening. Refer to any 
personal connections to the subject matter you may have so that others can understand why you 
may feel this way. You may make an ‘aesthetic’ judgement of the image. Aesthetic appreciation 
is a little like musical taste. There is no right or wrong as it is a very personal issue. Above all be 
honest to yourself and respect the opinions of others.

Zarah Ellis
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CRUSHED DROWNED

Objective analysis
We can also make a comment about a photograph that cannot be disputed, because it is not 
coloured by our feelings or opinions. This observation about a photograph can be said to be 
‘objective’ as it is based on fact, e.g. ‘the boy in the photograph is sitting on the grass’. When we 
create a photograph that documents the world around us it can be seen as a ‘window’ looking out 
to the external world to inform people about indisputable facts. 
Discussions about a photographic image can start with a description of the explicit content of the 
image. You should state the context in which the image was presented if you are discussing an 
image that you have collected, e.g. gallery, magazine etc. List the visible elements of design and 
technique that were used by the photographer/picture-editor to capture or organise the image.

Note > Although the difference between subjective and objective analysis may seem clearly 
defined, many people who look at a photograph have trouble separating what is explicit and what 
is implicit. We must ask the question “what can I actually see, and what do I think I see? Concepts 
and ideas can be stated clearly in photographs using factual evidence (explicit communication) or 
merely implied or suggested (implicit communication).

seeing is   believing
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BURNED FELL

SEEING IS BELIEVING
Popular sayings such as ‘seeing is believing’ and ‘the camera never lies’ indicate a trust in the 
photographic image for presenting objective evidence. This perceived objectivity of photography 
by the public makes photography a powerful medium for communication by the media. Implied 
communication in photographs used by the media is used to reinforce ideas and concepts that 
they would often like us to view as evidence - evidence that buying the product will make us happy, 
or evidence that the event happened in the way that we were informed by the text. Very often we 
see only what we are guided to see by the supporting text.

Cause of Death - John Hilliard
‘This picture demonstrates how framing affects the way a photograph is read and how 
captioning spells out its meaning - offering elegant forensic evidence that, although 
the camera cannot lie, photographs tell different truths.’ Chris-Steele Perkins

seeing is   believing

Cause of Death - John Hilliard, 1974 - Arts Council Collection, Hayward Gallery, London
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VIEWING THE IMAGE OUT OF CONTEXT
Leonardo’s famous painting ‘The Mona Lisa’ in The ‘Louvre’ museum in Paris demands respect. 
We are expected to be in awe of the original master and appreciate the art, the value and the 
historical significance. Put a reproduction above your TV and the image at a glance may appear 
remarkably similar to that of the original (minus the gold frame), except that your wallpaper and 
your living room now surround it. The great work of art is stripped of its presentation and its 
relationship with the other great works of art it once shared its room with. The expectations for us 
to look carefully with admiration and appreciation are removed. The context in which we see an 
image makes a significant difference to how we respond to the image. When we present an image 
for discussion we must remember that we have removed it from its original context. 

Note > The original context is therefore an important ‘frame of reference’ that should be recorded 
in your background work or research.

PRESENTATION
Most people consume a large amount of ‘ephemeral’ (here today gone tomorrow) images each 
day. The person who creates an image and expects the viewer to study the image for longer than 
three seconds must often provide a cue or context so that the viewer understands the purpose 
or intention behind the image’s creation. Photographs are often passed around straight from a 
packet of 36 (traditional number) as part of a cultural communication pattern. Because we are 
used to having to view 36 we glance at them briefly because we know there are another 35 on the 
way. If you double the size of the image and present it either in a frame or in a folio you are telling 
people that the image has value - maybe only to you - but the image demands closer attention, 
comment and appreciation. When a single image cannot hope to communicate what it is you want 
to say a portfolio of images usually establishes connections and a dialogue that is very difficult in 
a single image. 

Note > Consider carefully how you will sequence and present your final images for viewing and/or 
assessment.

REACTION AND INTERPRETATION
There can be no guarantee that anyone will view and read an image you have created the way 
you would like them to. Images are full of visual ambiguity and uncertainty. The appreciation is 
subjective. It is subjective because the image has been removed from its original context and the 
intellectual and emotional history of the viewer may vary enormously from that of the photographer. 
Again the production of a body of work that is united as a portfolio or study can help to clarify your 
aims and objectives. An image by the master photographer Henri Cartier-Bresson removed from 
its book and viewed alone is a lot less powerful than a book of images that define Henri as the 
master of ‘the decisive moment’. A teacher or lecturer responding to your work can provide you 
with some technical feedback and some subjective opinions but the full power of the moment that 
you saw and responded to may well be lost - the teacher was not there.

Note > Everybody’s personal opinion or appraisal of your work is valid even if you disagree.
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THE PROCESS OF SELF-EXPRESSION
Why do we take photographs? Do we take them for other people to admire our skill? Do we take 
them as a record, document or as a trophy? Do we create them to advertise to our friends that we 
are having a beautiful, successful, enviable life, or do we create them for ourselves, a process of 
expressing how we feel to be alive in our world.
I create images because the act of looking helps me to slow down and actually look at the life I am 
living. It gets me ‘out of my head’ and into my world - it helps me to connect and appreciate what 
is around me, and this act helps me to express myself. Art is about expressing yourself. It doesn’t 
really matter if no one ‘gets it’ so long as it was a meaningful exercise to you. Buddhist monks 
make ‘Mandala’ paintings by pouring sand slowly and carefully to create intricate designs. They 
work on the art for days and then tip it into the sea when they are finished. The art is often about 
the process rather than the outcome. When someone appreciates your art it is indeed rewarding. 
Someone else understands us - someone else ‘gets it’ too.

SYMBOLS, METAPHORS AND SIMILES 
Poets to pack an emotional charge in just a few lines use symbols, metaphors and similes. The 
poem may require the reader to work a little harder at unravelling the meaning - the enjoyment 
however, for many, is in the unravelling - a literary crossword puzzle if you like. It’s a game not 
everybody enjoys, but the more you play the easier it gets. I am using a simile now to make my 
point. These literary tools can be used to extend the photographers visual language by using 
images that represent more than their face value.
Our world is filled with symbols. The juxtaposition (careful placing of one thing next to another) of 
content can change meaning in an extraordinary way. We don’t have to physically pick one thing 
up and place it next to the other. We can simply move ourselves until the different subjects are 
framed together.

Dreams will come true - Matthew Orchard
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CAPTIONS
Images are often used as evidence by the media to validate communication. The camera is seen by 
many as an objective tool for documenting our world. The subjective interpretation of photographic 
content however poses a problem for individuals wanting to create a specific message for a target 
audience. This subjective interpretation can be reduced or eliminated with the use of ‘captions’. 
Captions are used by the media to reinforce or validate the intended communication and may 
resolve any questions that we otherwise might have had. Captions are used to spell out the 
meaning that the photograph then confirms as fact. Very often we see only what we expect, or 
are guided, to see. In advertising the captions may convince us of a need, or the relevance of a 
fantasy to our lives, that is then made real by the photograph.

PUBLICITY
This century has seen an increasing reliance by the media to use visual images to communicate 
their messages. Our visual culture is now dominated by these media images. The ceaseless 
stream of images has defined the capitalist ideology of a consumer population. Before we can 
explore the subtleties of visual expression we must first learn to appreciate and understand the 
dominant communications of our time. 

‘Photographs are considered highly important sources of information but there is no requirement 
of literacy, from either those who view them or those that control their use. Advertisers, who 
put the pretty woman next to the car they are trying to sell, utilize an implied logic that, being 
nonverbal, is left unchallenged. Perhaps that is partially why photographic literacy is not 
encouraged - illiteracy works so well for advertising. If one knew how to read the images, the 
so called subliminal messages of advertising would be much more obvious: “Buy this car and 
the pretty woman will like you” is considerably less convincing when put bluntly.’

Fred Ritchin - In Our Own Image

Bring your own - Mark Galer



Foundation Module 





aims
     ~ To develop an awareness of how a photographic print is a two-dimensional   
 composition of lines, shapes and patterns.
     ~ To develop an understanding of how different ways of framing can affect both the  
 emphasis and the meaning of the subject matter.

objectives
     ~ Research - look at the composition of different photographs and the design   
 techniques used.  Record these observations and findings.
     ~ Analyse and evaluate critically - exchange your ideas and opinions with others.
     ~ Develop ideas - produce a study sheet that documents the progress and   
 development of your own ideas.
     ~ Personal response - produce and present photographic prints through close   
 observation and selection that demonstrate how the frame can create    
 compositions of shape, line and pattern and a personal theme.

                                       

Pavement - Gareth Neal

the frame
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INTRODUCTION
From photographs each of us can learn more about the world.  Images not only inform us about the 
products we never knew we needed, the events, people and places too distant or remote for us to 
see with our own eyes, but also tell us more about the things we thought we already knew.  
Most of us are too preoccupied to stand and look at something for any great amount of time.  We 
glance at something briefly and think we have seen it.  Our conditioning or desires often tell us what 
we have seen or would like to see.  When we look at a photograph of something ordinary, however, 
it may show us the object as we had never seen it before.  With a little creative imagination and a 
little photographic technique it is possible to release the extraordinary from the ordinary.

Bill Brandt in 1948 said that ‘it is the photographer’s job to see more intensely than most people 
do.  He must keep in him something of the child who looks at the world for the first time or of the 
traveller who enters a strange country.’

CHOOSING A SUBJECT
In order to photograph something that will be of interest to others you must first remove the blinkers 
and photograph something that is of interest to you.  Your first creative decision is an important 
one.  What will you choose to photograph?  Your first technical decision is how to frame it.

Fingers - Mark Galer
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COMPOSITION
FRAMING THE SUBJECT
A common mistake made by many amateur photographers is that they stand too far away 
from their subject matter, in a desire to include everything.  Their photographs become busy, 
unstructured and cluttered with unwanted detail which distracts from the primary subject matter. 
Subject matter can look unimportant and not worthy of closer attention and  there is also a danger 
that the photographer will not have control over the composition. 

The photograph above is a study of the human figure and also a composition of shape, tone and 
line.  There are three dominant shapes.  The woman’s leg, the man’s back and also the third shape 
which is created between the frame and the man’s back.  The act of framing a subject using the 
viewfinder of the camera imposes an edge that does not exist in reality.  This frame also dissects 
familiar objects to create new shapes.  The shapes that this frame creates must be studied 
carefully in order to create successful compositions. 
The powerful arc of the man’s back is positioned carefully in relationship to the edge of the frame 
and the leg of the woman is added to balance the composition.

Embrace - Eikoh Hosoe 1970
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FILLING THE FRAME
When the photographer moves closer, distracting background can be reduced or eliminated.  
There are less visual elements that have to be arranged and the photographer has much more 
control over the composition.  Many amateurs are afraid of chopping off the top of someone’s head 
or missing out some detail that they feel is important.  Unless the photograph is to act as a factual 
record the need to include everything is unnecessary.  

When the viewer is shown a photograph they have no way of knowing for sure what lies beyond 
the frame.  We often make decisions on what the photograph is about from the information we can 
see.  We often have no way of knowing whether these assumptions are correct or incorrect. 
The photograph above is of a father and child.  The protective hands of a father figure provide 
the only information most people need to arrive at this conclusion.  In order to clarify any doubt 
the photographer may have decided to move further back to include the whole figure.  The 
disadvantage in doing this would have been that the background would also begin to play a large 
part in the composition and the power of this portrait of a child and his father would have been lost.  
Photographers do have the option, however, of taking more than one photograph to tell a story.

ACTIVITY 1 
Look through assorted photographic books and observe how many photographers have 
moved in very close to their subjects.  By employing this technique the photographer is said 
to ‘fill the frame’ and make their photographs more dramatic.
Find two examples of how photographers seek simple backgrounds to remove unwanted 
detail and to help keep the emphasis or ‘focal point’ on the subject.

Father and Child, Vietnam - Marc Riboud/Magnum
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ACTIVITY 2
Read the following passage taken from the book The Photographer’s Eye by John 
Szarkowski and answer the questions below.

‘To quote out of context is the essence of the photographer’s craft.  His central 
problem is a simple one: what shall he include, what shall he reject?  The line of 
decision between in and out is the picture’s edge.  While the draughtsman starts with 
the middle of the sheet, the photographer starts with the frame.
The photograph’s edge defines content.  It isolates unexpected juxtapositions.  By 
surrounding two facts, it creates a relationship.  The edge of the photograph dissects 
familiar forms, and shows their unfamiliar fragment.  It creates the shapes that 
surround objects.
The photographer edits the meanings and the patterns of the world through an 
imaginary frame.  This frame is the beginning of his picture’s geometry.  It is to the 
photograph as the cushion is to the billiard table.’

Q.  What does John Szarkowski mean when he says that photographers are quoting ‘out of 
context’ when they make photographic pictures?

Q.  The frame often  ‘dissects familiar forms’.  At the end of the last century photography 
was having a major impact on Art.  Impressionist artists such as Degas were influenced by 
what they saw.  
Find an example of his work which clearly shows this influence and explain why the public 
might have been shocked to see such paintings.

THE WHOLE TRUTH?
Photographs provide us with factual information but sometimes we do not have enough information 
to be sure what the photograph is about.

Hyde Park - Henri Cartier-Bresson/Magnum

What do we know about this old 
lady or her life other than what 
we can see in the photograph?  
Can we assume she is lonely as 
nobody else appears within the 
frame?  Could the photographer 
have excluded her grandchildren 
playing close at hand to improve 
the composition or alter the 
meaning?  Because we are unable 
to see the event or subject that the 
photograph originated from we are 
seeing it out of context.
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The rule of thirds

SUBJECT PLACEMENT
When the photographer has chosen a subject to photograph there is often the temptation, 
especially for the untrained eye, to place the subject in the middle of the picture without considering 
the overall arrangement of shapes within the frame.  If the focal point is placed in the centre of 
the frame, the viewers eye may not move around the whole image and this often leads to a static 
and uninteresting composition.  The photographer should think carefully where the main subject is 
placed within the image, only choosing the central location after much consideration. 

‘A picture is well composed if its constituents - whether figures or apples or just 
shapes - form a harmony which pleases the eye when regarded as two-dimensional 
shapes on a flat ground.’ 

Peter and Linda Murray - A Dictionary of Art and Artists

THE RULE OF THIRDS
Rules of composition have been formulated to aid designers create harmonious images which 
are pleasing to the eye.  The most common of these rules are the ‘golden section’ and the 
‘rule of thirds’. 

Breaking the rules
Designers who are aware of these rules often break them by deliberately placing the elements 
of the image closer to the edges of the frame.  This can often be effective in creating ‘dynamic 
tension’ where a more formal design is not needed.

ACTIVITY 3
Find two examples of photographs that follow the rule of thirds and two examples that do 
not.  Comment briefly on why and how you think the composition works. 

The golden section is the name given to 
a traditional system of dividing the frame 
into unequal parts which dates back to the 
time of Ancient Greece.  The rule of thirds 
is the simplified modern equivalent.  Try to 
visualise the viewfinder as having a grid 
which divides the frame into three equal 
segments, both vertically and horizontally.  
Many photographers and artists use these 
lines and their intersection points as key 
positions to place significant elements 
within the picture.
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BALANCE
In addition to content a variety of visual elements such as line, colour and tone often influence a 
photographer’s framing of an image.  The eye naturally or intuitively seeks to create a ‘symmetry’ 
or a harmonious relationship between these elements within the frame.  When this is achieved 
the image is said to have a sense of ‘balance’.  The most dominant element of balance is visual 
weight created by the distribution of light and dark tones within the frame.  To frame a large dark 
tone on one side of the image and not seek to place tones of equal visual weight on the other side 
will create imbalance in the image.  An image that is not balanced may appear heavy on one side.  
Visual tension is created within an image that is not balanced.  Balance, although calming to the 
eye, is not always necessary to create an effective image.  Communication of harmony or tension 
is the deciding factor of whether balance is desirable in the image. 

ACTIVITY 4
Collect one image where the photographer has placed the main subject off-centre and 
retained a sense of balance and one image where the photographer has placed the main 
subject off-centre and created a sense of imbalance.  
Discuss the possible intentions of the photographer in creating each image.
Create four images, placing the focal point and/or visual weight in different areas of the frame.  
Discuss whether each image is balanced.

Tai Chi
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LINE
The use of line is a major design tool that the photographer can use to structure the image.  Line 
becomes apparent when the contrast between light and dark, colour, texture or shape serves to 
define an edge.  The eye will instinctively follow a line.  Line in a photograph can be described by 
its length and angle in relation to the frame (itself constructed from lines).

HORIZONTAL AND VERTICAL LINES     
Horizontal lines are easily read as we scan images from left to right comfortably.  The horizon 
line is often the most dominant line within the photographic image.  Horizontal lines within the 
image give the viewer a feeling of calm, stability and weight.  The photographer must usually be 
careful to align a strong horizontal line with the edge of the frame.  A sloping horizon line is usually 
immediately detectable by the viewer and the feeling of stability is lost.
Vertical lines can express strength and power.  This attribute is again dependent on careful 
alignment with the edge of the frame.  This strength is lost when the camera is tilted to 
accommodate information above or below eye level.  The action of ‘perspective’ causes parallel 
vertical lines to lean inwards as they recede into the distance.

SUGGESTED AND BROKEN LINE
Line can be designed to flow through an image.  Once the eye is moving it will pick up a direction 
of travel and move between points of interest.  The photograph above is a good example of how 
the eye can move through an image.  Viewers tend to look briefly at the adult hand holding the 
child’s, before quickly moving down the arm to the face.  The direction of the child’s gaze returns 
the viewer’s attention to the hands.  A simple background without distracting detail helps to keep 
our attention firmly fixed on this relationship.

Cambodian Refugee Camp - Burk Uzzle 
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DIAGONAL LINES 
Whether real or suggested, these lines are 
more dynamic than horizontal or vertical lines. 
Whereas horizontal and vertical lines are stable, 
diagonal lines are seen as unstable (as if they are 
falling over) thus setting up a dynamic tension or 
sense of movement within the picture.

CURVES
A curved line is very useful in drawing the viewer’s eye through the image in an orderly way.  The 
viewer often starts viewing the image at the top left-hand corner and many curves exploit this.  
Curves can be visually dynamic when the arc of the curve comes close to the edge of the frame 
or directs the eye out of the image.

ACTIVITY 5
Find two examples of photographs that use straight lines as an important feature in 
constructing the pictures’ composition.  
Find one example where the dominant line is either an arc or S-curve.
Comment briefly on the contribution of line to the composition of each example.
Construct an image where the viewer is encouraged to navigate the image by the use of 
suggested line and broken line between different points of interest.

Wil Gleeson 

Daimaru
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VANTAGE POINT
A carefully chosen viewpoint or ‘vantage point’ can often reveal the subject as familiar and yet 
strange.  In designing an effective photograph that will encourage the viewer to look more closely, 
and for longer, it is important to study your subject matter from all angles.  The ‘usual’ or ordinary 
is often disregarded as having been ‘seen before’ so it is sometimes important to look for a fresh 
angle on a subject that will tell the viewer something new.

When we move further away from our subject matter we can start to introduce unwanted details 
into the frame that begin to detract from the main subject.  Eventually the frame is so cluttered that 
it can look unstructured.  The careful use of vantage point can sometimes overcome this.  A high 
or low vantage point will sometimes enable the photographer to remove unwanted subject matter 
using the ground or the sky as an empty backdrop.

ACTIVITY 6
Find two examples of photographs where the photographer has used a different vantage 
point to improve the composition (e.g. Alexander Rodchenko and André Kertész).  
Comment on how this was achieved and how this has possibly improved the composition.

The Beach - Joanne Arnold 
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DEPTH 
When we view a flat two-dimensional print which is a representation of a three-dimensional scene, 
we can often recreate this sense of depth in our mind’s eye.  Using any perspective present in 
the image and the scale of known objects we view the image as if it exists in layers at differing 
distances.  Successful compositions often make use of this sense of depth by strategically placing 
points of interest in the foreground, the middle distance and the distance.  Our eye can be led 
through such a composition as if we were walking through the photograph observing the points of 
interest on the way.

In the image above our eyes are first drawn to the largest figures occupying the foreground on 
either side of the central doorway.  In a desire to learn more from the image our eyes quickly 
progress towards the figures occupying the middle distance.  Appearing as lazy sentinels the 
figures lean against the doorway and move our gaze towards the focal point of the photograph, 
the small girl holding her mother’s hand in the centre of the image.
The technique of drawing us into the photograph is used in many photographs and can be also be 
exploited using dark foreground tones that draw us towards lighter distant tones.  Photographers 
can also control how much of the image is seen ‘in focus’, which again can contribute to a sense 
of depth (see ‘Light > Depth of field’).

ACTIVITY 7
Find two photographs where the photographer has placed subject matter in the foreground, 
the middle distance and the distance in an attempt either to fill the frame or to draw our gaze 
into the image.  
Comment briefly on where you feel the focal points of these images are.

Doctor’s Waiting Room, Battersea, London 1975 - Ian Berry
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PRACTICAL ASSIGNMENT
Produce a set of six photographs investigating natural or man-made forms.  Your work 
should demonstrate how the frame can be used to create compositions of shape, line and 
pattern.  You should consider not only the shapes of your subject matter but also those 
formed between the subject and the frame.

CHOOSING A THEME
Your photographs should develop a clearly defined theme.  This could be several different 
ways of looking at one subject or different subjects that share something in common, e.g. a 
similar pattern or composition.  If you are unfamiliar with your camera choose a subject that 
will keep still, allowing you time to design the composition. 

A possible title for your set of prints could be:     

1. Patterns in nature.
2. Rhythms of life.
3. Urban patterns.

Your work should:

a) make use of differences in subject distance including some work at, or near, the   
    closest focusing distance of your camera lens; 
b) show that you have considered the rule of thirds;
c) demonstrate the creative use of line in developing your compositions; 
d) make use of different vantage points; 
e) show that you have thought carefully about the background and the foreground in  
 making your composition.

Note. Implement aspects of your research during your practical assignment.

RESOURCES
Basic Photography - Michael Langford.  Focal Press.  Oxford.  2000.
Black and White Photography - Rand/Litschel.  Delmar Learning.  2001.
Designing a Photograph - Bill Smith and Bryan Peterson. Watson-Gupthill Pubns. 2003.
Henri Cartier-Bresson: Masters of Photography Series. Aperture 2nd Edition. 1997.
Photography Composition - Tom Grill and Mark Scanlon.  Amphoto.  1990.
Photography - London and Upton.  Prentice Hall.  2001.
Principles of Composition in Photography - Andreas Feininger. Watson-Gupthill Pubns. 1973.
The Photographer’s Eye - John Szarkowski.  Little Brown and Co. 1980.
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Spiral Staircase - Tom Scicluna Arc - Tom Scicluna                                  
Many photographers use the lines and  
intersection points of the rule of thirds as 
key positions to place significant elements 
in the picture.

By tilting the camera the shapes and lines 
can be carefully organised within the frame. 
The dominant arc in this image sweeps the 
edge of the frame and exits at the bottom 
right-hand corner.

Staircase - Philip Leonard Stacked Chairs - Gareth Neal

A carefully chosen viewpoint can often reveal 
the subject as familiar and yet strange. A 
student has explored the interesting lines 
created by a stack of chairs.

Diagonal lines that appear in a picture, 
whether real or suggested, are more dynamic 
than horizontal lines. The diagonal lines have 
been arranged to enter the corners of this 
photograph.
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GALLERY

 

Wil Gleeson



aims

     ~ To develop knowledge and understanding of how the quality and direction of light  
 can change character and mood. 
     ~ To develop an awareness to the limitations of film and image sensors in recording  
 subject contrast.

objectives
     
     ~ Research - produce a study sheet that looks at the ‘atmospheric’ lighting of several
 different photographs and the lighting techniques employed by the photographers.
     ~ Analyse and evaluate - the effectiveness of the work you are studying and   
 exchange ideas and opinions with other students.
     ~ Discussion - exchange ideas and opinions with other students.
     ~ Personal response -  produce images through close observation and selection that  
 demonstrate how the quality of light and its direction affects communication.

light

Hands - Ashley Dagg-Heston



INTRODUCTION
Light is the photographer’s medium.  The word photography is derived from the ancient Greek 
words photos and graph meaning ‘light writing’.  In photography, shadows, reflections, patterns 
of light, even the light source itself may become the main subject and solid objects may become 
incidental to the theme. 

CREATING ATMOSPHERE  
Directional light from the side and/or from behind a subject can produce some of the most 
evocative and atmospheric photographs.  Most snapshots by amateurs, however, are taken either 
outside when the sun is high or inside with a flash mounted on the camera.  Both these situations 
give a very flat and even light which may be ideal for some colour photography but for black and 
white photography it all too often produces grey, dull and uninteresting photographs. 
Learning to control light and use it creatively is an essential skill for a good photographer.  When 
studying a photograph that has been well lit you need to make three important observations 
concerning the use of light:

1.  What type or quality of light is being used?
2.  Where is it coming from?
3.  What effect does this light have upon the subject and background?

Projection - Student photograph
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QUALITY OF LIGHT
Light coming from a compact source such as a light bulb or the sun can be described as having 
a very ‘hard quality’.  The shadows created by this type of light are dark and have well-defined 
edges. 
Light coming from a large source such as sunlight that has been diffused by clouds or a light that 
has been reflected off a large bright surface is said to have a very ‘soft quality’.  The shadows are 
less dark (detail can be seen in them) and the edges are not clearly defined.

The smaller the light source, the harder the light appears.
The larger the light source, the softer the light appears.

 

ACTIVITY 1
Look through assorted photographic books and find some examples of subjects lit by hard 
light and examples of subjects lit by soft light.  
Describe the effect the light has on the subjects’ texture, form and detail and the overall 
mood of the picture.

 
A single hard light positioned directly above 
casts deep shadows around the eyes giving a 
dramatic effect which complements the pose.  
Note how the hands add to the expression.
                

A soft light positioned high and to the right 
gives a flattering and glamorous effect.  Note 
the soft shadows from the glasses.   

Claire - Lorraine Watson Claire - Lorraine Watson
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DIRECTION OF LIGHT
The direction of light decides where the shadows will fall and its source can be described by its 
relative position to the subject.  The light may be high, low, to one side, in front of or behind the 
subject.
The subject may be lit by a single light source or more than one.  This additional light may be 
reflected back onto the subject from a nearby surface or may be shining directly onto the subject 
from a second light source, e.g. a flash mounted on or near the camera.

Broken Light - Kevin Ward 

ACTIVITY 2
Find an example of a photograph where the subject has been lit by a single light source and 
an example where more than one light has been used.  
Describe in each the quality and position of the brightest or main light and the effect this has on 
the subject. In the second example describe the quality and effect the additional light has.  
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SUBJECT CONTRAST
Contrast is the degree of difference between the lightest and darkest tones of the subject or 
photographic image. A high-contrast photograph is where the dark and light tones dominate over 
the mid-tones within the image. The highest contrast image possible is one that contains only two 
tones, black and white, and where no mid-tones remain. A low-contrast image is one where mid-
tones dominate the image and there are few if any tones approaching black or white.
Each subject framed by the photographer will include a range of tones from dark to light. The 
combined effects of quality of light and lighting direction give the subject its contrast.
It is contrast that gives dimension, shape and form to the subject photographed.

LIMITATIONS OF THE CAPTURE MEDIUM
The human eye can register detail in a wide range of tones simultaneously. Film and digital image 
sensors are unable to do this. They can record only a small range of what human vision is capable 
of seeing.

  

Cloud cover diffuses and softens the light leading to lower contrast. Shadows appear less harsh 
and with softer edges. The lighting may be described as being flat and the film or image sensor 
will be able to record all of the tones from black to white if the exposure is correct. When harsh 
directional light strikes the subject the overall contrast of the scene increases. The photographer 
may now be able to record only a small selection of the broad range tones.

 Increasing exposure will reveal more detail in the shadows and dark tones.
 Decreasing exposure will reveal more detail in the highlights and bright tones.

If the photographer wishes to photograph in harsh directional sunlight it is appropriate to increase 
the exposure from that indicated by the camera’s TTL light meter to avoid underexposure.  An 
additional one stop is usually sufficient to protect the shadow detail.

 If a subject is lit by harsh directional light increase the exposure by one stop  
 from that indicated by the TTL light meter.

High contrast Low contrast
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Most cameras take information for the light reading mainly from the centre of the viewfinder.  When 
you need to set the exposure for a subject that requires compensation you can:

1. Move in close so that your chosen subject fills the frame and set the exposure. Move back to  
 your chosen camera position and take the shot at the same setting.
2. Point the centre of the viewfinder away from the bright light, set the exposure and        
 reposition the camera. Some cameras have a memory lock to help you do this.

ACTIVITY 3
Find two images that have been shot into the light or included the light source.  
Explain how the photographer may have gone about taking a light meter reading for these 
photographs.

EXPOSURE COMPENSATION
When you take a light meter reading of a subject you are taking an average reading between the 
light and the dark tones you have framed.  The meter reading is accurate when there is an even 
distribution of tones, or the dominant tone is neither dark nor light.  It is very important that you 
‘compensate’ or adjust the exposure when the framed area is influenced by a tone that is dark, 
light or very bright.
If your subject is in front of a bright light, such as a window or the sky, the light meter will indicate 
an average reading between your subject and the very bright tone.  The camera’s meter will be 
influenced by this tone and indicate an exposure setting that will reduce the light reaching the film 
or image sensor.  In these situations you have to override the meter and increase the exposure to 
avoid underexposing the subject.

The Rhondda - Mark Galer
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DEPTH OF FIELD 
You can increase or decrease the amount of light reaching the film or image sensor by moving one 
of two controls.  By changing the shutter speed (the amount of time the shutter stays open for) or 
by changing the f-stop (the size of the aperture through the lens).
If you change the aperture, the final appearance of the photograph can differ greatly.  This will be 
the area of sharp focus in the scene, from the nearest point that is sharp to the farthest.  This is 
called ‘depth of field’. 

The widest apertures (f2, f4) give the least depth of field.
The smallest apertures (f11, f16) give the most depth of field. 
 

Try this simple experiment to help you understand depth of field.  Look at your hand at arm’s length 
in front of your eyes.  You will notice the room behind your hand is out of focus.  Similarly if you 
look at the far wall of the room, your hand will appear out of focus.  This is called ‘shallow depth 
of field’ and is how your camera will see it at the widest aperture.  If you progressively reduce the 
aperture value, known as stopping down, the amount that is in focus gradually increases until you 
reach f16 or f22 when you achieve ‘maximum depth of field’.  At this aperture it is possible to have 
both your hand and the wall in focus at the same time.  
When you look through your camera and adjust the aperture no change appears to take place.  
This is because the lens stays at its widest aperture to allow a bright viewfinder image and easy 
focusing.  The instant you depress the shutter the aperture closes to the f-stop you have selected.  
Some cameras have a ‘depth of field preview’ located near the lens which allows you to see the 
true extent of sharpness.

ACTIVITY 4
Find two examples of photographs which make use of maximum depth of field and two 
examples which have very shallow depth of field.  
Describe how the photographer’s selective use of aperture affects the subject in each of the 
photographs you have chosen.

Depth of field

 f8f16  f4
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BASIC STUDIO LIGHTING

The subject - this may have to be placed some distance from the backdrop if the subject and 
backdrop are to be illuminated separately.

Main light source - the position is optional depending upon the desired effect required.  If deep 
shadows are created by the main light they can be softened in one of three ways:

1. Reflector - this is used to bounce light from the main light back into the shadow areas.
2. Fill - this is usually a weaker light or one moved further away and is usually positioned by the 
camera.
3. Diffusion - the hard directional light can be softened at the source either by bouncing it off a 
white surface or by using tracing paper placed in front of the light itself.

Effects light - this can be shone onto the background to create ‘tonal interchange’.  This is a 
technique where the photographer places dark areas of the subject against light areas of the 
background and vice versa.
Alternatively the effects light can be shone directly onto the back of the subject so as to ‘rim light’ 
otherwise dark areas.  Care must be taken to avoid shining the light directly into the camera lens.  
This is usually achieved by placing the effects light low or obscuring the light directly behind the 
subject itself.

Camera

�

Main light�
�

�
Subject

Reflector

Effects light�

Backdrop

Fill light
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PRACTICAL ASSIGNMENT
Produce a set of six prints that express your feelings towards one of the following titles:

1.  Shadows and silhouettes.
2.  Broken light.
3.  The twilight hours.
4.  Face and figure.

Your final work should develop the insight gained from all areas of your research and should 
include investigations into both natural and artificial light.  Try experimenting with window light, 
studio lights, projected images, light bulbs, candles, torches etc. 
If you are having difficulty thinking of a suitable subject try working with another student using each 
other as ‘models’.  You may decide to use some other person for the final piece of finished work.

PRESENTATION OF WORK
Research and all contact prints should be carefully mounted on large sheets of paper or thin card.  
Explanatory notes and comments should be made directly onto this sheet or on paper and glued 
into place.  You should edit your proof sheet including any alterations to the original framing with 
a chinagraph pencil or indelible marker pen.  You should clearly state what you were trying to do 
with each picture and comment on its success.  Proof sheets and photographs should be easily 
referenced to relevant comments using either numbers or letters as a means of identification.  You 
should clearly state how your theme has developed and what you have learnt from your research 
and how this has contributed towards your final set of prints. 

RESOURCES
Basic Photography - Michael Langford.  Focal Press.  Oxford.  2000.
Black and White Photography - Rand/Litschel.  Delmar Learning.  2001.
Photography Composition - Tom Grill and Mark Scanlon.  Amphoto.  1990.
Photography - London and Upton.  Prentice Hall.  2001.
Photographic Lighting - Child/Galer. Focal Press.  Oxford.  2001.
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Hands 1 - Sanjeev Lal

Using a single hard light source the student 
has taken care to frame the subject in a 
dynamic way. Note how the hands add to 
the expression of the portrait.

Embrace - Rew Mitchell

Hard light, positioned above and left, is used 
to create this dramatic study of the human 
figure.  The arms are used to create a frame 
within a frame.

Gareth - Tom Scicluna

The contours of the face break the pattern 
of light being shone from a slide projector 
positioned to the right of the face. 

Furniture Constructions - Daniel Cox 

A single light pointing back towards the 
camera has been placed behind the 
figure sitting in the chair.  The student has 
rearranged the order of the chair frame, its 
cover and the sitter.
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To develop an understanding of how a photograph can describe a subject over a 
period of time as selected by the photographer.
To develop an appreciation of how the selected period of time or ‘shutter speed’ can 
affect the visual outcome of the print.

Research - produce a study sheet that looks at the effect that varying the shutter 
speed has on a moving subject.
Analyse and evaluate critically - exchange ideas and opinions with other students 
on the work you are studying.
Develop ideas - produce a study sheet that documents the progress and 
development of your own ideas
Personal response - produce a series of photographic prints that explore a moving 
subject by using a variety of techniques and shutter speeds. 

Movement - Renata Mikulik

aims 
     ~

     ~

objectives
     ~

     ~

     ~

     ~

time
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INTRODUCTION
All photographs are time exposures of shorter or longer duration, and each describes an 
individually distinct parcel of time.  The photographer, by choosing the length of exposure, is 
capable of exploring moving subjects in a variety of ways. By choosing long exposures moving 
objects will record as blurs.  This effect is used to convey the impression or feeling of motion.  
Although describing the feeling of the subject in motion much of the information about the subject 
is sacrificed to effect.  By selecting fast shutter speeds photographers can freeze movement.  We 
can see the nature of an object in motion, at a particular moment in time, that the human eye is 
unable to isolate.

Greek Girl - Henri Cartier-Bresson/Magnum

THE DECISIVE MOMENT
Henri Cartier-Bresson in 1954 described the visual climax to a scene which the photographer 
captures as being the ‘decisive moment’. In the flux of movement a photographer can sometimes 
intuitively feel when the changing forms and patterns achieve balance, clarity and order and when 
the scene becomes, for an instant, a well-designed picture. 

ACTIVITY 1
Look at a Henri Cartier-Bresson photograph and discuss why you think that capturing the 
decisive moment has added to the picture’s quality.
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FAST SHUTTER SPEEDS
By freezing thin slices of time, it is possible to explore the beauty of form in motion.  A fast shutter 
speed may freeze a moving subject yet leave others still blurred.  The ability to freeze subject 
matter is dependent on its speed and the angle of movement in relation to the camera.  For subject 
matter travelling across the camera’s field of view, relatively fast shutter speeds are required, 
compared to the shutter speeds required to freeze the same subject travelling towards or away 
from the camera.

LIMITATIONS OF EQUIPMENT  
Wide apertures in combination with bright ambient light and/or fast film or high ISO setting allow 
the use of fast shutter speeds in order to freeze rapidly moving subject matter.  Some telephoto 
and zoom lenses only open up to f4 or f5.6.  If used with a slow or medium-speed film, or image 
sensor set to a low ISO setting, there is usually insufficient light to use the fastest shutter speeds 
available on the camera. 

ACTIVITY 2 
Find an example of a photograph where the photographer has used a very fast shutter speed 
and describe the subject matter including the background.  Discuss any technical difficulties 
the photographer may have encountered and how he or she may have overcome them.
Discuss what has happened to the depth of field and why. 
Discuss whether the image gives you the feeling of movement stating the reasons for your 
conclusion.

Songkran Festival
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PANNING
Photographers can follow the moving subject with the camera in order to keep the subject within 
the frame.  This technique called ‘panning’ allows the photographer to use a slower shutter speed 
than would otherwise have been required if the camera had been static.  The ambient light is often 
insufficient to use the very fast shutter speeds making panning essential in many instances.  
For successful panning the photographer must aim to track the subject before the shutter is 
released and follow through or continue to pan once the exposure has been made.  The action 
should be one fluid movement without pausing to release the shutter.  A successful pan may not 
provide adequate sharpness if the focus is not precise. In order to have precise focusing with a 
moving subject the photographer may need to use a fast predictive autofocus system or pre-focus 
on a location which the moving subject will pass through.

 

ACTIVITY 3
Take four images of a running or jumping figure using fast shutter speeds (faster than 
1/250 second).  Vary the direction of travel in relation to the camera and attempt to fill the 
frame with the figure.  Examine the image for any movement blur and discuss the focusing 
technique used.
Take four images of the same moving subject using shutter speeds between 1/15 and 1/125 
second.  Pan the camera to follow the movement.  The primary subject should again fill the 
frame. Discuss the visual effect of each image.

Bird in Flight - Jana Liebenstein
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SLOW SHUTTER SPEEDS
When the shutter speed is slowed down movement is no longer frozen but records as a streak.  
This is called ‘movement blur’.  By using shutter speeds slower than those normally recommended 
for use with the lens, movement blur can be created with relatively slow moving subject matter.  
Speeds of 1/30, 1/15, 1/8 and 1/4 second can be used to create blur with a standard lens.  If 
these slow shutter speeds are used and the camera is on a tripod the background will be sharp 
and the moving subject blurred.  If the camera is panned successfully with the moving subject 
the background will provide most of the blur in the form of a streaking effect in the direction of the 
pan.

CAMERA SHAKE
Movement blur may also be picked 
up from camera movement as a result 
of small vibrations transmitted to the 
camera from the photographer’s hands.  
This is called ‘camera shake’.  To avoid 
camera shake a shutter speed roughly 
equal to the focal length of the lens is 
usually recommended, e.g. 1/30 second 
at 28mm, 1/60 second at 50mm and 
1/125 at  135mm.  Many cameras give an 
audible signal when shutter speeds likely 
to give camera shake are being used.
With careful bracing, slower speeds 
than those recommended can be used 
with great success.  When using slow 
shutter speeds the photographer can 
rest elbows on a nearby solid surface, 
breathe gently and release the shutter 
with a gentle squeeze rather than a 
stabbing action.

Daimaru 

ACTIVITY 4
Find a photograph where the photographer has used a slow shutter speed and describe the 
subject matter including the background.  Discuss any technical difficulties the photographer 
may have encountered and how these may have been overcome.
Discuss what has happened to the depth of field and why.
Discuss whether the image gives you the feeling of movement stating the reasons for your 
conclusions.
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PHOTOGRAPHIC TECHNIQUES
VERY LONG EXPOSURES
For this technique you will need to mount the camera on a tripod and release the shutter using a 
cable.  You should select the smallest aperture possible on your camera lens, e.g. f16 or f22, and 
use a slow film such as 50 ISO or choose a low ISO setting for the image sensor.  The shutter 
speed can be further extended by the addition of a light reducing filter such as a neutral density 
filter or polarising filter.

SLOW SHUTTER SPEEDS
For this technique you can either hold the camera or mount the camera on a tripod.  By using 
shutter speeds slower than those recommended for use with the lens you are using you can create 
blur from moving objects.  If you are using a standard lens try shooting a moving subject at speeds 
of 1/30, 1/15, 1/8 and 1/4 second.  If the camera is in a fixed position on a tripod the background 
will be sharp but if the camera is panned with the subject the background will produce most of the 
blur.  Try shaking the camera whilst exposing to increase the effect even more.

FAST SHUTTER SPEEDS
For this technique you need to select a wide aperture. Some telephoto and zoom lenses only open 
up to f4 so you will need to attach a lens that will allow you to open up to f2.8 or wider.  Once you 
have selected the aperture take a light meter reading of your subject.  If your indicated shutter 
speed is only up to 1/250 second then you must do one or both of the following.  Either increase 
the amount of illumination reaching the subject and/or use a faster film or image sensor set to a 
higher ISO.

Charlie Sublet
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MULTIPLE EXPOSURES 
This can be achieved in the following ways: 

1.  Some modern film cameras have a multiple exposure function. If you have a ‘classic style’ 
camera that does not have this function double exposure may still be possible.  After loading the 
film but before the exposure, rewind the film using the rewind crank so that there is no slack in the 
film (do not depress the rewind button at this stage).  Place some masking tape or similar over 
the rewind crank to prevent the film moving.  If the background is illuminated or you are shooting 
outdoors you will need to reduce the exposure, i.e. reduce the aperture by one stop for two 
exposures and two stops for four exposures. After each exposure and before you wind on to cock 
the shutter for the next exposure you must depress the film rewind button which is usually on the 
camera base.  If you are shooting against a black background in a studio and the subject is moving 
away from its original location it will not be necessary to reduce the exposure.

2.  Multiple exposures can also be achieved using flash equipment.  This is best achieved in a dark 
studio using a black background.  The camera can be mounted on a tripod and the shutter fired 
using a cable release.  The camera’s shutter speed dial should be set to B and the cable release 
kept depressed until the desired number of flashes has been fired.  Allow the flash to recharge 
after each firing.  The flashgun will need to be fired manually and you should also ensure you have 
set the correct aperture on the lens as indicated by your flashgun or flash meter.  See the section 
about working with flash in this study guide for more information.

Hock-Loong Goh
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ZOOMING
For this technique you need to use a lens that can alter its focal length, i.e. a zoom lens.  A slow 
shutter speed should be selected, e.g. 1/15, 1/8 or 1/4 second.  The camera can be mounted on a 
tripod.  The effect of movement is achieved by making the exposure whilst altering the focal length 
or zooming the lens either in or out. The subject does not need to be moving.  Bright highlights 
and/or bright colours increase the visual effect.

MANIPULATION IN THE DARKROOM
A stationary subject or one that has been frozen using a fast shutter speed can be blurred by 
moving the print slowly during the final seconds of exposure in the darkroom.  Movement or time 
passing can also be achieved by using David Hockney’s ‘Joiner’ technique.

LIMITATIONS OF SEMI-AUTOMATIC
When selecting shutter priority mode on a built-in metering system the photographer must take 
care not to underexpose images.  Excessively fast shutter speeds for the available light may 
require an aperture greater than that available on the lens.
When selecting aperture priority mode on a built-in metering system the photographer must take 
care not to overexpose images.  Excessively wide apertures to create shallow depth of field in 
bright light may require shutter speeds faster than that available on the camera.

ACTIVITY 5
Create four images that contain a mixture of solid (sharp) and fluid (blur) form. 

Zooming
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FLASH PHOTOGRAPHY
Flash is the term given for a pulse of very bright light of exceptionally short duration (usually shorter 
than 1/500 second).  When additional light is required to supplement the daylight, flash is the most 
common source used by photographers. It is especially difficult to master flash photography with 
film cameras because the effects of the flash cannot be seen until the film is processed.
Most flash units available are able to read the reflected light from their own flash during exposure.  
This feature allows the unit to extinguish or ‘quench’ the flash by a ‘thyristor’ switch when the 
subject has been sufficiently exposed.  When using a unit capable of quenching its flash, subject 
distance does not have to be accurate as the duration of the flash is altered to suit.  This allows 
the subject distance to vary within a given range without the photographer having to change the 
aperture set on the camera lens or the flash output.  These sophisticated units are described as 
either ‘automatic’ or ‘dedicated’.

AUTOMATIC FLASH
An automatic flash unit uses a photocell mounted on the front of the unit to read the reflected 
light and operate an on-off switch of the fast acting thyristor type.  The metering system works 
independently of the camera’s own metering system.  If the flash unit is detached from the camera 
the photocell must remain pointing at the subject if the exposure is to be accurate. 

DEDICATED FLASH
Dedicated flash guns are designed to work with specific cameras.  The camera and flash 
communicate exposure information through additional electrical contacts in the mounting bracket 
of the gun.  The TTL metering system of the camera is used to make the exposure reading instead 
of the photo cell mounted on the flash unit.  In this way the exposure is more precise and allows 
the photographer the flexibility of using filters without having to alter the settings of the flash.  

SETTING UP A FLASH UNIT
Check that the ISO has been set on the flash and camera.
Check that the flash is set to the same focal length as the lens.  This may involve adjusting 
the head of the flash to ensure the correct spread of light. Check that the shutter speed on 
the camera is set to the correct speed (usually slower than 1/125 second on a 35mm SLR 
camera using a focal plane shutter).
Check that the aperture on the camera lens matches that indicated on the flash unit.
On dedicated units you may be required to set the lens aperture to an automatic position or 
the smallest aperture.
Check that the subject is within range of the flash.  On dedicated and automatic units the  
flash will only illuminate the subject correctly if the subject is within the two given distances 
indicated on the flash unit.  If the flash is set incorrectly the subject may be overexposed if 
too close and underexposed if too far away.

~
~

~

~

~
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Bowling Alley - Mark Galer

SLOW-SYNC FLASH
Slow-sync flash is a technique where the freezing effect of the flash is mixed with a long exposure 
to create an image which is both sharp and blurred at the same time.
Many modern cameras offer slow-sync flash as an option within the flash programme but the 
effect can be achieved on any camera.  The camera can be in semi-automatic or manual exposure 
mode.  A shutter and aperture combination is needed that will result in subject blur and correct 
exposure of the ambient light and flash.

    ~ Choose a low ISO setting or load the camera with 100 ISO film or less.
    ~ Select a slow shutter speed that will allow camera movement-blur (try experimenting with 

speeds around 1/8 second).
    ~ Take an ambient light meter reading and select the correct aperture.  
    ~ Set the flash unit to give a full exposure at the selected aperture.
    ~ Pan or jiggle the camera during the long exposure.

POSSIBLE DIFFICULTIES
Limited choice of apertures - Less expensive automatic flash units can dictate the use of 
a limited choice of apertures.  This can lead to a difficulty in obtaining the suitable exposure.  
More sophisticated units allow a broader choice of apertures, making the task of matching both 
exposures much simpler.  
Ambient light too bright - A slower film/reduced ISO setting or a lower level of lighting should be 
used if the photographer is unable to slow the shutter speed down sufficiently to create blur. 
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PRACTICAL ASSIGNMENT
Produce a series of six prints that explore a moving subject by using a variety of techniques and 
shutter speeds.  Your final presentation sheet should demonstrate that you have developed a 
theme from your initial investigations and that you have chosen appropriate techniques for your 
subject matter.
A possible title for your set of prints could be:

1. Sport.
2. Dance.
3. Vertigo.
4. The fourth dimension.

Your work should:

a) Make use of different shutter speeds, including some work at or near the slowest and fastest  
 speeds possible with the equipment you are using.
b) Demonstrate an understanding of what is meant by the Decisive Moment.
c) Show that you have considered both lighting and composition in your work. 

PRESENTATION OF WORK
Research and all contact prints should be carefully presented on card no larger than A2.  
Explanatory notes and comments should be made directly onto this sheet or on paper and 
attached.  You should edit your contact sheet including any alterations to the original framing with 
a chinagraph pencil or indelible marker pen.  You should clearly state what you were trying to do 
with each picture and comment on its success.  Contact prints and photographs should be easily 
referenced to relevant comments using either numbers or letters as a means of identification.  
You should clearly state how your theme has developed and what you have learnt from your 
background work and how this has contributed towards the final set of prints.

 

RESOURCES
Great Action Photography - Bryn Campbell.  Outlet.  1987.
Henri Cartier-Bresson: Masters of Photography Series (2nd edition). Aperture. 1997.
Motion and Document Sequence and Time - Sheldon/Reynolds. Addison Gallery. 1993.
Photography - London and Upton. Prentice Hall. 2001.
Photographic Composition - Tom Grill and Mark Scanlon. Amphoto. 1990.

Books including work by Eadweard Muybridge, Gjon Mili, Harold Edgerton and Ernst Haas. 
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Leapfrog - Melanie Sykes 

The camera was mounted on a tripod and 
set to f11 for a 1/8 second exposure. 

Sparks - Clair Blenkinsop

The camera’s shutter was held open on the 
B setting in a dark studio whilst a student 
traced the outline of the model with a 
sparkler.

Kick - Mark Galer

This slow sync flash effect was created by 
setting the camera’s shutter to 1/15 second, 
using a 500 watt tungsten light and the flash 
placed slightly to one side of the subject. 

Splash - Claire Ryder

Two 1000 watt halogen lights were used 
to obtain this fast 1/500 second exposure.  
Back lighting was essential to illuminate the 
water against the dark background.



Advanced Guides





aims
     ~ To develop an awareness of the links between self image and personal identity.
     ~ To develop an awareness of symbolism and visual codes of practice.

objectives
     ~ Research - a range of categories that define or divide people and the visual symbols
  connected with these categories. 
     ~ Analyse and evaluate - the effectiveness of the work you are studying and   
 exchange ideas and opinions with other students.
     ~ Develop ideas - produce a study sheet that documents the progress and   
 development of your ideas.
     ~ Personal response - produce and present artwork that explores one or more   
 aspects of your personal character.

Positive and Negative - Faye Gilding

self image
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INTRODUCTION
We are judged as individuals by our appearance, our actions and our status within society.  These 
judgements contribute to our awareness of ‘self’ and our self image.
The images we choose to represent ourselves help to establish our identity.  In photographs we 
might find evidence of the way we conform, share similarities and fit in with society, e.g. uniforms, 
fashion, dress code etc.  In photographs we might find evidence of what makes us an individual, 
a unique person within society, e.g. expression, make-up, jewellery, important personal objects, 
locations and other people.
The images we put forward of ourselves may vary depending on how we would like to be perceived 
by others.  An individual may like to be seen as smart, serious and powerful in a business setting, 
but casual, friendly and relaxed in a family setting.  The images we choose to frame or keep in 
our albums will tend to portray positive aspects of our self image, e.g. happiness, success and 
security.  This, however, is only one aspect of our ‘self image’.

CLASSIFICATIONS
Individuals tend to seek out groups that they feel comfortable in.  These groups contain individuals 
who are similar in some respects and together the group forms a collective identity.  From this 
collective identity (team, family group, club or fraternity) we draw a part of our self image that is 
important to our own identity.  Members of large collective groups adopt visual forms of recognition, 
e.g. items of clothing, body decoration or adornment (scarves, rings, tattoos, haircuts etc.).  Along 
with the visual forms of recognition, the individual is expected to adopt the customs, rituals or 
ceremonies that serve to unite the group in a common mutual activity, e.g. worship, singing or 
dancing etc.
The adolescent years and years of early adulthood can be turbulent and explosive for some as 
they strive either to ‘fit in’ or ‘break out’ of some of the categories they were brought up in, or 
labelled with.  As individuals establish new identities conflict may lead to insecurity and anger.  The 
struggle to recognise and define identity is one of life’s most difficult tasks.

ACTIVITY 1
What follows is a list of categories that serves to define and divide us.  Make a personal list 
of the categories you belong to or have conflict with and visual symbols that are associated 
with each.  Aspirations and expectations should also be listed.

1.   Age/generation - This can dictate levels of independence afforded to the individual.
2.   Gender - Our sex affects the way we are treated by some individuals.
3.   Race -  Prejudice and perceived racial superiority can affect hopes and aspirations.
4.   Religion - Moral codes and ideologies that serve to guide, unite and divide. 
5.   Class or caste - A classification that an individual may never escape from.
6.   Personality - Extrovert and introvert are classifications of personality.
7.   Intelligence - We are often segregated by educational establishments using IQ.
8.   Political persuasion - Left wing or right wing.  Each carries its own ideology.
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IMAGES OF BEAUTY
The photographs above are of the same student.  Each image represents a different aspect of the 
same character.  The image on the left represents how the student would most like to be seen, 
positive, calm and physically attractive.  The image on the right represents how the student would 
least like to be seen, disfigured, in pain and physically repulsive.    
Many people edit images of themselves before they are passed around or placed into a 
photographic album.  People often destroy images that they feel do not portray themselves in 
a positive way.  We are drawn to the image on the right because of its visual impact but we are 
shocked to learn that the image on the left is of the same student.  We do not expect that a single 
individual has the capacity to be both beautiful and ugly, yet in reality we all feel these reactions to 
our own image at different times, depending on our state of mind, our physical well being and the 
manner in which the camera has captured our likeness. 

ACTIVITY 2
Find images in the media which have been used to represent attractive and unattractive 
aspects of the human face.  
Examine and record carefully the photographic techniques used to accentuate both these 
qualities, drawing up a list that relates to the images you have found.  
List the physical characteristics that we have come to admire in both the male and female 
face and write 100 words in response to the following questions:

 

1. Do you believe that media images or public opinion are responsible for the characteristics     
of beauty becoming universal stereotypes?  
2. Do you believe any harm can be done by people admiring media images of glamorous 
models? 

                                          Beauty and the Beast - Catherine Burgess
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                                                          Fashion Statement - Tom Scicluna

IMAGES OF CONFORMITY
The photomontage above shows the same figure dressed in many strange ways. Each figure 
is accompanied by a bar code as seen attached to the products we buy in the supermarket.  
The orderly lines of figures contrast with the main figure in the foreground who is wearing his 
underpants outside his trousers and who stares straight at the viewer in an unnerving manner.
The student is making the statement that fashion manipulates the young.  Fashion rather than 
being an individual attempt at personal expression is a commercial way of pressurising people 
to conform (no matter how silly the conformity looks).  The main figure looks like he has just 
recognised this fact and is not amused.
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Boxes - Housewife - Julia McBride

The photomontage above expresses the student’s awareness of social pressures to conform to 
the image and behaviour of a typical housewife.  The student is seen to be breaking out of the ‘box’ 
in which she feels she may be placed at some future date.

ACTIVITY 3
Consider some of the social pressures that you think may shape your behaviour and 
personal image.  List the images most commonly associated with the categories or ‘boxes’ 
you have already listed in Activity 1.  
How have you responded to social pressures to conform by adopting an appearance that 
relates to the categories that you feel you have been placed in or have chosen?
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PRACTICAL ASSIGNMENT 
Using photography and other media put together a composite image or series of images that 
communicate how you see yourself in harmony or conflict within the social structure of which you 
are a part.  The assignment may put forward one aspect or several concerning your self image and 
it is envisaged that you will explore not just the positive ones.
Your design sheets or sketch book should show evidence of the development of a variety of ideas 
or approaches to this assignment and together with the finished piece of work they will form an 
integral part of the assessment material.
Possible starting points for practical work concerning self image:

1. Reflections:
 ~ a window into the soul?

2. Different aspects or sides to our character could be illustrated through conflicting,  
 contrasting or changing images:

 ~ Negative and positive, strong and weak, child and adult etc.
     
 ~ Different aspects of our character viewed simultaneously or consecutively.
     
 ~ Triptychs, installations, constructions, e.g. cubes, cylinders, mobiles etc.
     
 ~ Our dreams and aspirations versus the reality we inhabit.
     
 ~ A recognition of the sources of individual pressures within society to conform or  
  adjust our behaviour and appearance.
     
 ~ Stereotypes - racial, gender etc.
 

RESOURCES

Media images representing age, class, gender and race.

The family photograph album.

Personal collections of photographs.

The photographic work of Jo Spence, Cindy Sherman and Arno Minkkinen.



>
>

>
FO

U
N

D
AT

IO
N

S
Self Image

Ph
ot

og
ra

ph
y >>

>
>

>
>

57

Daniel has created this image by breaking a mirror into many pieces on the floor 
and photographing the reflection of a single individual.  Due to the shallow depth of 
field the actual fragments of the mirror cannot be seen.  Daniel was working on the 
idea of an individual possessing more than one identity and how the image may be 
a mask to the true identity.

Claire has used a highly reflective piece of card which has been bent to produce this 
dramatic effect.  The model and their reflection can be viewed at the same time 
but the reflection is a distorted view of reality.  Claire has produced an image which 
explores how our self image can be distorted by our levels of confidence and by the 
recording methods used.  

Reflection - Claire Ryder

Façades - Daniel Shallcross
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GALLERY

Matthew Theobold

Matthew Houghton



aims
     ~ To develop an awareness of how visual elements interact with each other and      
 with text to convey specific messages.
     ~ To develop an awareness of the techniques employed by individuals in the 
 media in order to manipulate photographic material.

objectives
     ~ Research - a range of assembled photographic images from both commercial and 
 non-commercial sources.
     ~ Analyse and evaluate - the effectiveness of the work you are studying and exchange
 ideas and opinions with other students.
     ~ Develop ideas - produce a study sheet that documents the progress and   
 development of your ideas.
     ~ Personal response - produce and present artwork to demonstrate how assembled  
 photomontages can communicate a specific message.

Agoraphobia - Chris Gannon

photomontage
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INTRODUCTION
When we look at a photograph we read the images as if they were words to see what information 
they contain.  If the photographic image is accompanied by words they can influence our decision 
as to what the photograph is about or even alter the meaning entirely.  The photographer can 
manipulate the message to some extent by using purely photographic techniques such as framing, 
cropping, differential focusing etc.  This controls which information we can or cannot see.  Some 
artists and photographers have chosen to increase the extent to which they can manipulate the 
information contained in a photograph by resorting to the use of paint, chemicals, knives, scissors 
and electronic means to alter what we see.  The final result ceases to be a photograph and 
becomes a ‘photomontage’.

DEFINITION
A photomontage is an image that has been assembled from different photographs.  By adding or 
removing information in the form of words or images the final meaning is altered.  The resulting 
photomontage may be artistic, commercial, religious or political.

HISTORY 
Photomontage is almost as old as photography itself.  During the 1850s, several photographers and 
artists attempted to use photography to emulate the idealised scenes and classical composition 
that was popular in the Pre-Raphaelite painting of the period.  Photographs during this time 
were restricted by the size of the glass plate used as the negative in the camera.  Photographic 
enlargers were not common, so the images had to be contact printed onto the photographic paper.  
By using many negatives to create a picture the photographer could increase the size of the final 
image.  This also released the photographer from the need to photograph complex sets using 
many models.  The technique of ‘combination printing’  allowed the photographer to photograph 
each model individually and then print them on a single piece of paper masking all the areas of the 
negative that were not needed.

Destruction - Darren Ware
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HISTORICAL EXAMPLES
A famous combination print of the Victorian era is called ‘Two Ways of Life’ by Oscar Gustave 
Rejlander, produced in 1857.  As many as 30 negatives were used to construct this image.  The 
picture shows the moral choice between good and evil, honest work and sin.  
Another photographer who worked with this technique was the artist Henry Peach-Robinson.  
Robinson first sketched his ideas for the final composition on a piece of paper and then fitted in 
pieces of the photographic puzzle using different negatives.  One of his most famous images is the 
piece titled ‘Fading Away’ which was constructed in 1859 from five negatives.  The image depicts 
a young woman dying whilst surrounded by her family. 

HISTORICAL DEVELOPMENTS
Both Peach-Robinson and Rejlander were heavily criticised by the fine art world for their work in 
this field but the technique was popular with the public and did survive.  Commercial photographic 
studios in the 1860s started making their own composite photographs.  They were made by cutting 
up many photographs, usually portraits of the famous or of beautiful women, and gluing them onto 
a board.  This was then re-photographed and the resulting prints sold as souvenirs or given away 
as promotional material. 

ACTIVITY 1
Briefly discuss why you think painters of the Victorian period might have criticised these 
early photomontages and why the pictures were popular with the general public.
This technique of piecing together separate images to create one picture is again very 
popular with both artists and the media.  
What two reasons can you think of for this revival of an old technique?

Fading Away - Henry Peach-Robinson/Royal Photographic Society at NMPFT
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POLITICAL PHOTOMONTAGE  
The technique of photomontage was not widely used again until the Cubists and the Dadaists 
in the 20th century experimented with introducing sections of photographs and other printed 
material into their paintings.  A Dadaist by the name of John Heartfield further developed this use 
of photography and is now commonly attributed as the founder of political photomontage.
John Heartfield was influenced by Dadaism and the newly emerging socialism in the Soviet Union.  
Sergei Tretyakov, a Russian born writer, showed Heartfield how a collection of facts carefully edited 
could convey a significant message.  John Heartfield was already deeply involved with politics and 
he now saw how the graphic use of assembled photographs, combined with the mass production 
printing techniques of the time, could reach a wide audience with his political messages. 

The techniques that John Heartfield developed in the 1920s and 1930s are still used by 
contemporary artists such as Klaus Staeck and Peter Kennard.  In the 1980s Peter Kennard 
used photomontage to draw attention to the escalating arms race, his most famous works being 
associated with the organisation CND (the Campaign for Nuclear Disarmament).  Both artists have 
found photomontage an ideal medium to communicate social and political injustice to the public 
in an immediate and effective way.  Through photomontage the public are asked to question the 
media images they see everyday, thus raising their visual literacy.

Defended to Death - Peter Kennard
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TECHNIQUES OF POLITICAL PHOTOMONTAGE

1. Text:  Text included with most photomontages sets out to reinforce the message of the  
photographer or artist.  The words can remove any possible ambiguity that the viewer may find, 
draw the attention to the conflict in the images or contradict the images entirely thus establishing 
a satirical approach to the work. 

2. Recognising the familiar:  The viewer is meant to recognise familiar images, paintings, 
photographs, advertising campaigns etc. that the photomontage is based upon.  The viewer 
is drawn to the differences from the original and the new meanings supplied by the changed 
information.  This technique is often used in contemporary photomontage works. The technique is 
to make the familiar unfamiliar, e.g. ‘Cruise Missiles’  Peter Kennard, ‘Mona Lisa’  Klaus Staeck.

3. Contradiction:  In many photomontages we see images that contradict each other.  Introduced 
parts of the photomontage may be inconsistent with what we would normally expect to see 
happening in the image thus questioning the original point of view.  The contradiction can also be 
between what we see is happening and the text.  Our curiosity to establish a coherent meaning in 
both cases is raised.

4. Contrast:  To gain our attention individual components of the photomontage may be in sharp 
contrast to each other, e.g. wealth and extreme poverty, tranquillity and violence, happiness and 
sadness, industrialisation and the countryside, filth and cleanliness etc. 

5. Seeing through the lies:  Many photomontages invite the viewer to look behind the surface or 
see through something to gain greater insight into the truth.  Windows that open out to a different 
view, X-ray photographs that reveal a contradiction are all popular techniques.

6. Exaggeration of scale:  By altering the scale of components of the photomontage the  
artist can exaggerate a point, e.g. a photomontage entitled ‘Big business’ may include giant, cigar 
smoking, industrialists crushing smaller individuals under their feet. 

7. Figures of speech:  A very popular technique of the photomontage artist is to visualise figures 
of speech, e.g. puppet on a string, playing with fire, house of cards etc.  The artist may play upon 
the viewer’s acceptance of these as truth or use them as a contradiction in terms, e.g. ‘The camera 
never lies’. 

ACTIVITY 2
Find two examples of political photomontages that are either from a historical or contemporary 
source.  Discuss in what context they have been produced and how effective you think they 
communicate their intended message.
Discuss the techniques that have been used to assemble the examples you have chosen 
and offer alternative ways that the artist could have put over the same message.
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PHOTOMONTAGE IN THE MEDIA
Advertisers and the press have embraced, with open arms, the new technology which makes 
image manipulation easy.  It is fast, versatile and undetectable.  Advertising images are nearly 
always manipulated in subtle ways to enhance colours, remove blemishes or make minor 
alterations.  We are now frequently seeing blatant and extensive manipulation to create eye-
catching special effects.  We do not get unduly agitated or concerned over these images because 
advertising images have always occupied a world that is not entirely ‘real’.

TO MANIPULATE OR NOT TO MANIPULATE
We start to move into more questionable territory when images we take to be from real life, perhaps 
of real people, are altered without our knowledge.  The top fashion models we see on the covers 
of magazines like Vogue and Vanity Fair for instance, we believe to be real people, especially 
when they have been taken out of the advertising context.  We expect models to have near 
perfect features and complexions, but it would come as a shock to many sections of the public 
to realise that these images are frequently altered as they are not quite perfect enough for the 
picture editors of the magazines.  The editors do not distinguish between the images that appear 
on the cover of the magazine and the images that are sent to them in the form of advertisements.  
Minor blemishes to the model’s near perfect skin are removed, the colour of their lipstick or even 
their eyes can be changed to suit the lettering or the colour of their clothes.  Many women aspire 
to these models and their looks, and yet these people don’t exist.  It is important to remember that 
a publication is a product, whether it is a fashion magazine or a daily newspaper, and as such 
editors may be more interested in sales than in truth.
Most editors are at present using their own moral codes as to when, where and to what extent they 
will allow manipulation of the photographic image.  Most editors see no harm in stretching pictures 
slightly so they can include text over the image or removing unsightly inclusions.  What each editor 
will and will not allow can vary enormously.  Occasionally the desire for an image to complete or 
complement a story is very strong and the editor is tempted to overstep their self-imposed limits.  
A fabricated image can change the meaning of a story entirely or greatly alter the information 
it contains.  It is possible to construct a visual communication where none may otherwise have 
existed. 

ACTIVITY 3
As editors exercise their ever increasing power over information control, what limits would 
you impose on them as to the extent to which they can manipulate the photographic 
image?
Devise a series of guidelines that will control the release of images that have been 
constructed for media use so that the public are aware as to the extent of the manipulation. 
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PHOTOMONTAGE IN ART
Around the time that John Heartfield was developing the language of political photomontage, 
another artist, Laszlo Moholy-Nagy, was using photography in conjunction with drawn geometric 
shapes.  The effect was to cause a visual conflict between the print viewed as a factual record 
of three-dimensional reality and the print as a two-dimensional surface pattern.  This important 
work ensured that many contemporary artists would continue to use the camera as a creative tool.  
Some have found ‘straight photography’ limited as a medium for visualising their own personal 
ideas or abstract concepts within a single image.  Image manipulation and photomontage are two 
ways that photography can be used by the artist to communicate in more complex ways. 

SURREALISM
 Surrealism followed Dadaism and photography was found to be an ideal tool and so became 
directly involved in this movement as it had been in Dadaism. 
Surrealist images are constructed from the imagination rather than from reality.  Many of the 
works by surrealist painters such as Salvador Dali and Réne Magritte appear as fantastic dream 
sequences where familiar objects are placed in unusual settings.  Parts of the image may be 
distorted in scale or shape and the impossible is often visualised.  Inspired by the work of these 
surrealists Angus McBean, in the 1930s, produced a whole series of photomontages of actors and 
actresses.  The photographs are a strange mixture of fantasy and portraiture where the character 
is often surrounded by props from their current play.

Audrey Hepburn - Angus McBean photograph.  By permission of the Harvard Theatre Collection, copyright owner.
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JOINERS
David Hockney has used photomontage in many of his works.  Individual photographs have been 
placed together to create a larger photographic collage which Hockney has termed a ‘Joiner’.  The 
number of prints in each Joiner may vary depending on how much information Hockney feels he 
needs to explore in the subject matter.  In some of his Joiners he has photographed more than 
one side of an object or person and then placed the individual images together to create a single 
picture.  This technique was used by cubist painters such as  Georges Braque and Picasso who 
show many facets of objects on a single canvas.  Hockney has taken this one stage further and 
presented the subject at different moments in time.  The photographic instant has been lengthened 
in some of Hockney’s Joiners to become a study of a ‘happening’, different views from different 
times during the same event.  A picture of a card game is no longer a record of that game at one 
particular moment but rather a study of the whole game. 

ACTIVITY 4
Find two examples of photomontages that are either from a commercial source or from a 
fine art background.  Discuss in what context they have been produced and what techniques 
they share with political photomontages.
What messages, if any, are communicated through these photomontages and how effective 
do you think they are?  Consider different ways that each image could have been tackled by 
the artist and come up with an idea for ‘another in the series’.  

David Hockney 'The Desk, July 1st 1994' Photographic Collage' © David Hockney
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PRACTICAL ASSIGNMENT 1
Illustrate the cover of a photography book to be published by ‘Focal Press’.  Create a photographic 
montage using image editing software for the cover illustration.  The montage should illustrate the 
following title:

‘SEEING IS BELIEVING’

‘This book deals with the perceptions and misconceptions of photographic evidence.  
Problems are often encountered in the interpretation of the image.  Technically 
speaking all photographs “lie”; sometimes by accident and sometimes by deliberate 
misrepresentation.  This book covers areas of difficulty in extracting facts from 
photographs and what photographs can and cannot reveal.’      
        Gale E. Spring

INSPIRATION
The publisher has expressed a desire for 
the illustration to be inspired by the visual 
ambiguity found in the surrealistic work of 
Magritte.  

‘The effect of strangeness derived from 
the juxtaposition in one and the same 
space of several elements, none of which 
causes any surprise, since they all belong 
to everyday reality. The visualisation of 
the impossible which questions ordinary 
perception.’

Combine visual elements and/or concepts 
from two or more of Magritte’s paintings.  
Include copies of these images with your 
final submission.

SPECIFICATIONS
Dimensions: 189 x 246mm.
Title: Seeing is believing
Subtitle: Perceptions and Misconceptions of Photographic Evidence.  
Image Mode and Resolution: Colour (RGB)  200ppi
Artwork: A4 paper.

Note > See the ‘Digital Montage’ section in the ‘Distortion’ chapter for technical information on how 
to complete this Assignment using digital image editing software.

Anitra Keough
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PRACTICAL ASSIGNMENT 2
Produce a photomontage in response to one of the following titles:

a) Phobia - an abnormal or morbid fear of something
b) Metamorphosis - a change of form, character or conditions
c) Decay - decompose
d) Dream world 
e) Strange but true
f) Fast food
g) Fashion

ADDITIONAL INFORMATION
Your work should include:

1. A description of how you have photographed each individual element and the sources for  
 ‘found’ images that you may have had to use (images from the printed media). 
2. A description of how the final montage has been assembled. 
3. A research sheet including your own proof sheets and ideas.

RESOURCES
Books
Domesday Book: Photopoem - Peter Kennard. Manchester University Press. 2000.
Images for the End of the Century - Peter Kennard. Journeyman Press. 1990.
In Our Own Image - second edition - Fred Ritchin. Aperture Foundation. 1999.
John Heartfield: Aiz-VI 1930-38. Kent Gallery Inc. 1992.
Love for Sale: The words and pictures of Barbera Kruger. Harry N Abrams. 1996.
Photo Synthesis - Jerry Uelsmann. University Press of Florida. 1992.
Photomontage - a Political Weapon - Evans and Gohl. Gordon Fraser. London. 1986.
Photomontage (world of art) - Dawn Ades. Thames and Hudson. 1986

Work by the following artists and photographers:
Historical Photomontage - Oscar Gustave Rejlander &  Henry Peach-Robinson.
Political Photomontage - John Heartfield, Klaus Staeck & Peter Kennard.
Surrealism - Réne Magritte, Salvador Dali, Laszlo Moholy-Nagy & Angus McBean.
Contemporary Artists - David Hockney and Babera Kruger.

Video
Photomontage Today - Peter Kennard (35 minute video). Arts Council of Great Britain.
Roland Collection of Films and Videos on Art. 
http://www.roland-collection.com/rolandcollection/Section/36/667.htm

Websites
Angus McBean - www.artphiles.com/photophiles/McBean/mcbean.html
Jerry Uelsmann - www.uelsmann.net
René Magritte - artcyclopedia.com/artists/magritte-rene.html
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Space & Pavement - Darren Ware

Eating Cars - Zara Cronin
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Paul Allister

GALLERY



aims
     ~ To extend personal creativity through improved technique.
     ~ To explore the limitations of photographic materials and equipment through 
    experimentation and exploration.

objectives
     ~ Research - locate and investigate various techniques of photographic distortion
 as used by historical and contemporary photographers.
     ~ Analyse and evaluate critically - exchange ideas and opinions with others.
     ~ Develop personal ideas -  produce a study sheet that documents the progress   
 and development of personal ideas in response to your research.
     ~ Personal response - produce and present images that explore a range of
 techniques and processes to communicate a personal theme or idea.
 

Distortion - Ashley Dagg-Heston

distortion
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INTRODUCTION
All photographs distort reality to a lesser or greater degree.  The very act of converting three-
dimensional reality into a two-dimensional print is a distortion in itself.  The simplest of photographic 
techniques used by the photographer and editor can manipulate and distort the information that 
the photograph puts forward to the viewer.  This can be achieved in the following ways:

the act of framing composes the visual elements within the frame and decides which of the 
visual elements we can or cannot see in the final photograph;
the viewer can be led through the print in a systematic way through the use of line, tone and 
colour;
the choice of lighting can effect the mood of the image, to reveal or disguise form and 
texture;
use of shallow depth of field called ‘differential focusing’ can guide the viewer to individual 
elements within the frame;
movement can be explored or the illusion of movement created through the controlled use 
of shutter speed and flash lighting;
visual elements can be removed or added after the photograph has been taken to change 
the meaning of the image;
the use of text can be used to clarify or contradict meaning.

THE LIMITS OF DISTORTION
Photographic techniques control the way we read information from photographs in many ways, 
yet most people accept the accuracy of the photographic medium in recording the subject matter 
in front of the lens.  This study guide is designed to give you the opportunity to discover the limits 
of distorting this information using both the equipment and the materials commonly used in the 
photographic process.

ACTIVITIES 
a) Experiment with five of the techniques outlined in this study guide.  
 Use subject matter you feel is appropriate to the visual effect.  
 Record the procedures you have used accurately so that the process can be   
 perfected at a second or third attempt. 
b) Research both art and media sources for examples of photographic distortion and 
 make notes as to how you think this effect may have been achieved.

Note >  The final practical assignment requires that you work within a theme (as with 
previous assignments).  It is advisable that you consider this theme whilst working through 
the activities section of this study guide.  This will ensure that your research work is seen 
as appropriate. 

~ 

~

~
~

~

~

~
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DISTORTION USING THE CAMERA

LENS DISTORTION
Telephoto or long lens - A telephoto lens compresses, condenses and flattens three-dimensional 
space.  Subject matter appears to be closer together.  This effect is most noticeable when the lens 
has exceeded the focal length of 135mm.
Very long lenses are expensive but extreme effects can be explored by attaching a teleconverter 
to a shorter focal length lens.  A focal length of 400mm or greater may be achieved in this way 
without paying large sums of money.  The problems encountered by using this technique are 
maximum apertures that may be no better than f8.  A fast film or high ISO setting will be necessary 
in these situations.

Wide-angle lens - A wide-angle lens exaggerates distances and scale is  distorted.  Subjects 
close to the lens looks larger in proportion to their surroundings.  Subject matter in the distance 
looks much further away.  The overall effect is one of ‘steep perspective’.  
A wide-angle lens with a focal length of 28mm or shorter is recommended to explore this technique.  
The closer you move to the subject the greater the distortion. 

Zooming - For this technique you need to use a lens that can alter its focal length, i.e. a zoom 
lens.  The camera can be mounted on a tripod and a slow shutter speed selected, e.g. 1/15, 1/8 or 
1/4 second.  The effect is achieved by altering the focal length during the exposure.  The subject 
does not need to move for the effect to work (see ‘Time’).

Depth of field  - Very short depth of field is achieved by using one or more of the following 
techniques:  a) long focal length lens,  b) wide aperture,  c) moving closer. 
Wide depth of field is achieved by using a combination of one or more of the following techniques:  
a) short focal length lens,   b) small aperture,  c) moving further from subject.

REFRACTION AND REFLECTION
Refraction - This is the action of light being bent or deflected as it passes through different media 
such as glass and water.  Look at the swimmer photographed by André Kertész.  Try photographing 
through patterned or textured glass, special filters, clear filters with Vaseline smeared on them, 
water etc. in front of the lens.

Reflection - When light is reflected off smooth surfaces which are curved we get a view of the 
image distorted.  Look at the nudes produced by André Kertész. 
The mixing of reflections with the view through plain glass can also produce interesting effects, as 
can mirror images introduced into the picture.  Possible sources for such images include chrome 
items, reflective foil, shiny black cars etc.
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Point Blank - Philip Budd

DEPTH OF FIELD
The photograph above draws the viewer’s attention to the barrel of the gun.  The student has used 
a mixture of telephoto lens, close proximity to the subject and a wide lens aperture to create this 
photograph.  This is a technique known as differential focusing and is an example of pushing the 
equipment to its limits (see ‘Light’).

LIGHTING AND FILM
Artificial light - Try using unusual lighting conditions such as car headlights or portable video 
lights to illuminate your subject.  Experiment mixing tungsten and flash or by placing opposite 
coloured filters over the camera lens and a flashgun.  Try experimenting with coloured filters using 
black and white film (a red filter turns a blue sky virtually black). 

Infrared film - Infrared is a part of the light spectrum that is invisible to the human eye but can be 
recorded on special film.  Skies appear dark and green vegetation appears to glow.  This film needs 
to be used in conjunction with a deep red filter and must only be handled in complete darkness. 
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DISTORTION IN THE DARKROOM
a) Negative prints - These can be produced from any dry print and are often produced from 
solarised prints (see the work of Man Ray).  First make sure that the light from the enlarger lens 
covers the baseboard and set the enlarger lens to the brightest aperture.  Place a fresh sheet of 
unexposed printing paper, emulsion side up, on the base-board.  Place the original print face down 
onto this unexposed printing paper.  Place a clean sheet of glass onto the two sheets of paper to 
ensure close contact or use a purpose built contact printing frame.  Make a test strip to find out 
the correct exposure.  Exposures will be longer than if you had used a negative because the light 
has to pass through the top print to expose the paper underneath.  Process the test strip and the 
resulting negative print as normal. 

b) Sabattier effect - This is a technique which gives the print the appearance of being both 
negative and positive at the same time.  It is achieved by subjecting the print to a brief second 
exposure during the development stage.  The lightest tones of the print are affected most by this 
second exposure thus altering the normal tonal values of the print.  A white line or halo appears 
between the first and second exposures. See ‘Making a Sabattier print’.

c) Selective developing and fixing - The processing chemicals can be applied to some of the 
areas of the printing paper leaving others to fog or remain undeveloped.  Many imaginative ways 
can be found to apply the chemicals or prevent their contact with the print surface.  These include 
spraying, painting or dripping the chemicals and by coating areas of the print with hand cream, 
Vaseline or masking fluid which can be removed before fixing.

d) Movement of printing paper - The printing paper can be twisted, bent or dragged on the 
enlarger baseboard for a varying length of the exposure to distort the image or give the illusion of 
movement. 

e) Toning - Many chemicals are available to tone photographs that have already been processed.  
These include sepia (a warm brown tone), blue and copper toner.  The prints should be soaked for 
half an hour in water.  Blue toning a print will darken it, so it may be advisable to start with a print 
a little lighter than usual.

f) Colouring - Paints, inks and dyes can be applied directly to the finished print.  Gloss and resin 
coated papers are more difficult to work with than matt and fibre-based papers and will generally 
only accept acrylic paints.

g) Sandwiching negatives - This is achieved by placing two negatives together in the enlarger 
carrier (emulsion to emulsion).  Experiment with using one negative of a silhouette and one 
negative of a surface texture or pattern.  If exposures are too long try using negatives that are 
slightly underexposed.

h) Multiple exposures - This can be achieved by exposing different negatives onto the same 
piece of printing paper or turning the paper around and re-exposing the paper using the same 
negative.  If a subject has been photographed against a bright background this will produce dark 
areas on the negative.  When the negative is printed areas of the print will be unexposed, allowing 
a second exposure to be made into this area.  This technique will require some planning to be 
effective.
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MAKING A SABATTIER PRINT
a) Selecting an image - This should be a bold image with a 
strong pattern.  The image could contain blocks of differing tone 
or strong graphic lines.

b) Make a test strip - Using grade 4 or 5 makes a high contrast 
test strip.  If the negative will not give you a high contrast print 
choose another negative.

c) Make a print - Choose the best exposure from the test strip 
and reduce the exposure by 25-30%. Make 2 or 3 prints but do not 
process them.  Store them in a box or black plastic bag.

d) Preparing for the second exposure - Remove the negative 
from the enlarger. Make sure that the light from the enlarger lens 
covers the baseboard of the enlarger either by raising the enlarger 
head or altering the focus.  Cover the baseboard with paper 
towels and place a developing tray half full of water onto these.  
The light from the enlarger must cover all of the tray.   Switch off 
the enlarger. 

e) Make a second test strip - The aim of making this second 
test strip (without the negative) is to find a middle grey tone.  This 
tone will indicate the time required for the second exposure.  Set 
the enlarger timer. 

f) Half process the print - Process one print that you made 
earlier but remove it from the developer when it has received 
only half the developing time.  The image should only be half the 
correct density.  Slide the print gently into the tray of water and let 
the surface settle.  

g) Second exposure - Switch on the enlarger to give the print its 
second exposure.

h) Final processing - Return the print to the developer and 
process normally.  Fix and wash as usual.

i) View the print - View in daylight conditions and alter the time of 
the second exposure if needed.

Normal print

Sabattier print

Negative of sabattier print
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COMPUTER MANIPULATION
The images opposite demonstrate how copying and pasting can 
be used to manipulate the original image.  The first image shows 
a man with a broken nose and one half of his face in shadow.  It 
was decided to duplicate the left-hand side of the photograph to 
produce the manipulated image at the bottom of the page.

CUT, COPY AND PASTE
The electronic imaging software has several tools which allow the 
operator to cut out or copy sections of an image and paste them 
in a different place or in a different image entirely.  

 The tools above are:

 Top left - Rectangular marquee tool
 Top right - Move tool
 Bottom left - Lasso 
 Bottom right - Magic wand

A selection using the marquee tool is made by first clicking on the 
tool and then by clicking on the image and dragging the mouse 
until the area of image that you require is indicated by a dotted 
line.

The lasso is used to draw around a section of the image whilst the 
magic wand is placed on a specific area of the image and clicked.  
The magic wand will select all the pixels that are either the same 
or are similar to the ones where the magic wand was placed.
The selection is then copied and moved, leaving the original 
image intact.

The selection is flipped horizontally so that we then view a mirror 
image of itself.  When the selection is correctly positioned it 
is deselected.  Any areas that don’t quite match can then be 
retouched to produce a manipulation that is very difficult to 
detect.

The original image

The selection is moved

The selection is reversed and 
deselected
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DIGITAL MONTAGE
Masks are used to control which pixels are concealed or revealed on any image layer except 
the background layer.  If the mask layer that has been used to conceal pixels is then discarded 
the original pixels reappear. This approach to montage work is termed non-destructive. In the 
full version of Photoshop the mask is applied to the image layer whilst in Elements the mask is 
applied to a separate layer. The following technique adopts the latter approach and works in 
either version of the Adobe software.

1. Drag the layer thumbnail of one image into the image window of another to create a file with 
two layers. Use the ‘Move tool’ to position the second layer. Select ‘Free Transform’ to make minor 
changes in size of any new item being included in the montage.

2. Select the majority of the background using a combination of the magic wand and lasso tools.  
Keep the shift key depressed to build on, or add to, each successive selection or use the ‘Add to 
selection’ and ‘Subtract from selection’ icons in the options bar.
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3. Use the ‘Selection brush tool’ in either ‘Selection’ mode or ‘Mask’ mode to fine tune the 
selection work. Pressing the Alt key (Option key on a Mac) when painting with the selection 
brush tool will remove rather than add to the selection or mask. Keep the feather set to 0 and the 
hardness of the selection brush tool set to maximum to match the quality of the magic wand.

4. Choose the command ‘Select > Inverse’ so that only the subject is selected. Select the 
background layer in the layers palette and create a new empty layer by clicking on the ‘Create a 
new layer’ icon. Go to ‘Edit > Fill’ and select black as the content colour. 

5. Go to ‘Select > Deselect’ to remove the selection. This layer will act as your mask. In the full 
version of Photoshop it can sit on the same layer as the image you are masking. In Elements 
there is no option to add a layer mask to an image layer. 

6. Click on the top layer and select ‘Group with Previous’ from the ‘Layers’ menu. The base layer 
of a layer group acts as a mask to the other layers. The pixels are concealed rather than being 
deleted and can be retrieved if required to create the perfect edge.
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7.  The mask will require some modifications before the edge is subtle and believable. From the 
‘Filters’ menu select ‘Blur > Gaussian Blur’. Select a pixel ‘Radius’ that softens the edge of the 
subject by an appropriate amount. If the subject has one edge that is softer than the rest, first 
make a selection to isolate that edge for individual attention. To remove the small halo or fringe 
pixels of the old background from around the subject go to the ‘Filter’ menu and select ‘Other > 
Maximum’. Select a pixel radius amount that is just enough to shrink the mask so that the fringe 
of old background pixels disappear.

Note > Any small traces of old background (especially in corners or areas of fine detail) can 
be removed with the ‘Eraser Tool’. Select a small brush with a hard edge at a reduced opacity 
(approximately 50%) and erase some of the mask in the localised area that is causing the problem. 
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DIGITAL POSTERIZATION
The ‘Posterize’ command can be very effective for dividing a Grayscale image into large flat areas 
of tone for dramatic effect. 

From the ‘Image’ menu choose ‘Adjustments > Posterize’. From the posterize palette select the 4 
levels (this will give you white, black and two tones of grey). Experiment with different numbers to 
see the variations of effect. If the ‘Preview’ box is checked you can see the effect on your image 
as you type. 

Colour posterization
The effects of posterization however, are 
often far less successful if the command is 
applied directly to an RGB colour image. 
To posterize a colour image effectively 
start by duplicating the background layer 
and then proceed to remove the colour by 
choosing ‘Adjust Color > Remove Color’ 
from the ‘Enhance’ menu (Photoshop 
users should choose ‘Image > Adjustments 
> Desaturate’). Apply the posterize 
adjustment to this duplicate layer and then 
blend this layer with the background layer 
by changing its blend mode (using the 
layers palette) to ‘Overlay’. 

Note > You may also like to experiment with the layer opacity to modify the result. Select 
the Brightness/Contrast command from the ‘Enhance’ menu (Image > Adjustments for 
Photoshop users) and adjust the sliders to further refine the posterized effect. 
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DIGITAL SABATTIER EFFECT
The Sabattier effect that has been outlined earlier in this chapter can be achieved on a computer 
by using the blend modes. 

Start by duplicating the background layer by 
dragging it to the new layer icon in the layers 
palette. Invert this ‘Background copy’ layer by 
going to ‘Image > Adjustments > Invert’ and 
then apply a ‘Difference’ or ‘Darken’ blend mode 
to this layer. The ‘Darken’ option will render the 
negative version that is usually achieved in the 
darkroom before a reversal print is made.

Note > If the darken option is selected a 
‘Levels’ adjustment can return the highlights 
to a bright white (see ‘Digital Darkroom’).
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DIGITAL BLENDING 
When an image, or part of an image, is placed on a separate layer above the background, creative 
decisions can be made as to how these layers interact with each other. Reducing the opacity of the 
top layer allows the underlying information to show through but there are many other ways of mixing, 
combining or ‘blending’ the pixel values on different layers to achieve different visual outcomes. 

The different methods used by Photoshop 
and Elements to compare and adjust the hue, 
saturation and brightness of the pixels on the 
different layers are called ‘blend modes’. 
Blend modes can be assigned to the painting 
tools from the options bar but they are more 
commonly assigned to an entire layer when 
editing a multi-layered document. The layer 
blend modes are accessed from the ‘blending 
mode’ pull-down menu in the top left-hand 
corner of the layers palette.

Applying the blend mode ‘Overlay’ to a texture or pattern layer will create an image where the form 
appears to be modelling the texture. Both the highlights and shadows of the underlying form are 
respected.



Photography: Foundations for Art & Design
FO

U
N

D
AT

IO
N

S
>

>
>

P
ho

to
gr

ap
hy
 >>>

>
>

>

84

PRACTICAL ASSIGNMENT
Choose one assignment only.  All work should be supported with research and background work.  
This should include the work carried out in the ‘activities’ section of this study guide plus evidence 
of how your ideas have developed for your chosen theme.

1. A publishing company has commissioned you to produce a set of photographs that will 
advertise their forthcoming book titled Beyond Reason one of which will be used on the dust 
jacket of the book.
The book is about psychic phenomena and it is envisaged that the photographs will use special 
effects to set the mood for the articles in the book.

2. You have been commissioned by a successful photographic studio to establish and promote 
a specialised area of photography.  The area is to be known as ‘The Dirty Tricks Department’.  
This will be a mixture of specialised photographic effects together with original creative thinking. 
The promotion is to be a leaflet containing a number of images and you may wish to include the 
title as part of the presentation. 

3. Choose one of the following themes from which to work.  Think very carefully about the many 
ways you can approach your chosen theme.  Do not choose the most obvious definition of the 
word unless you have considered alternatives.

a) Sensation    b) Force    c) Transitions    d) Rituals    e) Faith    f) Masks    g) Dreams

4. Produce a set of promotional photographs that would be suitable for the pressure group 
Amnesty International.  The images you produce should promote a particular aspect of their work 
that you feel strongly about.

5.  Express in photographs one or more of the following emotions.  You may consider using props 
and/or text to convey the emotion effectively.

a) Anger    b) Fear    c) Love    d) Hate    e) Joy

RESOURCES
André Kertész - Nudes ......................................................................... distorted reflections
Bill Brandt - Nudes 1945-1980 ...................................................  wide angle lens distortion 
Classroom Photography - Ilford (London)  ..................................  creative use of materials
Creative Darkroom Techniques ................................................................................ Kodak
Ernst Haas  ............................................................................... use of slow shutter speeds
Man Ray  .....................  solarisation, negative prints, multiple exposures and photograms
The Print, Time Life Publications ...................................... images created in the darkroom
The Workbook of Darkroom Techniques ..........................John Hedgecoe/Mitchell Beazley
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Distortion 2 - Gareth Neal

The student has created a sequence of distorted images.  A magnifying lens has been used to 
distort sections of the human face whilst taking the shots.  These have been further distorted 
by using montage techniques to piece them together with mirror images of themselves.  The 
sequence shows the original image at the top disappearing into itself.  
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Scream - Lynsey Berry

This image was distorted by spraying the 
developer from a plant sprayer whilst the 
developing tray was tilted. 

Faces - Paul Heath

This print is a double exposure which has 
then been exposed a second time whilst 
processing the print.  

The Mouth - Gareth Neal

This image is a combination of distorting 
the face using a magnifying lens and then 
creating a Sabattier effect. 

The Look - Paul Heath

This image was created in the camera by a 
double exposure.  Only one side of the face 
was illuminated for each exposure.  



aims
    ~ To increase knowledge of the historical development of the landscape image.
    ~ To express ideas, convictions or emotions through landscape images. 
    ~ To develop an understanding of how different techniques can be employed to aid
 personal expression.
 

objectives
     ~ Research - a broad range of landscape images from both commercial and 
 non-commercial sources.
     ~ Analyse and evaluate - the effectiveness of the work you are studying and   
 exchange ideas and opinions with other students.
     ~ Develop ideas - produce a study sheet that documents the progress and   
 development of your ideas.
     ~ Personal response - create work that explores expressive landscape
 photography in response to the assignment brief in this chapter.

Mackenzie Charlton

landscape
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INTRODUCTION
Picture postcards, calendars and travel brochures show us glimpses of romantic, majestic and 
idyllic locations to be admired and appreciated.  The beautiful and wonderful are identified, 
observed, recorded and labelled repeatedly by professionals, tourists and travellers.  Mankind is 
responding to the basic social needs and expectations to capture, document and appreciate.  I 
came, I saw, I photographed.  Photography allows the individual to pay homage to beauty and 
achievement as if in some religious ritual.  We mark the occasion of our endeavour and our 
emotional response by taking a photograph. 

‘Most tourists feel compelled to put the camera between themselves and whatever is 
remarkable that they encounter.  Unsure of other responses they take a picture.  This gives 
shape to experience: stop, take a photograph, and move on.’ 

Susan Sontag - On Photography

In order to avoid a stereotypical representation it is important  to connect emotionally with the 
environment in order to express something personal.  How do you as an individual feel about the 
location and what do you want to say about it?

EARLY LANDSCAPE IMAGES
Early landscape images were either created as factual records or looked to the world of painting 
for guidance in such things as composition and choice of content.  Fox Talbot described his 
early photographs as being created by the ‘pencil of nature’.  On the one hand the medium was 
highly valued because of the great respect for nature at this time.  On the other hand the medium 
was rejected as art because many perceived photography as a purely objective and mechanical 
medium.  The question was asked,  ‘can photography be considered as an artistic medium?’  
Although it is the camera that creates the image, it is the photographer who decides what to 
take and how to represent the subject. This subjective approach enables individuals to express 
themselves in unique ways whether they use a brush or a camera.

Mark Galer
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PICTORIAL PHOTOGRAPHY
The practice of recording the environment as the principal subject matter for an image is a fairly 
modern concept.  Prior to the ‘Romantic Era’ in the late 18th century, the landscape was merely 
painted as a setting or backdrop for the principal subject.  Eventually the environment and in 
particular the natural environment began to be idealised and romanticised.  The picturesque 
aesthetic of beauty, unity and social harmony was established by painters such as John Constable 
and William Turner working just prior to the invention of photography.   The first photographic 
movement was born and was known as ‘pictorial photography’.
Pictorial photographers believed that the camera could do more than simply document or record 
objectively.  The pictorial approach was not so much about information as about effect, mood and 
technique.  
Pictorial photographers often felt, however, that the photographic lens recorded too much detail. 
This led to photographers employing techniques to soften the final look of the image. These 
techniques included taking the images slightly out of focus or using print manipulation to remove 
detail. The aim was to create an image which looked more like a drawing or painting and less like 
a photograph.

NATURALISM
Dr Peter Henry Emerson promoted photographic ‘Naturalism’ in 1889 in his book Naturalistic 
Photography for Students of Art.  Emerson believed that photographers shouldn’t emulate the themes 
and techniques of the painters but treat photography as an independent art form.  He encouraged 
photographers to look directly at nature for their guidance rather than painting.  He believed that 
photography should be both true to nature and human vision. Emerson promoted the concept that 
each photographer could strive to communicate something personal through their work.

Pictorial style image
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REALISM
In 1902 a photographer named Alfred Stieglitz exhibited under the title ‘Photo-Secessionists’ with 
nonconformist pictorial photographs, choosing everyday subject matter taken with a hand-held 
camera.  These images helped promote photography as an aesthetic medium.  

F64
Another member of the group, Paul Strand, pioneered ‘straight photography’, fully exploring the 
medium’s strengths and careful observation of subject matter.  Strand believed that the emphasis 
should lie in the ‘seeing’ and not the later manipulation in order to communicate the artist’s feelings. 
The work and ideas influenced photographers such as Edward Weston and Ansel Adams who 
decided to take up this new ‘Realism’.  They formed the group F64 and produced images using 
the smallest possible apertures on large format cameras for maximum sharpness and detail.  
Straight photography heralded the final break from the pursuit of painterly qualities by 
photographers.  Sharp imagery was now seen as a major strength rather than a weakness of the 
medium.  Photographers were soon to realise this use of sharp focus did not inhibit the ability of 
the medium to express emotion and feeling. 

Dunes, Oceano, California 1963 - Ansel Adams © Ansel Adams Publishing Rights Trust/Corbis
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DOCUMENTARY
Photography was invented at a time when the exploration of new lands was being undertaken by 
western cultures.  Photography was seen as an excellent medium by survey teams to categorise, order 
and document the grandeur of the natural environment.  A sense of the vast scale was often established 
by the inclusion of small human figures looking in awe at the majestic view. These majestic views and 
their treatment by American photographers contrasted greatly with European landscape photographs.  
Landscape painters and photographers in Europe did not seek isolation.  Indeed seeking out a sense 
of isolation is problematic in an industrialised and densely populated land.

In the 1930s Roy Stryker of the Farm Security Administration (FSA) commissioned many 
photographers to document life in America during the depression.  Photographers such as Arthur 
Rothstein, Dorothea Lange and Walker Evans produced images which not only documented the 
life of the people and their environment but were also subjective in nature.

ACTIVITY 1
View the image by Walker Evans on this page and describe what you can actually see 
(objective analysis) and what you think the image is about (subjective analysis).
Discuss how effective Walker Evans has been in using a landscape image to communicate 
a point of view.
Can this photograph be considered as Art? Give two reasons to support your answer.

Bethlehem, Graveyard and Steel Mill - Walker Evans 1935 © Walker Evans Archive, 1994, 
The Metropolitan Museum of Art
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PERSONAL EXPRESSION
The image can act as more than a simple record of a particular landscape at a particular moment 
in time.  The landscape can be used as a vehicle or as a metaphor for something personal the 
photographer wishes to communicate.  The American photographer Alfred Stieglitz called a 
series of photographs he produced of cloud formations ‘equivalents’, each image representing 
an equivalent emotion, idea or concept.  The British landscape photographer John Blakemore is 
quoted as saying:

‘The camera produces an intense delineation of an external reality, but the camera also 
transforms what it “sees”.  I seek to make images which function both as fact and as metaphor, 
reflecting both the external world and my inner response to, and connection with it.’

‘Since 1974, with the stream and seascapes, I had been seeking ways of extending the 
photographic moment.  Through multiple exposures the making of a photograph becomes 
itself a process, a mapping of time produced by the energy of light, an equivalent to the 
process of the landscape itself.’

John Blakemore 1991

Communication of personal ideas through considered use of design, technique, light and symbolic 
reference is now a major goal of many landscape photographers working without the constraints 
of a commercial brief.  Much of the art world now recognises the capacity of the photographic 
medium to hold an emotional charge and convey self-expression.

Rocks and Tide, Wales - John Blakemore
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ALTERNATIVE REALITIES
There is now a broad spectrum of aesthetics, concepts and ideologies currently being expressed 
by photographers.  The camera is far from a purely objective recording medium.  It is capable of 
recording a photographer’s personal vision and can be turned on the familiar and exotic, the real 
and surreal.  This discriminating and questioning eye is frequently turned towards the urban and 
suburban landscapes the majority of us now live in.  It is used to question the traditional portrayal 
of the rural landscape (romantic and idyllic) as a mythical cliché.  It explores the depiction of the 
natural landscape for many urban dwellers as a mysterious location, viewed primarily through 
the windscreen of a car and from carefully selected vantage points. Landscape photography can 
be used to reflect the values of society.  The landscape that has been traditionally portrayed as 
being unified and harmonious may instead be portrayed as confused and cluttered to express the 
conflict, between expectation and reality.  

Photographers also explore their personal relationship with their environment using the camera 
as a tool of discovery and revelation.  To make a photograph is to interact and respond to the 
external stimuli that surround us.  We may respond by creating images that conform to current 
values and expectations or we may create images that question these values.  To question the 
type of response we make and the type of image we produce defines who we are and what we 
believe in.

ACTIVITY 2
Find two landscape photographs that question social values or act as a metaphor for personal 
issues that the photographer is trying to express.  Discuss whether the communication is 
clear or ambiguous and how this communication is conveyed.

Dreams Will Come True - Matthew Orchard
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EXPRESSIVE TECHNIQUES
The use of early morning, late afternoon and evening light when the sun is low can be used to 
increase the range of moods.  The changes in contrast and colour can all be used to extend the 
expressive possibilities.

RECORDING THE SKY
Sky may become overexposed when detail is required in the land and land may become 
underexposed when detail is required in the sky.  The problem can be controlled to some extent 
by filtration, careful exposure in the camera and burning and dodging when printing.

FILTERS
Polarising filters - these provide increased colour saturation and deeper blue skies when 
capturing images in colour.  The filter is turned when attached to the front of the lens until the 
desired effect can be seen through the viewfinder. The filter should be removed when the effect is 
not required.  When used in conjunction with a wide-angle lens additional filters (skylight, UV etc.) 
should be removed.  This will eliminate the problem of tunnel vision or clipped corners. 

Coloured filters  - Yellow, Yellow-Green, Orange and Red filters can all be used with black and 
white film to help decrease the exposure of a blue sky and obtain detail when printed. Yellow has 
the least effect and red the most. Underexposure of green colours (fields and trees etc.) is likely 
when using a red filter so the exposure should be increased to reduce or eliminate the problem.

Annapurna
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COMPOSING THE LANDSCAPE
Composing subject matter is more than an aesthetic consideration.  It controls the way we read an 
image and the effectiveness of your communication.

FORMAT AND HORIZON LINE
The most powerful design elements that you have to work with are choice of ‘format’ and 
positioning of the horizon line.
Avoid making the mistake of overusing the vertical or portrait format when faced with tall buildings 
or trees etc.  You should explore both formats when faced with a similar location and compare the 
communication of each.
The placement of the horizon line within the frame is critical to the final design.  A central horizon 
line dividing the frame into two halves is usually best avoided.  Consider whether the sky or 
foreground is the more interesting element and construct a composition accordingly. 

Michelle  Greenhalgh

OPEN OR CLOSED LANDSCAPE
In creating a landscape photograph it is possible to remove the horizon line altogether. By removing 
the horizon line from the image (through vantage point or camera angle) the photographer creates 
a ‘closed landscape’.  In a closed landscape a sense of depth or scale may be difficult for the 
viewer to establish. In some instances it is possible that the image may be viewed as an abstract 
image as the viewer struggles to recognise familiarity through a sense of scale.
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DEPTH
Including foreground subject matter introduces the illusion of depth through perspective and the 
image starts to work on different planes.  Where the photographer is able to exploit lines found in 
the foreground the viewer’s eye can be led into the picture.  Rivers, roads, walls and fences are 
often used for this purpose.

USE OF VANTAGE POINT
By lowering the vantage point or angling the camera down, the foreground seems to meet the 
camera.  A sense of the photographer in, or experiencing, the landscape can be established.  In 
the photograph above the beach and cliff walls are included along with the author’s own footsteps 
to establish a sense of place. 

ACTIVITY 3
Find examples of photographs created using different formats and compare and discuss the 
visual effect of each.
Find examples of closed and open landscapes and discuss the different ways we read these 
images.
Find an example of a photograph where the photographer has created the illusion of depth. 
How has this been achieved?

Solitary Steps
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THE CONSTRUCTED ENVIRONMENT 
When Arthur Rothstein, FSA photographer, moved a skull a few metres for effect he, and the FSA, 
were accused of fabricating evidence and being dishonest.  A photograph, however, is not reality.  
It is only one person’s interpretation of reality.  Rothstein perceived the skull and the broken earth 
at the same time and so he included them in the same physical space and photograph to express 
his emotional response to what he was seeing.  Is this dishonest?  
The photograph can act as both a document and as a medium for self-expression.  Truth lies in 
the intention of the photographer to communicate visual facts or emotional feelings.  Sometimes it 
is difficult for a photograph to do both at the same time.

The majority of photographers are content with responding to and recording the landscape as 
they find it.  A few photographers, however, like to interact with the landscape in a more concrete 
and active way.  Artists such as Andy Goldsworthy use photography to record these ephemeral 
interactions.  Goldsworthy moves into a location without preconceived ideas and uses only the 
natural elements within the location to construct or rearrange them into a shape or structure that 
he finds meaningful.  The day after the work has been completed the photographs are often all 
that remain of Goldsworthy’s work.  The photograph becomes both the record of art and a piece 
of art in its own right.

ACTIVITY 4
Make a construction or arrangement using found objects within a carefully selected public 
location. Create six images showing this structure or arrangement in context with its 
surroundings.  Consider framing, camera technique and lighting in your approach.

© Image by Andy Goldsworthy
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ASSIGNMENTS
Produce six images that express your emotions and feelings towards a given landscape.  Each of 
the six images must be part of a single theme or concept and should be viewed as a whole rather 
than individually.
People may be included to represent humankind and their interaction with the landscape.  The 
people may become the focal point of the image, but this is not a character study or environmental 
portrait where the location becomes merely the backdrop.

1. Wilderness.
2. Seascape.
3. Suburbia.
4. Sandscape.
5. Inclement weather.
6. City.
7. Mountain.
8. Industry.
9. Arable land.

RESOURCES
A Collaboration with Nature - Andy Goldsworthy.  Abrams.  New York.  1990.
Ansel Adams: Classic images. New York Graphic Society. 1986.
On Photography - Susan Sontag.  Picador.  2001.
Inscape - John Blakemore.  Art Books Intl. Ltd.  1991.
In This Proud Land - Stryker and Wood.  New York Graphic Society.  New York.  1973. 
Land - Faye Godwin.  Heinemann.  London.  1985.
Naturalistic Photography for Students of the Art - P. H. Emerson.  Arno Press.  NY.  1973.
Small World - Martin Parr. Dewi Lewis Publications. 1995.
The History of Photography: an overview - Alma Davenport.  Focal Press.  1991.
The Photograph - Graham Clarke.  Oxford University Press.  1997.
The Story of Photography - Michael Langford.  Focal Press.  Oxford.  1997.
Walker Evans: Masters of Photography (2nd edition). Aperture. 1997.
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GALLERY

Lucas Dawson

Alison Ward
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Lucas DawsonKalimna Brock

Mark Galer



aims
     ~ To develop an understanding of the genre of photographic portraiture.
     ~ To develop personal skills in directing people. 
     ~ To develop essential technical skills to work confidently and fluently with people.           

objectives
     ~ Research - photographers noted for their skills in photographing people 
 (portraiture and documentary).
     ~ Analyse and evaluate - the effectiveness of the work you are studying and
 exchange ideas and opinions with other students.
     ~ Discussion - exchange ideas and opinions with other students.
     ~ Personal response - produce images through close observation and selection that  
 demonstrate both a comfortable working relationship with people at close range
 and appropriate design and technique.

Mi-Ae Jeong

portraiture
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INTRODUCTION
The craft of representing a person in a single still image or ‘portrait’ is to be considered a skilled 
and complex task.  The photographic portrait (just as the painted portrait that influenced the genre) 
is not a candid or captured moment of the active person but a crafted image to reveal character.  
The person being photographed for a portrait should be made aware of the camera’s presence 
even if they are not necessarily looking at the camera when the photograph is made.  This requires 
that the photographer connect and communicate with any individual if the resulting images are to 
be considered portraits.  Portraits therefore should be seen as a collaborative effort on the part of 
the photographer and subject.  A good photographic portrait is one where the subject no longer 
appears a stranger.

The physical surroundings included in a portrait offer enormous potential to extend or enhance 
the communication.  Just as facial expression, body posture and dress are important factors, the 
environment plays a major role in revealing the identity of the individual. 

ACTIVITY 1
Look through assorted books, magazines and newspapers and collect four portrait 
photographs. The environment should be a key feature in two of the four images. 
Describe the subject’s character in each of the images. 
What can you see within each image that leads you to these conclusions about the subjects’ 
character.

Matthew Orchard
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DESIGN
Choosing a suitable background or backdrop for the portrait can greatly influence the final 
design of the image. Using a plain backdrop with limited detail can retain focus on the individual 
being photographed whilst choosing an informative location can extend the communication 
and design possibilities. If the photographer is to reveal any connection between the subject 
and the background the two elements must be carefully framed  together.  Vantage point and 
the relationship and connection between foreground and background become major design 
considerations for the portrait photograph.

FORMAT
The choice of vertical or horizontal framing and the placement of the subject within the frame 
will effect the quantity of the background that can be viewed in the image.  A centrally placed 
subject close to the camera will limit the background information.  This framing technique tends to 
be overused but should not be ruled out for creating successful portraits.  The horizontal format 
is common when creating environmental portraits. Using the portrait format for environmental 
portraits usually requires the photographer to move further back from the subject so that 
background information is revealed.

ACTIVITY 2
Find four portraits that demonstrate the different ways a photographer has framed the image 
to alter the design and content.  
Discuss the vantage point, depth of field and subject placement in all of the images.

Shaun Guest
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COMPOSING TWO OR MORE PEOPLE
Composing two or more people within the frame for a portrait can be difficult.  The physical space 
between people can become very significant in the way we read the image.  For a close-up 
portrait of two people the space between them can become an uncomfortable design element.  
Careful choice of vantage point or placement of the subjects is often required to achieve a tight 
composition making optimum use of the space within the frame.  

The situation most often encountered is where two people sit or stand side by side, shoulder to 
shoulder.  If approached face on (from the front) the space between the two people can seem 
great.  This can be overcome by shooting off to one side or staggering the individuals from the 
camera.  The considerations for design are changed with additional subjects.

ACTIVITY 3
Collect four portrait images with two to five subjects.  
In at least one image the subject should have been placed in the foreground.  
Comment on the arrangement of the subjects in relation to the camera and the effectiveness 
of the design.

Kata Bayer
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DEPTH OF FIELD
Sophisticated 35mm SLR cameras often provide a ‘Portrait Mode’.  When this programme mode is 
selected a combination of shutter speed and aperture is selected to give the correct exposure and 
a visual effect deemed suitable for portrait photography by the camera manufacturers.  The visual 
effect aimed for is one where the background is rendered out of focus, i.e. shallow depth of field.  
This effect allows the subject to stand out from the background, reducing background information 
to a blur.  Although this effect is appropriate for many portrait images it is not suitable for most 
environmental portraits where more information is required about the physical surroundings and 
environment.  The student intending to create portraits is recommended to use their camera in 
either fully manual or aperture priority mode so that maximum control is maintained.

APPROPRIATE FOCAL LENGTH
Photographic lenses can be purchased by manufacturers which are often referred to as ‘portrait 
lenses’.  The ‘ideal’ portrait lens is considered by the manufacturers to be a medium telephoto lens 
such as a 135mm lens for a 35mm camera.  This lens provides a visual perspective that does not 
distort the human face when recording head and shoulder portraits.  The problem of distortion, 
however, is not encountered with shorter focal length lenses if the photographer is not working 
quite so close to the subject.  To record environmental portraits with a telephoto lens would require 
the photographer to move further away from the subject and possibly lose the connection with the 
subject that is required.  Standard and wide-angle lenses are suitable for environmental portraiture. 

ACTIVITY 4
Photograph the same subject varying both the depth of field and focal length of the lens.
Discuss the visual effects of each image.

Buddhist Temple, Singapore
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REVEALING CHARACTER
Significant and informative details can be photographed with the subject.  These details may 
naturally occur or be introduced for the specific purpose of strengthening the communication.  
Connections may be made through the ‘tools of the trade’ associated with the individual’s 
occupation.  Informative artefacts such as works of art or literature may be chosen to reflect the 
individual’s character.  Environments and lighting may be chosen to reflect the mood or state of 
mind of the subject.

The objects or subject matter chosen may have symbolic rather than direct connection to the 
subject.  In the above image the bent walking stick of the old man and the path travelled could be 
seen to represent the journey of life.

ACTIVITY 5
Find one portrait image that has included significant or informative detail.  
Describe the importance of the additional information and how it is likely to be read by the 
viewer.

Ann Ouchterlony
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PHOTOGRAPHING STRANGERS
It can sometimes feel awkward or embarrassing to be either photographed or photograph someone 
at close range.  These feelings of awkwardness, embarrassment or even hostility may arise out of 
the subject’s confusion or misinterpretation over the intent or motive of the photographer. 
 
The photographer’s awkwardness or 
reticence to introduce themselves to 
the subject often comes from the fear of 
rejection. Never be tempted to think that a 
portrait can be created using a telephoto 
lens with the subject unaware. Although 
some interesting images of people are 
captured this way they are not strictly 
portraits. 

INTERACTION
Putting a subject at ease in front of the 
camera is dependent on two main factors.

1. The subject is clear about the   
 photographer’s motive.

2. The subject sees value in the   
 photographs being made.

MOTIVE
Many people view a photographer with curiosity or suspicion.  Who is the photographer and why 
are they taking photographs?  It is essential that the photographer learns to have empathy with the 
people he/she intends to photograph.  A brief explanation is therefore necessary to help people 
understand that your intentions are harmless.

VALUE
Many people see the activity or job that they are doing as uninteresting or mundane.  They may 
view their physical appearance as non-photogenic.  You should explain to the subject what you 
find interesting or of value and why.  If the activity the subject has been engaged in appears 
difficult or demanding and requires skill, patience or physical effort, you should tell them.  You 
should continue to ask questions whilst photographing so that the subject is reassured that your 
interest is genuine.

Stephen Rooke
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DIRECTING THE SUBJECT
The photographer should display an air of confidence and friendliness whilst directing  subjects.  
Subjects will feel more comfortable if the photographer clearly indicates what is expected of them.  
There can be a tendency for inexperienced photographers to rush a portrait.  The photographer 
may feel embarrassed, or feel that the subject is being inconvenienced by being asked to pose.  
The photographer should clarify that the subject does have time for the photograph to be made 
and indicate that it may involve more than one image being created.  A subject may hear the 
camera shutter and presume that one image is all that is required.

PASSIVE SUBJECT
Ask your subject to pause from any activity that they are engaged in.  You can remain receptive to 
the potential photographic opportunities by keeping the conversation focused on the subject and 
not on oneself.

EXPRESSION AND POSTURE
Often a subject will need reminding that a 
smile may not be necessary.  Subjects may 
need guidance on how to sit or stand, what 
they should do with their hands and where 
to look.  It may be a simple case of just 
reminding them how they were standing 
or sitting prior to having their photograph 
taken. Have a few poses memorised so that 
you can position somebody who is feeling or 
looking awkward.
 

SHOOTING DECISIVELY
As you take longer to take the picture 
the subject will often feel more and more 
uncomfortable about their expression and 
posture.  To freeze human expression is 
essentially an unnatural act.  If the camera 
is to be raised to the eye to capture the 
image (as opposed to using a tripod), 
exposure, framing and focus should all be 
considered first. 

ACTIVITY 6
Direct two individuals towards a relaxed expression and body posture.
Discuss the process of direction for each.

Simon Sandlant
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CHARACTER STUDY
A series of portraits may be taken around a single character, or characters, connected by 
profession, common interest or theme.
With additional images it is possible to vary the content and the style in which the subject is 
photographed to define their character within the study.  The photographer may choose to include 
detail shots such as hands or clothing to increase the quality of information to the viewer.  The 
study may also include images which focus more on the individual (such as a straight head and 
shoulders portrait) or the environment to establish a sense of place.

 

The images above show the diversity of approach to present the character of a single individual.  
The images are of Martin, a homeless individual who lived under a bridge in Melbourne and who 
sold copies of The Big Issue to support himself.

ACTIVITY 7
Collect one character study where the photographer has varied the content of the images to 
define the character or characters of the individual or individuals.
Describe the effectiveness of the additional images that are not portraits. 

The Big Issue - Sean Killen
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ASSIGNMENT
Produce six portraits giving careful consideration to design, technique and communication of 
character.  At least one of the images should include more than one person.  Choose one category 
from the list below.

1. Manual labourers ................  dockers, builders, mechanics, bakers etc.
2. Professional people ............  doctors, nurses, lawyers etc.
3. Craftsmanship ....................  potters, woodworkers, violin makers etc.
4. Club or team members .......  cricketers, golfers, scouts etc.
5. Family and friends ..............  different generations etc.
6. Character study.................... celebrity, politician, busker etc. 
 This study should include portraits, environmental portraits and close-up detail.

RESOURCES
Editorial:
National Geographic
Newspapers and magazines

Books:
Arnold Newman - TASCHEN America Llc. 2000.
August Sander: 1876-1964. TASCHEN America Llc. 1999.
Brandt: The Photography of Bill Brandt. Harry N Abrams. 1999.
East 100th Street - Bruce Davidson. St Ann’s Press.  2003.
Immediate Family - Sally Mann. Aperture. 1992.
Karsh: A Biography In Images. MFA Publications. 2004.
Portraits - Steve McCurry. Phaidon Press Inc. 1999.
Pictures of People - Nicholas Nixon.  Museum of Modern Art.  New York.  1988.
Richard Avedon Portraits. Harry N Abrams. 2002.
The Brown Sisters - Nicholas Nixon. Museum of Modern Art. New York. 2002.
The Photographs of Dorothea Lange. Hallmark Cards. 1996.
Women - Annie Liebowitz and Susan Sontag. Random House. 1999.
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GALLERY

Lizette Bell

Chris Augustnyk Bec McCubbin
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Shaun Guest

Lizette Bell



aims
     ~ To understand visual communication through narrative techniques.
     ~ To develop an awareness of receptive and projective styles of photography.
     ~ To understand the process of editing to clarify or manipulate communication.
     ~ To increase awareness of commercial, ethical and legal considerations.
 

objectives
     ~ Research - photo-stories and discuss the communication, narrative and structure. 
     ~ Analyse and evaluate - the effectiveness of the work you are studying and   
 exchange ideas and opinions with other students.
     ~ Develop ideas - produce a study sheet that documents the progress and   
 development of your ideas.
     ~ Personal response - capture and/or create images to communicate a specific   
 narrative and edit the work collaboratively.

Andrew Goldie 

photo-story
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INTRODUCTION
The purpose of constructing a photographic essay is to communicate a story through a sequence 
of images to a viewer.  Just as in writing a book, a short story or a poem the photographer must first 
have an idea of what they want to say.  In a photographic essay it is the images instead of words 
that must be organised to tell the story.  Individual images are like descriptive and informative 
sentences.  When the images are carefully assembled they create a greater understanding of the 
individual, event or activity being recorded than a single image could hope to achieve.   Words 
should be seen as secondary to the image and are often only used to clarify the content.  

THE FIRST STORIES
In 1890 the photographer Jacob Riis working in New York produced one of the earliest photographic 
essays titled How the other half lives.  National Geographic magazine began using photographs 
in 1903 and by 1905 they had published an eleven-page photographically illustrated piece on the 
city of Lhassa in Tibet. In 1908 the freelance photographer Lewis W. Hine produced a body of work 
for a publication called Charities and the Commons.  The photographs documented immigrants in 
the New York slums.  Due to the concerned efforts of many photographers working at this time to 
document the ‘human condition’ and the public’s growing appetite for the medium, photography 
gradually became accepted.  The first ‘tabloid newspaper’ (the Illustrated Daily News) appeared 
in the USA in 1919.  By this time press cameras were commonly hand-held and flash powder 
made it possible to take images in all lighting conditions.

The Vet - Michael Mullan
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‘I saw and approached the hungry and desperate 
mother, as if drawn by a magnet. I do not remember 
how I explained my presence or my camera to her, but 
I do remember she asked me no questions. I made five 
exposures, working closer and closer from the same 
direction. I did not ask her name or her history. She told 
me her age, that she was thirty-two. She said that they 
had been living on frozen vegetables from the surrounding 
fields, and birds that the children killed. She had just sold 
the tires from her car to buy food. There she sat in that 
lean-to tent with her children huddled around her, and 
seemed to know that my pictures might help her, and 
so she helped me. There was a sort of equality about 
it.’ Dorothea Lange from: Popular Photography, Feb. 
1960.

FSA 
The 1930s saw a rapid growth in the development of the photographic story. During this decade the 
Farm Security Administration (FSA) commissioned photographers to document America in the grip 
of a major depression.  Photographers including Russell Lee, Dorothea Lange,  Walker Evans and 
Arthur Rothstein took thousands of images over many years.  This project provides an invaluable 
historical record of culture and society whilst developing the craft of documentary photography.

THE PHOTO AGENCIES
In the same decade ‘Life magazine’ was born along with a host of like-minded magazines.  These 
publications dedicated themselves to showing ‘life as it is’. Photographic agencies were formed 
in the 1930s and 1940s to help feed the public’s voracious appetite for news and entertainment.  
The greatest of these agencies Magnum was formed in 1947 by Henri Cartier-Bresson, Robert 
Capa, Chim (David Seymour) and George Rodger. Magnum grew rapidly with talented young 
photographers being recruited to their ranks. The standards for honesty, sympathetic understanding 
and in-depth coverage were set by such photographers as W. Eugene Smith.  Smith was a Life 
photographer who produced extended essays staying with the story until he felt it was an honest 
portrayal of the people he photographed.  He went on to produce the book Minamata about a small 
community in Japan who were being poisoned by toxic waste being dumped into the waterways 
where the people fished.  This was and remains today an inspirational photo-essay.

ACTIVITY 1
Research a photographic story that was captured by either an FSA photographer or a 
photographer working for the Magnum photo agency.
What do the images communicate about the human condition?

Migrant Mother - Dorothea Lange
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VISUAL COMMUNICATION 
Photographic stories are the visual communication of personal experience, as such each story is 
potentially unique and is the ideal vehicle for personal expression.  To communicate coherently and 
honestly the photographer must connect with what is happening.  To connect the photographer 
should research, observe carefully, ask questions and clarify the photographer’s personal 
understanding of what is happening.  Unless the photographer intends to make the communication 
ambiguous it is important to establish a point of view or have an ‘angle’ for the story.  This can 
be achieved by acknowledging feelings or emotions experienced whilst observing and recording 
the subject matter.  All images communicate and most photographers aim to retain control of this 
communication.  Photography can be used as a powerful tool for persuasion and propaganda and 
the communication of content should always be the primary consideration of the photographer.

CHOOSING A SUBJECT
The most popular subject for the photographic story has always been the ‘human condition’. This 
is communicated through experience-based discovery.  The aim is to select one individual or 
group of individuals and relate their story or life experience to the viewer.  The story may relate the 
experience of a brief or extended period of time. 
Finding a story, gaining permission to take images and connecting with the individuals once 
permission has been granted are some of the essential skills required to produce a successful 
story. Tracking down a story often requires curiosity, perseverance, motivation and patience.  
These skills are required by the majority of professional photojournalists who are freelance.  
Freelance photographers find, document and sell their own stories.

Kim Noakes
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THE COMFORT ZONE
The ‘comfort zone’ is a term used to describe the familiar surroundings, experiences and people 
that each of us feel comfortable in and with.  They are both familiar and undemanding of us as 
individuals.  Photography is an ideal tool of exploration which allows us to explore environments, 
experiences and cultures other than our own.  For professional photojournalists this could be 
attending the scene of a famine or a Tupperware party.

 

The student photographer may feel they have to travel great distances in order to find an exotic or 
unusual story.  Stories are, however, much closer at hand than most people realise.  Interesting 
stories surround us.  Dig beneath the surface of any seemingly bland suburban population and 
the stories will surface.  People’s triumphs, tragedies and traumas are evolving every day, in 
every walk of life.  The interrelationships between people and their environment and their journey 
between birth and death are the never ending, constantly evolving resource for the documentary 
photographer.  The photographer’s challenge is to find and connect in a non-threatening and 
sympathetic way to record this. The student of photojournalism should strive to leave their personal 
‘comfort zone’ in order to explore, understand and document the other.  The photographer should 
aim to become proactive rather than waiting to become inspired and find out what is happening 
around them.

ACTIVITY 2 
Find two meaningful photographic stories containing at least four images.  
What is being communicated in each story?  
Have the captions influenced your opinion about what is happening?  
Could a different selection of images alter the possible communication?
Make a list of five photo-essays you could make in your own home town.  
Describe briefly what you would hope to find out and communicate with your images.

Hairspray - Michael Davies
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CAPTURING A STORY
How many movie films have you seen where the opening scene begins with a long and high shot 
of a town or city and moves steadily closer to isolate a single street or building and then a single 
individual.  This gives the viewer a sense of the place or location that the character inhabits.  A 
story constructed from still images often exploits the same technique.  To extend and increase 
the communication of a series of images the photographer should seek to vary the way in which 
each image communicates.  There is a limit to the communication a photographer can achieve by 
remaining static, recording people from only one vantage point. It is essential that the photographer 
moves amongst the people exploring a variety of distances from the subject.  Only in this way will 
the photographer and the viewer of the story fully appreciate and understand what is happening. 
 

The photographer should aim to be a witness or participant at an activity or event 
rather than a spectator.

The images that create a well-crafted photographic story can usually be divided or grouped into 
four main categories.  Not all stories contain images from all four categories but many editors 
expect to see them.  The categories are:

1. Establishing image.
2. Action image.
3. Portrait.
4. Detail image.

Vietnam Vets at the Shrine of Remembrance, Melbourne
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ESTABLISHING IMAGE
In order to place an event, activity or people in context with their environment it is important to step 
back and get an overview.  If the photographer’s essay is about a small coal-mining community 
in a valley, the viewer needs to see the valley to get a feeling for the location.  This image is often 
referred to as the establishing image but this does not necessarily mean that it is taken or appears 
first in the story.  Often the establishing image is recorded from a high vantage point and this 
technique sets the stage for the subsequent shots.  In many stories it can be very challenging to 
create an interesting establishing image.  An establishing image for a story about an animal refuge 
needs to be more than just a sign in front of the building declaring this fact.  The photographer 
may instead seek out an urban wasteland with stray dogs and the dog catcher to set the scene or 
create a particular mood.

ACTION IMAGE
This category refers to a medium-distance image capturing the action and interaction of the 
people or animals involved in the story.  Many of the images the photographer captures may fall 
into this category, especially if there is a lot happening.  It is, however, very easy to get carried 
away and shoot much more than is actually required for a story to be effective.  Unless the activity 
is unfolding quickly and a sequence is required the photographer should look to change the 
vantage point frequently.  Too many images of the same activity from the same vantage point are 
visually repetitive and will usually be removed by an editor.

Coal mine in the Rhondda valley
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PORTRAITS
Portraits are essential to any story because people are interested in people and the viewer will 
want to identify with the key characters of the story. Unless the activity the characters are engaging 
in is visually unusual, bizarre, dramatic or exciting the viewer is going to be drawn primarily to the 
portraits.  The portraits and environmental portraits will often be the deciding factor as to the degree 
of success the story achieves.  The viewer will expect the photographer to have connected with the 
characters in the story and the photographs must illustrate this connection. The connection is aided 
by the use of standard and wide-angle lenses which encourage an interactive working distance.   
Portraits may be made utilising a variety of different camera distances.  This will ensure visual 
interest is maintained.  Environmental portraits differ from straight head and shoulder portraits in 
that the character is seen in the location of the story.  The interaction between the character and 
their environment may extend the communication beyond making images of the character and 
location separately.  

CLOSE-UP OR DETAIL IMAGE
The final category requires the photographer to identify significant detail within the overall scene.  
The detail is enlarged either to draw the viewer’s attention to it or to increase the amount or quality 
of this information.  The detail image may be required to enable the viewer to read an inscription 
or clarify small detail.  The detail image in a story about a craftsperson who works with their hands 
may be the hands at work, the fine detail of the artefact they have made or an image of a vital 
tool required for the process. For very small detail the photographer may require a macro lens or 
magnifying dioptres that can be attached to the existing lens.  When the detail image is included 
with images from the other three categories visual repetition is avoided and the content is clearly 
communicated.

ACTIVITY 3
Find one photographic story that contains images from all four categories listed.
How does each image contribute to the story?
Describe alternative images for each of the categories in the story you have chosen?

Roly Imhoff
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CREATING A STORY
To create a story it is possible to plan and arrange the timing, the subject matter and location so 
that the resulting images fit your requirements for the communication of a chosen narrative.  
To create a story you first need to start with the concept or idea that you would like to illustrate. 
The story can be inspired by the words of a poem or novel that you have read or the lyrics of a 
song. Start with words that create images for the mind and then illustrate what is in your minds’ 
eye. Keep the story short or simple and remember to be realistic about your technical ability and 
the resources (human and physical) to create the story for the camera.

A ‘storyboard’ should first be made that shows the sequence of events that can later be 
photographed. The categories used in ‘Capturing a story’ can be used effectively to create a story 
as well. This will ensure that all of the images required to communicate the story are made with 
efficient use of your resources.

ACTIVITY 4
Look at the work of a photographer who uses sequences of images to narrate a story. 
Can the story be read without words?
Discuss the effectiveness of the communication.

Sharounas Vaitkus
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EDITING A STORY THAT HAS BEEN CAPTURED
The aim of editing work is to select a series of images from the total production to narrate an 
effective story.  Editing can be the most demanding aspect of the process requiring focus and 
energy.  The process is a compromise between what the photographer originally wanted to 
communicate and what can actually be said with the images available. 

EDITORIAL OBJECTIVE
The task of editing is often not the sole responsibility of the photographer.  The task is usually 
conducted by an editor or in collaboration with an editor.  The editor considers the requirements of 
the viewer or potential audience whilst selecting images for publication.  
The editor often has the advantage over the photographer in that they are less emotionally 
connected to the content of the images captured.  The editor’s detachment allows them to focus 
on the ability of the images to narrate the story, the effectiveness of the communication and the 
suitability of the content to the intended audience.  

THE PROCESS
Images are viewed initially as a collective.  A typical process is listed as follows:

 ~ All the proof sheets, prints or transparencies are spread out on a table or light box.  
 ~ All of the visually interesting images and informative linking images are selected and the  
 rest are put to one side. 
 ~ Similar images are grouped together and the categories (establishing, action, portrait  
 and detail) are formed.
 ~ Images and groups of images are placed in sequence in a variety of ways to explore  
 possible narratives.  
 ~ The strength of each sequence is discussed and the communication is established.
 ~ Images are selected from each category that reinforce the chosen communication. 
 ~ Images that contradict the chosen communication are removed. 
 ~ Cropping and linking images are discussed and the final sequence established.

ACTIVITY 5
Create at least 20 images of a chosen activity or event taking care to include images from 
all of the four categories discussed in this chapter.  
Edit the work with another student who can take on the role of an editor.  
Edit and sequence the images to the preference of the photographer and then again to the 
preference of the editor.
Discuss the editing process and the differences in outcome of both the photographer’s and 
editor’s final edit.



>
>

>
FO

U
N

D
AT

IO
N

S
Photo-story

Ph
ot

og
ra

ph
y >>

>
>

>
>

123

ETHICS AND LAW
Will the photograph of a car crash victim promote greater awareness of road safety, satisfy morbid 
curiosity or just exploit the family of the victim?  If you do not feel comfortable photographing 
something, question why you are doing it.  A simple ethical code of practice used by many 
photographers is:  ‘The greatest good for the greatest number of people’.  
Papparazzi photographers hassle celebrities to satisfy public curiosity and for personal financial 
gain.  Is the photographer or the public to blame for the invasion of privacy?
The first legal case for invasion of privacy was filed against a photographer in 1858.  The law 
usually states that a photographer has the right to take a picture of any person whilst in a public 
place so long as the photograph:

 ~ is not used to advertise a product or service;
 ~ does not portray the person in a damaging light (called defamation of character).  

If the photographer and subject are on private property the photographer must seek the permission 
of the owner.  If the photograph is to be used for advertising purposes a model release should be 
signed.
Other legal implications usually involve the sensitivity of the information recorded (military, political, 
sexually explicit etc.) and the legal ownership of copyright.  The legal ownership of photographic 
material may lie with the person who commissioned the photographs, published the photographs 
or the photographer who created them.  Legal ownership may be influenced by country or state 
law and legally binding contracts signed by the various parties when the photographs were 
created, sold or published.

DIGITAL MANIPULATION
Images are often distributed digitally which allows the photographer or agency to alter the images 
subtly in order to increase their commercial potential. Original negatives or transparencies may 
never be sighted by an editor.  A photographer, agency or often the publication itself may enhance 
the sharpness, increase the contrast, remove distracting backgrounds, remove information or 
combine several images to create a new image.  What is legally and ethically acceptable is still 
being established in the courts of law.  The limits for manipulation often rests with the personal 
ethics of the people involved.  

ACTIVITY 6
Discuss the ethical considerations of the following:

~  Photographing a house fire where there is the potential for loss of life.
~  Photographing a celebrity, who is on private property, from public property.
~  Manipulating a news image to increase its commercial viability.
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ASSIGNMENTS
Produce a six image photo-story giving careful consideration to communication and narrative 
technique. For each of the five assignments it is strongly recommended that students:

 ~ Choose activities, events or social groups that are repeatedly accessible.
 ~ Avoid choosing events that happen only once or run for a short period of time.  
 ~ Approach owners of private property in advance to gain relevant permission.
 ~ Have a back-up plan should permission be denied.
 ~ Introduce yourself to organisers, key members or central characters of the story.
 ~ Prepare a storyboard if you are creating a story.

Capture a story. Document one of the following categories:

1. Manual labour or a profession.
2. Minority, ethnic or fringe group in society.
3. An aspect of modern culture.
4. An aspect of care in the community.

Create a story to illustrate one of the following:

5. The dream.
6. The journey.
7. The encounter.
8. A poem, short story or the lyrics to a song.

RESOURCES
Books
American Photographers of the Depression - Charles Hagen. Thames and Hudson. 1991.
Don McCullin. Jonathon Cape. 2003.
Photofile - Duane Michals.  Thames and Hudson.  London.  1990.
Farewell to Bosnia - Gilles Peress.  Scalo.  New York.  1994.
In This Proud Land - Stryker and Wood.  New York Graphic Society.  New York.  1973. 
Minamata - W. Eugene and Aileen Smith.  Chatto and Windus.  London.  1975. 
Sleeping with Ghosts - Don McCullin.  Vintage.  London.  1995.
Terra: Struggle of the Landless. Phaidon Press Inc. 1998.
The Concerned Photographer  2 - Cornell Capa.  Viking Press.  1973.
The Photographs of Dorothea Lange. Hallmark Cards. 1996.
Workers - Sebastião Salgado. Phaidon Press.  London.  1993.

Magazine
National Geographic magazine.

Websites
Black Star photo agency - http://www.blackstar.com
FSA - http://lcweb2.loc.gov/ammem/fsowhome.html
Magnum Photo Agency - http://www.magnumphotos.com
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GALLERY

Michael Davies
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Anthony Secatore



 

aims
    ~ To develop an understanding of why and how photographic images are constructed.
    ~ To develop an awareness of how the photographic image can be manipulated to  
 communicate specific messages.

objectives
    ~ Research - a range of photographic images from the printed media, documentary   
 and advertisements.
    ~ Analyse and evaluate - how effective the media is in its aims.  Exchange ideas and  
 opinions with other students.
    ~ Develop ideas - produce a study sheet that documents the progress and   
 development of your ideas.
    ~ Personal response - produce artwork individually and in teams to demonstrate how  
 photography can be used to communicate different messages.

Mark Galer

visual literacy
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INTRODUCTION
A photograph, whether it appears in an advertisement, a newspaper or in a family album is often 
regarded as an accurate and truthful record of real life.  Sayings such as ‘seeing is believing’ 
and ‘the camera never lies’ reinforce these beliefs.  In this study guide you will learn that the 
information we see in photographs is often carefully selected by the photographer or by the editor 
so that what we believe we’re seeing is usually what somebody else would like us to see.  By 
changing or selecting the information we can change the message. 
The concepts of time, motion and form that exist in the real world are accurately translated by 
the photographic medium into timeless and motionless two-dimensional prints.  Photographers, 
editors and the general public frequently use photography to manipulate or interpret reality in the 
following ways:

1. Advertisers set up completely imaginary situations to fabricate a dream world to which they 
would like us to aspire.
2. News editors choose some aspects of an event, excluding others, to put across a point of view.  
3. Family members often choose to record only certain events for display in the family album, 
excluding others, so that we portray the image of the family as a happy and united one.

Photography is a powerful media tool capable of persuasion and propaganda.  It appears to offer 
truth when in reality it can portray any manipulative or suggestive statement.
The camera may record accurately but it is people who choose what and how it records.  A 
photograph need only be sufficiently plausible so that it appears to offer the truth.

Cambodian Refugee Camp - Burk Uzzle
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MANIPULATION TECHNIQUES
Framing and cropping - This technique is used to include or exclude details that may change the 
meaning of the photograph.  The photographer, by moving the frame, or the editor by cropping it, 
defines the content of what we see.  By framing two facts it can create a relationship where none 
may otherwise exist.  By excluding a fact it may break one, e.g.  an old woman sitting on a park 
bench feeding the birds might appear lonely if we have moved the frame slightly to exclude her 
granddaughter playing nearby.

Editing - A photographer chooses a subject matter that he believes to be important and selects 
the decisive moment to take the picture.  In order to present a personal point of view the editor may 
then decide to select only one aspect of the photographer’s work.

Captions - A caption may give the picture a moral, social, political, emotional, or historical 
meaning that emphasises the intended message.

Focusing - The amount we see ‘in-focus’ can vary and draw our attention to a specific part of the 
photograph.

Vantage point or angle - The photograph may be taken from above, below or at eye level.  
Photographs taken from a low vantage point tend to increase the power and authority of the 
subject whilst those taken from above tend to reduce it.

Lighting - This can change the atmosphere or mood of the scene, e.g. soft and subtle, dramatic 
or eerie.

Image mode - Black and white or colour.  The contrast and colours may vary. 

Subject distance - The closer we appear to be to the subject the more involved we become and 
the less we discover about the subject’s environment or location.

Lens distortion - By using a telephoto lens detail and depth can be compressed, condensed and 
flattened.  Subject matter appears to be closer together.  By using a wide-angle lens distances are 
exaggerated and scale is distorted.  Things that are close to the lens look larger in proportion to 
their surroundings than they really are.  Things in the distance look much further away.  An estate 
agent may use a wide angle lens to make a room look bigger.

Composition - Lines, shapes and areas of tone or colour are placed within the picture frame to 
attract or guide our attention, e.g.  diagonal lines, whether real or implied, make the picture more 
dramatic and give us a sense of movement.  Due to the strong colour contrast, a person wearing 
a red jacket in a green field will instantly draw our attention.

Photomontage - An image may be assembled from different photographs.  By adding or removing 
information the final meaning is altered (see ‘Photomontage’).

PHOTOGRAPHIC CATEGORIES
Art - A display of skill and/or creative expression.
Documentary  - A factual record often with a social or political theme.
Commercial  - Social photography (weddings, portraits etc.) and the promotion of products  
    or services.
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ACTIVITY 1 - COVERAGE
Collect one glossy magazine, one ‘tabloid’ newspaper and one ‘broadsheet’ newspaper. 
What percentage of each publication is covered by photographs? 
What percentage of these are advertising images?

ACTIVITY 2 - ANALYSIS
1.  Remove a selection of photographs complete with any text and captions from the media 
sources you have used in activity 1.  After studying each photograph prepare a table, as in 
the example below, using the same headings.  In describing the subject matter you will need 
to consider:

     ~ Who is the main figure in the photograph.
     ~ How they look.
     ~ Who else appears and how they react to the main figure.
     ~ What else appears in the photograph e.g. objects, location, setting.

    

2.  Twenty years ago John Berger wrote in ‘Ways of Seeing’ that advertising showed us 
images of ourselves, made glamorous by the products it was trying to sell.  He claims the 
images make us envious of ourselves as we might become, as a result of purchasing the 
product.  Berger also believes that advertising makes us dissatisfied with our present position 
in society.
Look at the images you have collected.  Which of the following are we likely to envy or 
admire in each image:

     ~ Power
     ~ Prestige and status
     ~ Happiness
     ~ Glamour
     ~ Sexuality

Do any of your advertisements appeal to different emotions other than admiration and envy?  
With advertising becoming increasingly sophisticated and less blatant, do John Berger’s 
claims still ring true? 

Category Subject matter Photographic techniques Implied message

Advert for
beauty
product.

Woman well-dressed 
in the grounds of a 
large country house.
Handsome, well-dressed
young man looking on.

Warm colours, softly lit
low vantage point, focus
on woman. Woman placed
centrally in foreground.

Affluence,
glamour,
sexual 
admiration,
happiness,
contentment.
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GLAMOUR IN ADVERTISING
A connection between the product and a glamorous individual or lifestyle is often established in 
advertising. In the example above an attractive woman is sitting at a table in a café with a male 
onlooker. Her style of clothing, expression and body language are indications of her sophistication 
and confidence.

Implied communication: The woman is sophisticated, sexy and self-assured. Sophisticated, 
sexy and self-assured women purchase this brand of water. Purchasing this water will make you 
this glamorous.

‘San Pellegrino’ - Andrew Butler
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AMBIGUITY IN ADVERTISING
Almost in response to John Berger’s attempts to unravel the communication of advertising, the 
communication of some adverts became less obvious. The communication of a ‘feel good factor’ 
instead of the promotion of glamour became a popular style of advertising in the 1990s, the content 
of the advert often having little to do with the product. 

THE ‘FEEL GOOD’ FACTOR
The aim of this style of communication is for the consumer to connect a positive emotion with the 
product. The game is ‘find the product’ or ‘solve the riddle’. The reward is achievement. For many 
years cigarette-advertising campaigns, such as those run by ‘Benson & Hedges’ and ‘Silk Cut’, 
disguised the product or failed to show the product at all. The campaigns invite the viewer to solve 
a visual puzzle. By solving the puzzle the viewer feels good. The viewer starts to associate the 
feeling with the product. It is important to understand that if ambiguity is present in media images, 
it is there usually by intention or design. 

Media images are designed by their authors or editors to communicate specific messages to 
their targeted audience. Lifestyle magazines often remove visual reminders of the real world from 
their pages. Peter Kennard says ‘The problems and contradictions of our society are contained 
by keeping the elements rigidly separate’. Public confusion and anger was created when viewers 
could not find the glamour or ‘feel good factor’ in Benetton’s advertisements of the 1990s. Why 
were they not advertising the product? Benetton claim that they are using the vehicle of advertising 
for social comment. If we identify with the social concerns of the company however, is the feel 
good factor still present?

© 1989 Benetton Group S.p. A. Ph.: Oliviero Toscani
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ACTIVITY 3 - CAPTIONS
In this activity you will look at how captions reinforce the message implied in a photograph.  
Captions that accompany photographs can be:

 ~ Explicit - stating something very clearly as fact.
 ~ Implicit - suggesting that something is true.

For this activity you need to choose photographs and their captions from both the advertising 
and documentary categories.  Rewrite the captions that accompany each to give a different 
point of view or bias.  You may like to think of captions that change the moral, political, 
emotional or historical meaning of the photograph.  The caption you choose may even 
change the category in which the photograph first appeared.
Present your work and discuss how you have changed the meaning of the photographs and 
how effective the new messages have become. 

ACTIVITY 4 - JUXTAPOSITION
Photomontage is a technique where separate photographs are combined to create new 
meanings.  The interaction between the new elements creates a new meaning.  Below we 
see the unintentional and incongruous juxtaposition of two posters in the street. 

‘An entirely new meaning is made in the distance that exists between the glamour 
and eroticism of western fashion and the economics of survival in the third world.’

Peter Kennard - Photomontage Today.

Using some of the photographs you have collected, cut out various elements from each and 
rearrange them to make new images with new messages.  The sort of new images that work 
best are where strong contrasts are placed together, e.g. unemployment queues standing 
next to advertisements for luxury merchandise.

                  Mike Wells 1980
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ACTIVITY 5 - GROUP PRACTICAL
For this practical activity you should split up into groups of three or four.  Your group will have 
a broader perspective if the members are not all male or female.
The things you will need for this activity are as follows:

 ~ camera
 ~ location
 ~ assortment of props

Using appropriate photographic techniques as discussed earlier, take photographs for each 
of the following categories:

 ~ Advertising
 ~ Documentary

Repeat the exercise using one or more inappropriate techniques to create a satirical 
photograph for each of the categories.  Allow six frames for each individual in the group.

ACTIVITY 6 - EDITING
This activity requires that you work in pairs to act as a newspaper editor and photojournalist.  
Your objective is to produce a short news story that is either biased or unbiased.
Use titles, photographs and captions.  Text is optional but you may consider pasting down 
some text to create a realistic mock-up of the finished article.
The editor may choose not to tell the photographer which stance he or she is going to take 
on the subject.  The photographer may choose to manipulate the range of images supplied 
to the editor.
Your teacher will give you advice on the range of topics you may choose from, or you can 
make your own suggestions.

IMPORTANT
Discuss in detail each shot before you commit yourself to taking the picture.  You might 
like to consider a possible caption for each shot before planning your photographs.
Prepare for any technical difficulties that you think you may encounter, e.g. working 
with a tripod if you are shooting indoors without a flash.
You have probably already noticed how many photographers fill the frame with their 
subject matter in order to make a bold statement.  Avoid standing too far back in your 
own shots unless you have a specific reason to do so.
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ACTIVITY 7 - THE FAMILY ALBUM
1.  In this activity you will be looking at the way the family is portrayed both in the media and 
in our own family albums. 
Collect some media photographs that portray the family and analyse them using the criteria 
you used in Activity 2:

 ~ Category
 ~ Subject matter
 ~ Photographic techniques
 ~ Implied message

Apply the same criteria to the photographs that appear in a typical family photograph album.  
Pay particular attention to the way the photographs have been edited.  What aspects of 
family life were edited out or simply not recorded in the first place?  Do you think the family 
album is a true representation of family life?  How useful or damaging would it be to alter the 
type of events that are considered worthy of being placed in the family album?

2.  Write a short essay evaluating your findings.  Discuss how you think media images have 
affected you, your family and the general public.  Try to be as honest as you can.

RESOURCES
The following resources are suggestions only.  You or your teacher may add to this list.

Images from the press
Newspapers (both ‘tabloid’ and ‘broadsheet’).
Magazines.

Recommended reading
On Photography - Susan Sontag. Picador. 2001.
Ways of Seeing - John Berger.  Viking Press. 1995.

Images with accompanying text
About 70 Photographs - Chris Steele-Perkins.  Arts Council of Great Britain. 1980.
Basic Photography - M. Langford.  Focal Press. Oxford. 2000.
Images for the End of the Century - P. Kennard.  Journeyman Press. London. 1990.
In Our Own Image - Fred Ritchin. Aperture. 1999.
Looking at Photographs - John Szarkowski.  Bulfinch Press. 1999.
The Media - Brian Dutton. Pearson Schools.  1997.
The Photograph - Graham Clarke. Oxford University Press. 1997.

Video
Photomontage Today - Peter Kennard (35 minute video). Arts Council of Great Britain.
http://www.roland-collection.com/rolandcollection/Section/36/667.htm

Personal photographs
Family photograph albums.
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Tamas Elliot

GALLERY



Technical Guides





aims
    ~  To offer an independent resource of technical information. 
    ~  To develop knowledge and understanding about camera equipment.

objectives
    ~  Operate the basic controls of an SLR camera.
    ~  Adjust shutter speed and aperture in response to taking light meter readings.
    ~  Correctly expose images.
    ~  Care for camera equipment.

Mark Galer

the camera
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INTRODUCTION
At first glance the SLR camera is a sophisticated and confusing piece of equipment.  Just as with 
any other complex piece of machinery the user can, over a period of time, become very familiar 
with its operations and functions until they are almost second nature.  Operating the SLR camera, 
just like driving a car, is a skill which is attainable by most people.  How long it will take to acquire 
this skill will very much depend on the individual and how much time they are prepared to spend 
operating the camera.  Different makes and models of SLR cameras may appear very different but 
they all share the same basic features. The features may be placed in different locations on the 
camera body or operated automatically.  If you have any difficulty in finding a particular feature on 
your own camera ask a teacher or consult your camera manual.

Note >  Digital SLR cameras are slowly coming down in price but are still very expensive. If you elect 
to purchase a digital compact camera you must ensure that the model you choose has adequate 
control over both the shutter speed and lens aperture in order for the camera to be a creative tool.

WHY AN SLR?
The SLR is the most popular camera used by keen amateurs and professionals alike.  The  format 
has advantages over larger formats in that a large range of accessories is available and the 
system is easily portable.  The term ‘single lens reflex’ describes the way we view the image with 
this type of camera.  The SLR camera has a single lens unlike compact cameras which have two 
(one for viewing and another for capturing the image).  The single lens of the SLR camera is used 
to view the subject and take the picture.  This is achieved by the use of a mirror behind the lens 
which reflects the image up into the viewfinder via the ‘pentaprism’.  The pentaprism converts the 
mirror image to one which appears the right way round.  If we change the lens, use a coloured filter 
or change the focus we can see all of these changes through the viewfinder. 

AUTOMATIC OR MANUAL
If your camera operates automatically spend some time finding out how the camera can be 
switched to manual operation or how you can override the automatic function.  Automatic cameras 
are programmed to make decisions which are not necessarily correct in every situation.  A good 
photographer must be able to use the manual controls of the camera.

CARE OF THE CAMERA
1. Avoid dropping your camera - use a strap to secure it around your neck or wrist.
2. Avoid getting your camera wet - cover the camera when it starts to rain.
3. Only clean your camera lens with a soft brush or a lens cleaning cloth.
4. Never touch the mirror, shutter or digital chip inside the camera body.  
 These items are extremely delicate.

Note >  Damage to your camera can usually only be repaired by a camera specialist and will 
usually incur a minimum fee which can be greater than the value of your camera.   
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Load the film cassette.  Lift 
the rewind crank to insert the 
cassette.

Attach the film leader to the 
take-up spool.  Most of the film 
leader can be inserted.

Press the shutter release and 
advance the film.  The teeth must 
engage with the sprocket holes.

Take up any slack in the film 
by rewinding the crank handle 
gently.  Close the back securely.

Open the back of the camera.   
This is usually done by pulling 
the rewind crank up.  

Push the rewind crank down 
and pull a short length of film 
out of the cassette.

THE FIRST FILM (USING A CLASSIC STYLE CAMERA)

Take two blank shots and 
advance the film.  Check the 
rewind crank turns each time 
you advance the film.   

Set the film speed or ISO on 
the   film speed selector.  This 
is not moved again whilst 
exposing this roll of film.

Select a shutter speed. Usually 
no slower than 1/60 second 
unless you are using a tripod.
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Advance the film using the film 
advance lever. The shutter will 
only fire when fully advanced.

Adjust the aperture and shutter 
speed until an appropriate 
exposure is obtained.

Hold the camera firmly, frame 
your shot and press the shutter 
release gently.

When the last frame has been 
taken push the film rewind  
button.

Rewind the film smoothly back 
into the cassette, approximately  
one complete turn per frame.

THE FIRST FILM (CONTINUED)

Move the focusing ring back 
and forth until your subject 
appears as sharp as possible.

Remove the film by raising the 
rewind crank.  If the film leader 
is still visible, mark the film to 
indicate that it is exposed. 

Place the film back into its 
container until you are ready to 
process it.  This will protect the 
film from moisture and dirt. 

When you feel or hear the film 
coming away from the take-up 
spool stop rewinding the film.  
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MODERN AUTOMATED FILM CAMERAS

Many modern SLR cameras 
include a host of  automated 
features. These include 
automatic film loading  and 
advance after exposure, 
focusing, film speed setting 
and exposure. Exposure 
compensation and manual 
exposure should be available 
if the camera is to be used 
creatively.

With no film rewind crank, the 
camera back is usually opened 
via a lever on the side.

The film leader is aligned to 
a marker on the camera body 
before closing the back.

Film speed is set automatically 
and the exposure mode (auto 
or manual) is dialled in.

Camera functions and 
exposure information can be 
viewed via LCD figures and 
symbols.

Additional controls on some 
automated cameras allow 
control over lens apertures, 
focus and/or exposure lock.

Camera functions are accessed 
via pressing a function button 
and rotating a control wheel to 
select an alternative setting.
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DIGITAL CAMERAS

Digital cameras use a light sensitive image sensor instead of film. The advantage of the image 
sensor is that it is reusable.  It is able to ‘download’ (transfer) its information to a disk or ‘card’ after 
every captured image.  The image is able to be viewed as soon as it is captured (without the need 
for chemical processing). Although the initial purchase of a digital camera is expensive the money 
saved on film and processing has to be taken into consideration. In making a decision as to whether 
it is advantageous to purchase a digital camera the following points should be considered:

 ~  Creative control
 ~  Quality
 ~  Cost
 ~  Convenience

Creative control
Establish whether the digital camera offers the individual control over the lens aperture and the 
duration of the exposure (the creative controls for depth of field and movement blur). 

Quality of image
With digital cameras offering over 3 Megapixels the limiting factor to final quality is usually the 
printer and not the resolution of the image sensor. 3 megapixels is sufficient to create a high 
quality full-page inkjet print.

Cost 
Capturing images using digital cameras is cheaper, frame for frame, when compared to film.  This 
takes into account the cost and effective life of the batteries required to run a digital camera and 
the safe handling and disposal of chemicals (health and safety).

Convenience
The method and speed of transferring images from a digital camera to the computer must be 
compared to the time spent processing and scanning film.  Most photographic labs however are 
now able to offer an affordable and effective scanning service. 
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f.16 f.8 f.4

EXPOSURE

THE APERTURE
The aperture of the camera lens opens and closes like the iris of the human eye.  Just as the human 
iris opens up in dim light and closes down in bright light to control the amount of light reaching 
the retina, the aperture of the camera lens must also be opened and closed in different lighting 
conditions to control the amount of light that reaches the film or image sensor.  The film or image 
sensor requires exactly the right amount of light to create an image.  Too much light and the image 
will be overexposed (film negatives appear very dark or dense when processed).  Not enough light 
and the image will be underexposed (film negatives appear very light or ‘thin’ when processed). 

   
We are guided to select the correct aperture by the light meter.  As the aperture ring is turned on 
the camera lens a series of clicks can be felt.  These clicks are called f-stops and are numbered.  
Depending upon which way you turn the aperture ring every stop lets exactly twice or half as much 
light reach the film or image sensor as the previous one.  The light meter will advise you when 
you are getting closer to the correct aperture.  The highest f-number corresponds to the smallest 
aperture and the smallest f-number corresponds to the widest aperture.

THE SHUTTER
When the shutter button is pressed the shutter opens for the amount of time set on the shutter 
speed dial.  These figures are in fractions of seconds.  The length of time the shutter is open also 
controls the amount of light that reaches the film or image sensor, each shutter speed doubling or 
halving the amount of light.  Exposure, therefore, is a combination of aperture and shutter speed.
To slow the shutter speed down is to leave the shutter open for a greater length of time.  Shutter 
speeds slower than 1/60 second can cause movement blur or camera shake unless you hold the 
camera steady with a tripod or by some other means. 
To use a shutter speed faster than 1/250 second requires a wide aperture, and/or a film or image 
sensor set to a high ISO, to compensate for the small amount of light that can pass through a shutter 
that is open for such a short amount of time.  It is suggested that you keep the shutter speed dial on 
1/60 or 1/125 second until you are familiar with the equipment that you are using.

      f16             f8      f4
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TTL LIGHT METERS
‘Through the lens’ (TTL) light meters built into cameras measure the level of reflected light prior 
to exposure.  They measure only the reflected light from the subject matter within the framed 
image.  The meter averages out or mixes the differing amounts of reflected light in the framed 
image and indicates an average level of reflected light.  The light meter readings can be translated 
by the camera’s ‘central processing unit’ (CPU) and used to set aperture and/or shutter speed.

CENTRE-WEIGHTED AND MATRIX METERING
‘Centre-weighted’ and ‘matrix metering’, common in many cameras, bias the information 
collected from the framed area in a variety of ways.  Centre-weighted metering takes a greater 
percentage of the information from the central area of the viewfinder.  The reading, no matter how 
sophisticated, is still an average - indicating one exposure value only.  Any single tone recorded 
by the photographer using a TTL reading will reproduce as a mid-tone, no matter how dark or 
light the tone or level of illumination.  This tone is the midpoint between black and white.  If the 
photographer takes a photograph of a black or white wall and uses the indicated meter reading to 
set the exposure, the final image produced would show the wall as having a mid-tone.

AUTOMATIC TTL EXPOSURE MODES
If the camera is set to fully automatic or programme mode both the shutter speed and aperture 
will be adjusted automatically so that the correct exposure will usually be obtained.  In low light 
the photographer using the programme mode should keep an eye on the shutter speed which 
is being used to achieve the correct exposure.  The reason for this is that as the lens aperture 
reaches its widest setting the programme mode will start to use shutter speeds slower than ones 
usually recommended to avoid camera shake.  Many cameras alert the photographer when 
this is happening using an audible signal.  This should not be treated as a signal to stop taking 
photographs but as one to take precautions to avoid camera shake such as bracing the camera 
in some way.

Centre-weighted TTL metering
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2. One light indicates the shutter speed that 
has been selected.  Move the other light or 
lights towards this one by altering the aperture 
or shutter speed until only one light shows.

1. Position the needle between the + and - 
symbols by altering the aperture or shutter speed.  
The box containing the + and - symbol may be 
replaced by a second needle or a circle.

USING THE LIGHT METER
The light meters found in most cameras will show the light meter reading inside the viewfinder.  
This allows the photographer to alter the camera settings to achieve the correct exposure without 
having to remove the camera from the eye.  
Inside the viewfinder you should see either a needle, a series of lights or an LED display. Changes 
should occur when the camera is pointed towards the light.  The camera’s light meter requires a 
healthy battery to work so if you cannot see any changes consult a teacher or camera dealer. 
Most cameras will have a metering system which will resemble one of the four below.  If your 
metering system is different seek advice.

3. Move the aperture or shutter speed until 
the symbol ‘0’ is illuminated.
Too much light is indicated by a +  
Too little light is indicated by a -

 +
  0 

 -
4. Decrease or increase exposure as guided 
by a series of bars which are displayed (if 
there is insufficient or excessive exposure) 
either side of the 0 symbol.         

ACCURATE METERING
When taking a light meter reading try to avoid pointing the centre of the viewfinder towards a bright 
light or tone when setting the exposure.  Reposition the centre of the viewfinder on the average 
tones of your subject instead.  Set the exposure and then reframe the image.

 +
 -

         *0      

          *0

 500
125
 60
 30
15
 8
 4
 2
 1

[                   ]

 + lll 0    -
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DOMINANT TONES
The ‘through the lens’ (TTL) light meter found in most cameras measures the level of reflected 
light from the subject in the framed image.  The TTL meter does not measure the level of 
illumination from the light source (ambient light).  The light meter reading is an average between 
the reflected light from all the tones framed.  When light and dark tones are of equal distribution 
within the frame this average light reading is suitable for exposing the subject.  When light or dark 
tones dominate in the image area they overly influence the meter’s reading and the photographer 
must increase or decrease exposure accordingly.

 When light or bright tones dominate increase the exposure from that indicated.
 When dark tones dominate decrease the exposure from that indicated.

Note > Adjustments to the aperture or shutter speed will be compensated for in automatic 
modes.  The adjusted exposure must therefore be made using the exposure compensation 
function (see ‘Light - Exposure compensation’). 

APERTURE PRIORITY (AV)
This is a semi-automatic function whereby the photographer chooses the aperture and the camera 
selects the shutter speed to achieve the indicated exposure.  This is the most common semi-
automatic function used by photographers. 
When aperture priority is selected the photographer needs to be aware of slow shutter speeds in 
low light conditions or when using small apertures.  To avoid camera shake and unintended blur 
in these instances the photographer has a number of options:

    ~ Select a wider aperture.
    ~ Use a faster film or ISO rating.
    ~ Mount the camera on a tripod.
    ~ Use a lens with a wider maximum aperture.
    ~  Brace the camera by supporting or resting your elbows, arms or hands on or against a  
 stable surface.

With practice it is possible to use shutter speeds slower than the minimum recommended by the 
manufacturers.

SHUTTER PRIORITY (TV)  
This is a semi-automatic function whereby the photographer chooses the shutter speed and the 
camera selects the aperture to achieve the correct exposure.  In choosing a fast shutter speed the 
photographer needs to be aware of underexposure when the light levels start to drop.  The fastest 
shutter speed possible is often limited by the maximum aperture of the lens.  In choosing a slow 
shutter speed the photographer needs to be aware of over- exposure when photographing brightly 
illuminated subject matter.  Movement blur may not be possible when using fast film or high ISO 
setting in bright conditions.





aims
    ~   To offer an independent resource of technical information. 
    ~   To develop knowledge and understanding about the technical processes and   
 procedures involved with producing photographic images.

objectives
    ~   Develop black and white photographic film in daylight developing tanks.
    ~   Produce proof sheets from black and white film for editing purposes.
    ~   Produce clean black and white prints with acceptable sharpness and contrast.

Mark Galer

wet process and print



Photography: Foundations for Art & Design
FO

U
N

D
AT

IO
N

S
>

>
>

P
ho

to
gr

ap
hy
 >>>

>
>

>

152

FILM PROCESSING
You must use a light-tight darkroom and be able to lock the door behind you if possible. 
You must have with you a DRY film spool, black centre column for the spool, developing tank, tank 
lid, scissors and film cassette opener if needed.

1. LIGHTS ON
If you have rewound your film leaving the leader out, or have managed to retrieve the leader using 
a special device, the following can be carried out with the lights on.
Cut the leader off between the sprocket holes and feed the first 4 cm onto the spool. 

2.  ALTERNATIVE WITH THE LIGHTS OFF
If the leader is wound into the cassette perform the following in total darkness.   
Practise loading a blank film onto a spiral in daylight before attempting this in the dark.
Open the cassette in total darkness with a special tool similar to a bottle opener.
Gently withdraw the film from the cassette and remove the film leader with a pair of scissors.  
Check that no ragged corners are left.
Let the film hang down and push the film gently into the gate of the spiral. 

3. LOAD FILM IN TOTAL DARKNESS
Wind the film gently onto the spiral by twisting one side of the spiral back and forth.
If the film jams, remove it from the spiral and start again.  Check the spool is dry and the leading 
edge of the film is not damaged.
When the film is wound onto the spiral remove the film spool (cut or tear the tape).
Push the loaded spiral onto the centre column and then place into the tank.  Check that the centre 
column base is placed down towards the base of the tank.
Place the lid on the tank ensuring that the lid is not twisted in the process.
Check with the other students before switching any lights on.

4. PREPARE THE CHEMICALS
Fill a 2 litre jug with water at 20°C.  Use a thermometer and mix hot and cold water if necessary.  
If the film developer is very cold or warm this temperature may be raised or lowered slightly to 
compensate.
Measure accurately with a measuring cylinder the correct amount of film developer for each film 
to be developed (if the developer is concentrated a small measuring cylinder should be used to 
gain an accurate reading).
Pour the developer into a measuring cylinder containing enough water to make up the total 
quantity needed.
Have ready measuring cylinders with the required amount of stop and fix.

Note > It is recommended to prepare enough chemicals to completely fill the developing 
tank regardless of the number of films being processed.
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Place your thumbs behind the 
entrance to the gate as you 
wind the film onto the spiral.

Lay out the equipment so 
that you will be able to find 
everything in the dark.

Cut off the leader between the 
sprocket holes and feed a few 
centimetres onto the spiral.

Switch off the light and pull the 
film cassette gently down until 
about a metre of film is free.

Prepare a jug full of water at 
20°C.  Measure this accurately 
with a thermometer and adjust 
the temperature if necessary.

Place the spiral onto the column 
and ensure the lip is facing 
towards the base of the tank.  

When no more film is left in the 
cassette, remove it using a pair 
of scissors.

Measure out the film developer 
into a small cylinder and make 
up to the required amount 
using the water from the jug.

Turn the lid of the tank clockwise 
until it locks into place.

FILM PROCESSING (PART 1)
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5. PRESOAK
Fill the developing tank with water from the mixing jug (20°C). Agitate the tank gently for 1 minute 
to bring the tank and film up to temperature and to soften the film emulsion.

6. DEVELOP
Pour the solution into the tank quickly and start timing immediately.
Press on the liquid seal firmly and invert the tank continuously for 20 seconds.
After every minute give a further 2 inversions of the tank (5 seconds agitation in total).
Start to pour the developer away 15 seconds before the developing time has elapsed.  

7. STOP
Fill the tank with STOP BATH from the measuring cylinder.
Replace the cover and invert for 30 seconds.
Return the stop bath to the correct container using a funnel (if stop turns blue, pour away).

8. FIX
Fill the tank with fixer from the measuring cylinder which has already been diluted.
Replace the cover and invert once every 15 seconds for 5 minutes.
Return the fixer to the correct container using a funnel.

9. WASH
Fill the tank with water from the mixing jug, replace the seal and invert several times.
Pour the water away and remove the tank lid.
Check that the film is clear (no milkiness) and wash under running water for 15-20 minutes. 

10. FINAL RINSE
Remove the films from the tank and add a few drops of wetting agent to the water.
Replace the films and waterproof seal, invert twice and leave for 30 seconds.

11. DRY
Remove the films from the tank and remove from the film spiral.
Shake the excess water from the spiral (a flicking of the wrist removes most of the water).
Hang the films up to dry with a weight on the bottom so that they dry straight.
Hang the films to dry in a dust-free place.
Do not dry the film with a hair-dryer as this may damage the film.
Film should dry in 10 minutes in a film dryer or 2 hours if hung on a line.
Do not use excessive heat to dry your films.

12. CLEAR AWAY
Replace all the lids on the chemical bottles.
Rinse all parts of the tank and mixing equipment and leave to drain.
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Fill the tank with stop bath, 
replace the cover and invert 
for 15 seconds.

Wash the film for 20 minutes. 
Add a few drops of wetting 
agent to the final wash.  Shake 
all water from the spiral.

Replace all of the tops on the  
chemical containers and put 
the tank and spiral in a warm 
place to dry.

After the correct time has 
elapsed pour the developer 
away.

Invert the tank for 20 seconds 
and then twice every minute.  

Pour in the developer quickly, 
start timing and attach the 
liquid seal to the tank.

Save the fix, rinse the tank out 
with water and then inspect the 
film to ensure that it is clear.

Pour the stop bath back into its 
container and then fill the tank 
with fixer.

Hang the film up to dry in a 
dust-free area with a weight 
attached to the base.  Wash all 
the equipment and surfaces.

FILM PROCESSING (PART 2)
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PRINT PROCESSING
Producing your own prints is a rewarding photographic activity.  To get the best results and avoid 
wasting materials you should adopt a methodical and patient approach.

HEALTH AND SAFETY  
It is important to protect yourself and your clothes from chemical contamination when  processing 
photographic paper.  Although the chemicals are not highly corrosive they can lead to rashes and 
stained clothes.  The following precautions must be taken.

a)  Wear a laboratory coat or old shirt at all times whilst processing.
b)  When pouring chemicals wear protective gloves and eye protection.
c)  Never handle prints with your hands.  Use the print tongs provided.
d)  Wash contaminated skin or clothes immediately with soap and water.
e)  Never sit on work surfaces that have come into contact with chemicals.
f)  Never bring food or drink into an area where chemicals are being used.  
g)  Ensure that the room you are working in is well ventilated. 

PROCESSING RESIN COATED (RC) PAPER
Note > Procedures 1-4 must be carried out in ‘safelight’ conditions only.

1. Place the exposed paper into a tray of developer at room temperature (approximately  
 20˚C) and submerge it using a pair of print tongs.
2. Rock the tray gently for 1 minute.  Do not ‘snatch’ the paper from the developer if you  
 think it is going too dark.  This will only lead to a poor quality print. 
3. Use print tongs to transfer the paper to the tray containing stop bath (allow a few seconds  
 for the surplus developer to drip back into the developer tray).  The tongs from the   
 developer tray must not touch the stop bath.  If they do, wash them before using again.
4. Transfer the paper to the fix after 10 seconds. Fix for 2 minutes rocking the tray gently. 
5 Wash the print in running water for 2 minutes.  Avoid adding prints to the wash from  
 the fix during this process. Test strips may be examined in daylight conditions after   
 only 15 seconds in the fix and 5 seconds in the wash if they are to be thrown away.
6. Squeegee the water off both surfaces of the print applying light pressure only.
7. Dry the prints face-up on a dry work surface.  Prints must not overlap during drying as  
 they will stick together. Drying prints with excessive heat will cause the prints to curl.

CLEANLINESS
Dirty marks, hairs or white spots appear due to chemical contamination or dirty 
negatives. Make sure your hands and work-bench are clean and dry.  
Use a blower brush to clean negatives.  
HANDLE NEGATIVES WITH EXTREME CARE.
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TEST STRIPS
Test strips are used to measure the brightness of the light coming from the enlarger lens.  They are 
used for the same reason that we take a light meter reading in the camera, i.e. to find the correct 
aperture and the length of time needed for a correct exposure.  Because photographic paper 
requires more exposure than film we use a timer connected to the enlarger to measure seconds, 
instead of fractions of seconds.  It is, however, possible to count accurately or use the second 
hand of a clock to measure exposures for photographic paper.
There is the temptation to guess an exposure from the first test strip even if all the exposures 
shown on the test strip are far from correct.  If used often, test strips will save you time and 
photographic paper. 

                4s                       8s                     12s                     16s                     20s
                                         Underexposure      Overexposure                        

A good test strip will cross many areas of density and show over- and underexposure.

CONTRAST CONTROL
The term contrast refers to the different tones of grey we can see in a print.  A low contrast print is 
one that may have many shades of grey but no deep blacks or bright whites.  A high contrast print 
is one that has many areas of black and white but few, if any, shades of grey.  The contrast can 
be altered on multigrade paper by using coloured filters.
   

 

Increasing the Magenta filter on a colour enlarger will increase the contrast on multigrade paper.  
Increasing the Yellow filter will lower the contrast.  Increasing the filtration on an enlarger will 
require longer exposures to obtain a print of the same density. 
Increasing to a higher number on a multigrade head will increase the contrast.  
Decreasing the number on the multigrade head will decrease the contrast. 

Note > The higher the number of the filter, the higher the contrast. 

Low contrast High contrast
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MAKING A PROOF SHEET

PREPARING YOUR NEGATIVES
1. Cut your negatives into strips of five or six frames on a clean dry surface.
 Do not handle the image area of the negatives with your fingers.
2. Slide the negative strips into the negative file shiny side up (emulsion side down).  
 Store your negatives away from wet or damp work surfaces.
3. Choose an enlarger and switch off any white lights.
4. Switch on the enlarger and adjust the lens aperture so that the light is at its brightest.   
 Close the aperture by 2 stops. 
5. Adjust the enlarger head height until the spread of light covers the negative bag or 
 contact printing frame.  Switch off the enlarger.

MAKING A TEST STRIP
6. In ‘safelight’ only, cut a 2cm strip off a sheet of photographic paper using a pair of 
 scissors or a guillotine.  Return the rest of the paper to the bag and seal it.
7. Place the strip of photographic paper, emulsion side up, on the baseboard (on your 
 pearl or gloss paper the emulsion side will reflect the red darkroom lights).
8. Place a strip of negatives of average exposures on top of the strip of paper.  If you have  
 a clear negative file you do not need to remove them. 
9. Cover the photographic paper and the negative with the clean sheet of glass and ensure  
 that both are in close contact.  Press down if necessary.
10. Cover up 3/4 of the test strip with a piece of card.
11. Set the enlarger timer to 4 seconds and expose the first 1/4 of the strip.
12. Uncover one further 1/4 and expose for a further 4 seconds.  Repeat process until all the  
 paper has been exposed.
13. Process the test strip in trays of developer, stop and fix.
14. Examine the test strip in daylight conditions.  Choose the best exposure from the 
 test strip and set the enlarger timer accordingly.  If all the exposures are too light 
 then increase the exposure times for a second test strip.  If all the exposures are too 
 dark close the lens aperture down 1 more stop.
15. Expose all of the negative strips onto one sheet of printing paper and process.

 REMEMBER: THE BRIGHTER THE LIGHT, THE DARKER THE PRINT.

COMMON FAULTS
1. Faint and fuzzy image ........ Photographic paper upside down. 
2. Test strip too dark ...............  Enlarger lens not stopped down.
3. Test strip too light ..............  Enlarger lens stopped down too much.
4. Out of focus images ............  Glass not in close contact.
5. Marks or splodges ..............  Glass not clean or chemical contamination. 
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MAKING A PROOF SHEET

Cut negatives. Be careful not 
to drag negatives along the 
work surface.

Place a clean sheet of glass over 
the negative and photographic 
paper.

Mask off a portion of the test 
strip using a piece of thick card 
to control exposure.

Slide negatives into the file sheet. 
Handle negatives carefully by the 
edges only.

Stop lens down 2 stops.  This 
will ensure that the exposure 
time is of a reasonable length.

Place the negative onto the 
test strip, emulsion side down, 
shiny side up.

Place the test strip, emulsion 
side up, on the baseboard of 
the enlarger.

The spread of light from the 
enlarger lens must cover the 
baseboard.

Process the photographic paper.
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PRINTING
1. Select a negative to print from the contact sheet.
2. Remove the negative carrier from the enlarger. Ensure that it is switched off.
3. Place the negative in the carrier, emulsion side down, glossy side up.
4. Blow any dust off the negative using a blower brush.
5. Replace the negative carrier in the enlarger.
6. Place printing easel on the enlarger baseboard and switch on the enlarger.
7. Ensure the aperture is at its largest f-stop to supply maximum light for focusing.
8. Raise or lower the enlarger head to obtain the desired degree of image enlargement.
9. Focus the image (use focusing aid for precise focusing).
10. Compose and frame the picture.
11. Reduce the aperture of the enlarger lens by 2 or 3 f-stops.
12.    Turn the enlarger off and place a test strip on the easel, emulsion side up.
13. Expose the test strip at 4 second intervals. 
14. Process test strip.  
15. Select the best exposure in daylight.

If the exposure time is less than 7 seconds, close the lens down 1 more f-stop.  If it is greater than 
30 seconds open up the lens 1 f-stop.
EACH F-STOP WILL DOUBLE OR HALVE THE EXPOSURE TIME.

BURNING-IN
When a section of the print appears too light it is possible to increase the exposure to this area 
without affecting the rest of the print.  This is called ‘burning-in’.
To burn in use a large piece of card with a hole cut in it.  The shape of the hole can vary 
depending upon the area to be burnt in, but it should be much smaller than the area needing 
the extra exposure.  Using test strips, find out the additional exposure needed for the area to be 
burnt in.  Expose the entire paper for the shorter exposure and then place the card with the hole 
approximately midway between the lens and the paper for the additional exposure.  The light 
falling through the hole should be directed onto the area needing the additional exposure and the 
card should be kept moving during this exposure so that no hard edge between the original and 
extra exposure appears on the final print.

HOLDING BACK OR DODGING
When a small area of the print appears too dark it is possible to reduce the exposure to this area 
only.  This is called ‘dodging’.  The selected area is shaded for part of the exposure by placing 
a small piece of card taped to a piece of wire held between the enlarger lens and photographic 
paper.  The amount of time the area needs to be shaded can be determined using a test strip, and 
as in the burning-in process the card should be placed midway between the enlarger lens and the 
photographic paper and kept moving.
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PRINTING

Expose the test strip from a 
section of the projected image 
which has a variety of densities.

Focus the image by eye with 
the enlarger lens set to its 
maximum aperture.

Remove any dust from the 
negative using a blower brush 
or soft cloth.

Adjust the height of the enlarger 
head to create an image of the 
right size on your printing easel.

Place the negative into the 
carrier, shiny side up, emulsion 
side down.

Use a focus finder to ensure 
accurate focusing. 

Reduce the aperture by 2 stops 
to ensure a reasonable length 
of exposure and sharp focus.

Process the test strip.  Ensure 
that the test strip is processed 
for the full processing time.

View the test strip to gauge the 
correct exposure and contrast 
before making the final print.
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QUALITY CONTROL OF NEGATIVES
High quality photographic prints are made from high quality negatives. If the negatives have not 
been exposed or processed correctly it is difficult to obtain high quality prints. Negatives should 
be examined carefully after processing each film to ensure that quality has been achieved or 
maintained. Negatives should be examined using a ‘light box’.

EXPOSURE
Correct exposure is determined by looking to see how the shadows and dark tones of the subject 
have recorded onto the film (these are the lighter/clearer areas of the negatives). If these areas 
are clear with no visible detail then the negatives are underexposed. This underexposure may be 
caused by either:

     ~ Failing to compensate for high contrast subjects or large areas of bright light in the  
 framed image (such as the sky or a window). 
 Improve compensation techniques (see ‘Light - Exposure compensation’).

     ~ The use of an inaccurate light meter. 
 Alter the ISO (film speed) to correct an inaccurate light meter
 Example 1: Rate a 400ISO film at 200ISO to increase the exposure by 1 stop.
 Example 2: Rate a 400ISO film at 800ISO to decrease the exposure by 1 stop.

PROCESSING
Correct exposure is determined by looking to see how the light tones of the subject have recorded 
(the darker areas of the negative). The film information (film name and frame numbers) can also be 
examined. If these tones are pale and the contrast of the negatives is low then under-processing 
is likely.
If the light tones of the subject are very dark and film edge information appears bloated and woolly 
then over-processing is likely.
Reduce or increase processing time or temperature to change processing problems.

Correctly exposed negative Underexposed negative (no detail in shadows)



aims
    ~ To offer an independent resource of digital imaging theory.
    ~ To develop an understanding of the theory behind digital image structure.
    ~  To develop knowledge and understanding about the technical processes and   
 procedures involved with producing a digital print.

objectives
    ~ Display an understanding of digital imaging theory including:
  - image mode
  - file format and size
  - resolution

Mark Galer

digital basics
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INTRODUCTION
The term ‘digital photography’ is used to describe images that have been captured by digital 
cameras or existing photographs that have been scanned to create digital image data.  The term 
also describes the processing of digital image data on computers and the output of ‘hard copies’ 
or digital prints (on paper or plastic) from this data.  
Digital photography is now revolutionising not only the process of photography but also the way we 
view photography as a visual communications medium.  This new photographic medium affords 
the individual greater scope for creative expression, image enhancement and manipulation.

DIGITAL FOUNDATIONS  
This guide is intended only to lay the foundations of practical digital knowledge.  The individual may 
find it beneficial to supplement this information with additional guides specific to the equipment and 
computer programs being used.  The information supplied by these additional guides, although 
valuable, may quickly become redundant as new equipment and computer programs are released 
frequently in this period of digital evolution.

PIXELS AND LEVELS
A digital image is one in which the image is constructed from ‘pixels’ (picture elements) instead of 
silver halide grains.  Pixels are square and positioned in rows horizontally and vertically to form a 
grid.  Each pixel in the grid is the same size and is uniform in colour and brightness, i.e. the tone 
does not vary from one side of the pixel to the other. 
In the illustration above 10 pixels, each with a different tone, are used to describe the ‘continuous 
tone’ above it.  Each different tone is called a ‘level’ and assigned a numerical value, e.g. 0 to 9.
In a typical digital image there are 256 different levels or separate tones to create a smooth 
transition from dark to light.  If the pixels are sufficiently small when printed out the viewer of the 
image cannot see the steps in tone thereby giving the illusion of continuous tone.

Ten pixels each with a different tone or level used to describe the above

The continuous tone of a subject (no steps in brightness)
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FILE SIZE
Digital images are usually created using a large amount of information or data.  This data is required 
to record the subtle variations in colour and/or tone of the original image or subject.  The simple 
binary language of computers and the visual complexities of a photographic image lead to large ‘file 
sizes’.  This data can require large amounts of computer memory to display, print or store the image.  
The text file for this book can comfortably fit onto a floppy disk whereas only a small portion of the 
cover image may be stored on a similar floppy disk.

BITS, BYTES, KILOBYTES AND MEGABYTES
The binary digit or ‘bit’ is the basis of the computer’s language.  One bit is capable of two 
instructions and can describe a pixel in two tones (0 or 1, black or white).  Two bits can give four 
instructions (00, 11, 01 and 10).  8 bits (sometimes called a ‘byte’) can record 256 possible values 
(2x2x2x2x2x2x2x2) whilst 24 bits can record 16.7 million possible values for each pixel (commonly 
used to record the data in digital colour images). 
There are 1024 bytes in a ‘kilobyte’ (KB) and 1024 kilobytes is a ‘megabyte’ (MB).  The ‘digital 
file’ of the image that is used on the cover of a glossy magazine is likely to exceed 20MB.  That is 
a lot of information to produce one colour image in print.  Fortunately files can be ‘compressed’ 
(reduced in memory size) for storage and it is possible to fit a large image file onto a floppy disk.  
Storing large files on floppy disks, although possible, is not practical.  Removable hard drives (such 
as the inexpensive ‘Zip’ drive made by Iomega™) are commonly used for storing and transferring 
large image files conveniently and quickly.

ACTIVITY 1
Find one digital image file and identify its file size when the image is closed. Open the same 
digital image using image editing software and identify its file size when open (go to the 
‘document sizes’ underneath the image window or choose ‘Image Size’ from the ‘Image’ menu).  
It is common for the file size to be larger when the image is open.  If this is the case with the 
image you have opened, image compression is taking place prior to the file being closed.

 UNITS OF MEMORY
 8 bits    =  1 byte
 1024 bytes   =  1 kilobyte
 1024 kilobytes   =  1 megabyte
 1024 megabytes =  1 gigabyte

 STORAGE CAPACITY OF DISKS
 Floppy disk   =  1.4 megabytes
 Zip disk   =  100 or 250 megabytes
 CD    =  600-700 megabytes
 Jaz drive   =  1 gigabyte
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MODES AND CHANNELS
The colour and tonal information of pixels within a digital image can be described using a number 
of different ‘modes’, e.g. a black and white image can be captured in ‘bitmap’ mode or ‘grayscale’ 
mode.  In a bitmap image each pixel within the grid is either black or white (no shades of grey).  
This mode is suitable for scanning line drawings or text.  For images that need to be rendered as 
continuous tone the grayscale mode is used.

GRAYSCALE
Black and white (continuous tone) photographs are captured or scanned in what is called ‘grayscale’.  
Each pixel of a grayscale image is assigned one of 256 tones or levels from black to white.  These 
256 levels allow a smooth gradation between light and shade simulating the continuous tone that 
is achieved with conventional silver-based photography.  A grayscale image is sometimes referred 
to as an ‘8-bit image’ (see ‘Bit depth’).

RGB
A ‘full colour’ image can be assembled from the three primary colours of light; red, green and blue 
or ‘RGB’.  All the colours of the visible spectrum can be created by varying the relative amounts 
of red, green and blue light.  The information for each of the three primary colours in the RGB 
image is separated into ‘channels’.  Each channel in an RGB image is usually divided into 256 
levels.  An RGB colour image with 256 levels per channel has the ability to assign any one of 16.7 
million different colours to a single pixel (256 x 256 x 256).  Colour images are usually captured 
or scanned in the RGB ‘colour mode’ and these colours are the same colours used to view the 
images on a computer monitor.  A colour pixel can be described by the levels of red, green and 
blue, e.g. a red pixel may have values of Red 255, Green 0 and Blue 0;  a yellow pixel may have 
values of Red 255, Green 255 and Blue 0 (mixing red and green light creates yellow);  and a grey 
pixel may have values of Red 127, Green 127 and Blue 127.

Note >  ‘CMYK’ is the colour mode used in the printing industry and uses the colours 
Cyan, Magenta, Yellow and blacK.  RGB images should only be converted to CMYK after 
acquiring specifications from your print service provider.

 

  Red:  255 0 0
 Green:  0 255 0
 Blue:  0 0 255
 Cyan:  0 255 255
 Magenta:  255 0 255
 Yellow:  255 255 0
 Black:  0 0 0
 White:  255 255 255
 Mid grey  127 127 127C

o
lo

u
r

 RGB Channels R G B
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BIT DEPTH
Each pixel of an 8-bit image is described in one of a possible 256 tones or colours.  Each pixel of 
a 24-bit image is described in one of a possible 16.7 million tones or colours.  The higher the ‘bit 
depth’ of the image the greater the colour or tonal quality.  An 8-bit image (8 bits of data per pixel) 
is usually sufficient to produce a good quality black and white image, reproducing most of its tonal 
variations, whilst a 24-bit image (8 bits x 3 channels) is usually required to produce a good quality 
colour print from a three channel RGB digital file.  Images with a higher bit depth require more data 
or memory to be stored in the image file.  Grayscale images are a third of the size of RGB images 
(same pixel dimensions and print size, but a third of the information or data).  

16 BITS PER CHANNEL
Most scanners now in use scan with a bit depth of 48 bits.  Although they are capable of discerning 
between more than 16.7 million colours (therefore increasing the colour fidelity of the file) they 
usually only pass on 24 bits of the data collected to the editing software.
Higher quality scanners are able to export 16 bits per channel (48-bit file) to image editing software 
such as Photoshop. In Photoshop it is possible to edit an image using 16 bits per channel instead 
of 8.  Image corrections are usually restricted to colour and tonal adjustments.  The file size of the 
digital image is doubled and the range of editing features is limited.  Image editing in this mode is 
often used by professionals for high quality retouching.

Grayscale image, 256 levels per channel (8 bit) 2 levels (1 bit)
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HUE, SATURATION AND BRIGHTNESS
It is essential when describing and analysing colour in the digital domain to use the appropriate 
terminology.  The terminology most frequently used belongs to that of human perception.  Every 
colour can be described by its hue, saturation and brightness (HSB).  These terms are used to 
describe the three fundamental characteristics of colour.   

Hue - is the name of the colour, e.g. red, orange or blue.  All colours can be  assigned 
a location and a number (a degree between 0 and 360) on the standard colour 
wheel.

Saturation - is the purity or strength of a colour, e.g. if red is mixed with grey it is still 
red, but less saturated.  All colours and tones can be assigned a saturation value 
from 0% saturated (grey) to 100% saturated (fully saturated).  Saturation increases 
as the colour moves from the centre to the edge on the standard colour wheel.

Brightness - is the relative lightness or darkness of the colour.  All colours and tones 
can be assigned a brightness value between 0% (black) to 100% (white).

CREATING AND SAMPLING COLOUR
Different colours can be created by mixing the ‘primary colours’ (red, green, and blue) in varying 
proportions and intensity. When two primary colours are mixed they create a ‘secondary colour’ 
(cyan, magenta or yellow). The primary (RGB) and secondary (CMY) colours are complementary 
colours.  Two primary colours combined create a secondary colour and two secondary colours 
combined create a primary.  
Colour in a digital image can be sampled by selecting the eyedropper tool in the tools palette.  
Move the tool over the colour to be sampled and click the mouse.  The colour will appear in the 
foreground swatch in the tools palette and the foreground swatch in the colour palette.  Clicking 
on the foreground swatch in the tools palette will bring up the full colour information in the ‘color 
picker’.

The ‘foreground swatch’ and ‘color picker’
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ACTIVITY 2
1. Open a colour digital image file in Photoshop or Elements.  

2. Double-click the hand tool in the tools palette to resize the image to fit the 
monitor.

3. Click on the ‘zoom tool’ in the tools palette to select the tool (double clicking the 
zoom tool in the tools palette will set the image at 100% magnification). 

4. Click on an area within the image window containing 
detail that you wish to magnify. 
Keep clicking to increase the magnification (note the 
current magnification both in the title bar of the image 
window and in the bottom left hand corner of the image 
window.  

At a magnification of 400% you should be able to 
see the pixel structure of the image.  Increase the 
magnification to 1200% (to decrease the magnification 
you should click the image with the zoom tool whilst 
holding down the Option/Alt key on the keyboard).

5. Click on the hand in the tools palette and then drag inside the image window to 
move the image to an area of interest (pixel variety).

6. Click on the eyedropper in the tools palette to access the information about a 
single pixel.

7. Click on different coloured pixels within your magnified image.

8. View the colour information in the colour palette (note 
how the colour of the selected pixel is also displayed in 
the foreground swatch in the tools palette).

9. The colour information is displayed as numerical 
values in the red, green and blue channels.  These 
values can be altered either by moving the sliders 
underneath the ramps or by typing a new value into 
the box beside the ramp. Drag the sliders or type in 
different numbers to create your own colours.
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FILE FORMATS
When an image is captured by a camera or scanning device it has to be ‘saved’ or memorised 
in a ‘file format’.  If the binary information is seen as the communication, the file format can be 
likened to the language or vehicle for this communication.  The information can only be read and 
understood if the software recognises the format.  Images can be stored in numerous different 
formats.  The three dominant formats in most common usage are:

     ~ JPEG (.jpg) - Joint Photographic Experts Group
     ~ TIFF (.tif) - Tagged Image File Format
     ~ Photoshop (.psd) - Photoshop Document

JPEG - Industry standard for compressing continuous tone photographic images destined for the 
world wide web (www) or for storage when space is limited.  JPEG compression uses a ‘lossy 
compression’ (image data and quality is sacrificed for smaller file sizes when the image files are 
closed).  The user is able to control the amount of compression.  A high level of compression leads 
to a lower quality image and a smaller file size.  A low level of compression results in a higher 
quality image but a larger file size.  It is recommended that you only use the JPEG file format after 
you have completed your image editing.

TIFF - Industry standard for images destined for publishing (magazines and books etc.).  Tiff uses 
a ‘lossless’ compression (no loss of image data or quality) called ‘LZW compression’.  Although 
preserving the quality of the image, LZW compression is only capable of compressing images a 
small amount.

Photoshop - A default format used by the most popular image processing software.  An image 
that is composed of ‘layers’ may be saved as a Photoshop document.  A Photoshop document 
is usually kept as the master file from which all other files are produced depending on the 
requirements of the output device.

A close-up detail of an image file that has been 
compressed using maximum image quality in the JPEG 
options box.

A close-up detail of an image file that has been 
compressed using low image quality in the JPEG options 
box.  Notice the artifacts that appear as blocks.
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RESOLUTION
Digital images are constructed from square picture elements or ‘pixels’.  Increasing the total 
number of pixels in an image at the scanning or capture stage increases both the quality of the 
image and its file size.  It is ‘resolution’ that determines how large or small the pixels appear in the 
final printed image.  The greater the resolution the smaller the pixels and the greater the apparent 
sharpness of the image.  Resolution is stated in ‘pixels per inch’ or ‘ppi’.

Note >  With the USA dominating digital photography, measurements in inches rather than 
centimetres are commonly used.  1 inch equals exactly 2.54 centimetres.

EXAMPLE
A 2 inch x 1.5 inch image is scanned three times to create three digital image files with different 
resolutions. The digital image with a resolution of 10 ppi has a total of 300 pixels (20 x 15 = 300).  
If the digital file is reproduced the ‘same size’ as the original, each pixel will measure 1/10 of an 
inch. The digital images with higher resolutions of 20 ppi and 40 ppi have an increased number of 
pixels.  Increasing the scanning resolution has increased the amount of information  sampled from 
the original image and therefore the quality. This increase in quality is limited by either the quality 
of the original image or the ability of the output device to reproduce the information contained by 
the digital file.  If the image resolution exceeds that required by the printer to produce optimum 
quality the extra resolution is wasted (see ‘Output resolution’).

It is essential to understand resolution in order to understand quality.  Quality is defined by the 
resolution at the scanning stage (obtaining the optimum number of pixels) and the printing stage 
(reproducing the pixels at the optimum size for the print output device).

IMAGE SIZE
A digital image can be quantified in the following ways:

     ~ Pixel dimensions and file size (e.g. 800 x  600) 
     ~ Output resolution (e.g. 200 ppi or pixels per inch)
     ~ Output dimensions (e.g. 6 x 4 inches) 
     ~ Colour or bit depth (e.g. 24 bit)

10 pixels per inch 20 pixels per inch 40 pixels per inch
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PIXEL DIMENSIONS
At the scanning or capture stage of the process the digital image is allocated a number of pixels 
or picture elements that describe the image or subject, e.g. if your scanner is set to scan at 
100 ppi and the image that you are scanning is 4 x 6 inches in size the resulting file will measure 
400 x 600 pixels.  These pixels are arranged in a grid.  The width and height of the grid can be 
measured by the number of pixels allocated to the row.  This width and height give the image its 
pixel dimensions (e.g. 400 x 600).  An image with fixed pixel dimensions can be displayed in a 
variety of different physical sizes from a very small print to a very big poster.  A pixel has no fixed 
size.  Pixel size is dependent on output size i.e. pixels grow or shrink in size when you increase 
or decrease the output size from the same file size, e.g. the pixels of an image printed at 100 ppi 
are twice as large as an image printed at 200 ppi.  As the output resolution decreases the pixels 
increase in size.  

 The pixel size is determined by the output resolution used to create the print.  

When the resolution is sufficiently low the pixels become visible and the print is said to be 
pixellated.  If the resolution is 1 ppi each pixel will measure 1 inch square.  Increasing output 
resolution renders the pixels smaller until finally they are invisible to the human eye.  Increasing 
the resolution beyond the capability of the printer increases the file size and pixel dimensions 
but not the quality of the print (see ‘Output resolution’).

CHANGING PRINT SIZE FROM THE SAME FILE
Resolution drops as the print size is increased (the pixels are spread further).  
Example: A 4 x 5 inch print is scanned at 60 ppi.  If this digital image file is enlarged to 8 x 10 
inches the resolution will drop to 30 ppi.  Both the original size image and the enlargement contain 
the same number of pixels but the quality of the larger image appears to be lower.

Note >  A resolution of at least 150 ppi is required to prevent pixellation when viewing 
images in print.

104 pixels wide at 60 ppi

104 pixels wide at 30 ppi
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OUTPUT RESOLUTION
Although output is the last step in the digital process it has to be considered first before you capture 
or scan your image.  When scanning or capturing an image it is essential to know how large and 
on what device you intend to print the image.  This information is essential to ensure the maximum 
possible quality of your final image whilst keeping the file size as small as possible.
If the resolution is too high the handling of the file will be slow.  If the resolution or file size is too small 
the quality of the final image will be low.  If the resolution of the file is very low the individual pixels 
of the image will be visible and the image will be said to be ‘pixellated’.
If the intended print is very large, e.g. larger than A2, the resolution may be lowered without an 
apparent drop in sharpness.  Large prints are usually viewed from further away and therefore 
require a lower output resolution.  The important questions prior to scanning are:

     ~ What is the final use for the digital image file?  
Scanning resolution depends on what the digital image will be used for, e.g. prints produced 
from digital files require a much higher scanning resolution than an image file required for 
display on the world wide web.  Digital images produced from high quality printers require a 
higher scanning resolution than images produced from low quality printers.

     ~ What is the optimum image resolution required by the printer you are using? 
Make some test prints.  The optimum image resolution is the point at which any increase in 
image resolution does not result in improved quality.

DOTS PER INCH
Printers place or transfer ink onto the paper in dots not squares.  Higher quality printers put more 
dots of ink down per inch of paper.  Printing devices therefore define the quality or ‘output device 
resolution’ in ‘dots per inch’ (dpi) not pixels per inch.  The resolution of the image (measured in 
pixels per inch) is usually much smaller than the output device resolution used to print the image, 
i.e.  each pixel is defined by more than one dot of ink.
Although there is a relationship between dpi and ppi they should not be confused during the 
print output stage, e.g. a 720 dpi inkjet printer needs an image with a maximum resolution of 
only 240 ppi (an RGB A4 digital file with a resolution of 720 ppi would exceed 143 MB).

INTERPOLATION
If a digital image is captured with a fixed number of pixels the image is limited in both size and/or 
quality.  It is possible with software to increase the number of pixels thus allowing an increase in 
size or resolution.  Increasing the total number of pixels requires ‘interpolation’.  New pixels are 
created from information obtained from the existing pixels.  These new pixels are inserted between 
the existing pixels.  These fabricated pixels cause a loss in overall quality.  If an image has to be 
scaled to fit a certain format or the specifications of a printer you should aim to scale down (reduce 
the number of pixels) rather than up.

Note >  Avoid increasing the total number of pixels in a digital image whenever possible.
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FROM ORIGINAL TO DIGITAL PRINT (AN EXAMPLE)

PRINT - SCANNED AT 400 PPI

35 mm film

35 MM FILM - SCANNED AT 1800 PPI

DIGITAL FILE
Pixel dimensions: 1600 x 2400
RGB file size: 11 Megabytes
Grayscale file size: 3.67 Megabytes

ADJUSTMENT IN SOFTWARE
Change resolution to 220 ppi 
Change print size to 7 x 10.5 inches

Note >  Retain pixel dimensions.

OUTPUT
Image printed on A4 paper* at 720 dpi 
(image resolution 220 ppi).
*Coated paper recommended.

Full-page image 

4x6 inch print
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CALCULATING IMAGE RESOLUTION FOR OUTPUT
The image resolution required to create a hard copy is dependent on the output device being 
used, the size of the enlargement and the quality required by the individual.
A commonly used method for calculating the optimum image resolution that can be utilised by 
an inkjet or laser printer is to divide the output device resolution (ODR) by a factor of three, e.g. 
720 dpi divided by 3 = 240 ppi.  If the resulting file size is unmanageable by your computer it is 
possible to increase this to a factor of four.  The quality will still look reasonably good but will lower 
the working file size significantly.
If you are intending to send image files out for commercial printing consult the printer prior to 
creating the initial digital image file.  It is very important to avoid having to increase the file size to 
accommodate a higher resolution required by the printer (see ‘Interpolation’).  
If an image setter is being used the printer may give you the screen frequency in lines per inch.  If 
this is provided you should multiply this figure by a factor of 2, e.g. 133 lpi multiplied by 2 = 266 ppi.

 Image resolution requirements of print output devices

 Inkjet and laser: Divide the output resolution by a factor of 3.
 Dye sublimation: Image resolution is the same as quoted output resolution.
 Image setter: Multiply the screen frequency by a factor of 2.

OUTPUT FILE FORMATS
When printing to inkjet and laser printers directly from the image processing software it is 
permissible to use any of the file formats supported by the software, e.g. Photoshop, TIFF, JPEG 
etc.  If the file is to be imported by word processing or desktop publishing (DTP) software the file will 
usually have to be saved as either a TIFF or JPEG.  If the image file is to be printed commercially 
the standard file format is TIFF (without layers).  Ensure that both the DTP file and all image files 
used in that file are kept together in one folder that can be easily found by the printer.
If an image is to be sent as an attachment to an email the file should be saved as a JPEG with 
no spaces in the file name and end with the file extension ‘.jpg’.  The file should be saved without 
icons and previews to minimise the file size.  Go to File > Preferences > Saving Files and select 
Ask when saving.  If speed of transfer is required a high level of compression (low image quality) 
should be considered.  Large file sizes may transfer very slowly via a modem.  If the image file is 
going to be used as part of a web page the JPEG format should again be used.  A high level of 
compression is required to minimise the time it takes to ‘download’ the web page containing the 
image.
A file format that is being used increasingly for transferring DTP files to printers is the ‘Portable 
Document Format’ or ‘PDF’.  These can be created and viewed by the Adobe software 
‘Acrobat’.
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SCANNING RESOLUTION
Scanning resolution is rarely the same as the resolution you require to print out your image.  If you 
are going to create a print larger than the original you are scanning, the scanning resolution will 
be greater than the output resolution, e.g. a 35mm negative will have to be scanned in excess 
of 1200 ppi if a 150 ppi A4 colour print is required (see ‘Resolution’).  If the print you require is 
smaller than the original the scanning resolution will be smaller than the output resolution.

The smaller the original the higher the scanning resolution.

In determining the file size and resolution required when scanning a negative, transparency or 
print you need to know the following:

Size and ‘mode’ of the final image you require, e.g. A4 RGB, A3 Grayscale, etc.
Optimum image resolution required by the printer (proportional to, but not the same as, the 
dpi of the printer), e.g. 240 ppi is usually the optimum resolution for a 720 dpi inkjet printer 
(see ‘Calculating image resolution for output’).

If you know the image size, mode and resolution required to make your final print you can then do 
either of the following:

Create a ‘dummy file’ in your image processing software.  Go to ‘File > New...’.  Type in 
the specifications (size, mode and resolution).  This will give you a file size you can aim 
for when scanning.  The dummy file is then discarded.  Simply increase the scanning 
resolution to obtain the appropriate file size.

Multiply the proportional change in size (original to required output size) by the resolution 
required by the printer, e.g. if an output size of 8 x 10 is required from a 4 x 5 original the 
dimensions have doubled (x2).  If the printer requires a resolution of 150 ppi the original 
should be scanned at 300 dpi (2 x 150 = 300).

Note > Always scan with a slightly higher resolution or larger file size if you are unsure.

Fi
le

 S
iz

e

Optimum resolution required by output device
Size &
Mode   72 ppi          150 ppi       200 ppi 300 ppi
                     low quality medium quality           high quality

A3 RGB 2.86M 12.44M  22.20M  49.80M
A3 Grayscale 1.98M 4.14M  7.40M  16.60M

A4 RGB  1.43M 6.22M  11.10M  24.90M 
A4 Grayscale 0.49M 2.07M    3.70M  8.30M

A5 RGB                            733K 3.11M  5.52M  12.50M
A5 Grayscale                   245K 1.04M  1.84M    4.14M

     ~ 
     ~ 

     ~

     ~



aims
     ~ To offer an independent resource of digital imaging practice.  

     ~ To offer a practical overview of the digital imaging process from capture to output.

objectives
     ~ Capture a digital image suitable for producing a high quality inkjet print.       
~ Optimise the colour, tone and sharpness of the digital file and remove any dust and  
 scratches present as a result of scanning.
     ~ Duplicate the image file and reduce the pixel dimensions so that the file is suitable  
 for uploading to the Internet or attaching to an email.
     ~ Create a colour matched print using an inkjet printer.

 

                                       

Mark Galer

digital darkroom
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INTRODUCTION
This study guide will take you through the complete digital process from capture to output. It is intended 
as an introduction to provide the user with an overview for creating successful digital images. 

STAGE A - CAPTURE AND EDIT
STEP 1 – CHOOSING AN IMAGE
Select or create a softly lit colour portrait image (diffused sunlight or window lighting would be 
ideal). The image selected should have detail in both the highlights and shadows and should have 
a range of colours and tones. An image with high contrast and missing detail in the highlights or 
shadows is not suitable for testing the effectiveness of the capture or output device.

STEP 2 – ADJUSTING THE COLOUR SETTINGS
Set the working space to ‘Full color management’ or ‘Adobe RGB (1998)’ in the ‘Color Settings’ of 
your Adobe software.

Profile Warnings: When you encounter a profile alert using Photoshop, select 
‘Convert document’s colors to the working space’ or ‘Assign working RGB’ and then 
click ‘OK’. 

Choose an image with a full detail in the shadows and highlights
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STEP 3 – IMPORTING THE IMAGE
Import the image into the computer using either of the following two options.

Digital Camera
Images for this activity can be transferred directly 
to the computer from a digital camera. The image 
size should not be smaller than 2.75M and if 
using the JPEG file format to capture images you 
should choose the high or maximum quality setting 
whenever possible.

Scanning Device
Ensure the media to be scanned is free from dust 
and grease marks. Gloss photographic paper offers 
the best surface for flatbed scanning. A 6-inch x 4-
inch print would be suitable for this activity. The 
scanning device can usually be accessed directly 
through the Adobe software. This is achieved by 
going to ‘File > Import’ and selecting the scanning 
software from the submenu.

Set the scanning specifications and check the file size
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SCANNING SPECIFICATIONS
If you are using a scanner to convert your image to a digital file use the following options:

• Select the correct setting for scanning film or print.
• Select ‘Preview’ to view the image you are about to scan.
• Select the scanning area by dragging a rectangular marquee around your image area.
• Deselect any Unsharp Mask/Sharpen options.
• Select a scanning resolution of 200dpi to create a digital image with a file size of   
 approximately 2.75M for 24 Bit scanning (check the file size in the scanning software after  
 you have selected the scanning area and before scanning). Always scan with a little extra  
 memory/pixels rather than a little less.
• Select ‘Scan’ and wait for the image to open in the image editing software.

Note > Increase the scanning resolution to 300dpi for print enlargements up to 6 x 8 inches 
and 400dpi for full A4 sized prints.  

STEP 4 – ADJUSTING THE TONALITY AND COLOUR
When the image is opened in the editing software for the first time it is important to check how the 
capture device has handled or interpreted the tonality and colour of the subject or original image. 
Press the ‘Control’ key (PC) or ‘Command’ Key (Mac) and the letter ‘L’ on your keyboard to open 
the ‘Levels’ dialog box. The ‘histogram’ displayed in the levels dialog box shows the brightness 
range of your image.  The sliders beneath the histogram can be used to modify the shadow, mid-
tone (gamma) and highlight tones or levels. 

Note > You should attempt to modify the brightness, contrast and colour balance at the 

capture stage to obtain the best possible histogram before editing begins in the software. 

A B C
Shadow 
adjustment

Highlight 
adjustment

Mid-tone
 adjustment

AB
C
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ADJUSTING THE LEVELS TO CONTROL TONALITY
A good histogram (a broad tonal range with full detail in the shadows and highlights) will extend all 
the way from the slider on the left to the slider on the right. The histogram below indicates missing 
information in the highlights (on the right) and a small amount of ‘clipping’ or loss of information in 
the shadows (on the left).

Histograms indicating Image is either too light or too dark

BRIGHTNESS
If the digital file is too light a tall peak will be seen to rise on the right side (level 255) of the 
histogram. If the digital file is too dark a tall peak will be seen to rise on the left side (level 0) of the 
histogram. 

Solution: Decrease or increase the exposure/brightness in the capture device.

CONTRAST
If the contrast is too low the histogram will not extend to meet the sliders at either end.
If the contrast is too high a tall peak will be evident at both extremes of the histogram.

Solution: Increase or decrease the contrast of the light source used to light the subject or the 
contrast setting of the scanning device. Using diffused lighting rather than direct sunlight or using 
fill-flash and/or reflectors will ensure that you start with an image with full detail.

Histograms indicating Image either has too much contrast or not enough
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CORRECTING A WEAK HISTOGRAM
The final histogram should show that pixels have been allocated to most if not all of the 256 levels. 
If the histogram indicates large gaps between the ends of the histogram and the sliders (indicating 
a low contrast scan) the subject or original image should be recaptured a second time. 

Small gaps can however be corrected by dragging the sliders to the start of the tonal information. 
Note how the sliders have been moved beyond the short thin horizontal line at either end of the 
histogram. These low levels of pixel data are not representative of the broader areas of shadows 
and highlights within the image and can usually be clipped (moved to 0 or 255).  

Moving the ‘Gamma’ slider can modify the 
brightness of the mid-tones. If you select a 
Red, Green or Blue channel (from the channels 
pull-down menu) prior to moving the gamma 
slider you can remove a colour cast present 
in the image. For those unfamiliar with colour 
correction the command ‘Variations’ gives a 
quick and easy solution to the problem. After 
correcting the tonal range using the sliders 
click ‘OK’ in the top right-hand corner of the 
levels dialog box.

Note > Variations is not available for photoshop users working in 16 Bits/Channel mode. 

COLOUR
Neutral tones in the image should appear desaturated on the monitor. If a colour cast is present 
try to remove it at the time of capture or scanning if possible.

Solution: Control colour casts by using either the white balance on the camera (digital) or by 
using an 80A or 80B colour conversion filter when using tungsten light with daylight film. Use the 
available colour controls on the scanning device to correct the colour cast and/or saturation.

Increase the tonal range by moving the shadow and highlight sliders
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USING ‘VARIATIONS’ TO ADJUST COLOUR 
To access ‘Variations’ go to ‘Enhance > Adjust Color > Color Variations’ in Adobe Elements and 
‘Image > Adjustments > Variations’ when using Photoshop. Use the ‘Adjust Color Intensity’ or 
‘Fine/Coarse’ slider to increase or decrease the colour differences between the images presented, 
then simply click on any thumbnail that looks better than the original. 

The colour adjustments are automatically applied when you click ‘OK’.  To avoid ‘clipping’ the 
tonality of the image it is advisable to keep the ‘Midtones’ radio button checked when removing 
colour casts. Save the adjusted image with a different name to the original. This will ensure that 
you have a master image that you can return to if you later feel that you would have done things 
a little differently.

STEP 5 – CROP 
Select the crop icon in the toolbox and enter the following cropping dimensions in the options bar: 
4 in x 6 in @ 200 ppi (this will result in a file size of exactly 2.75M). Drag the cropping marquee over 
the image area and press the return/enter key to crop the image. Move the mouse cursor inside the 
cropping marquee to move the marquee or click and drag a corner handle to adjust the size. 

Note > Entering the letters ‘in’ after each measurement overrides the default unit 
measurements (which may be set to pixels or centimetres). Resolution is uniformly set to 
pixels/inch (ppi) and rarely pixels/cm.

Increase the tonal range by moving the shadow and highlight sliders
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PERFECTING THE CROP
If the image is crooked you can rotate the cropping marquee by moving the mouse cursor to a 
position just outside a corner handle of the cropping marquee. A curved arrow should appear 
allowing you to drag the image straight.

Click and drag the corner handle to extend the image window to check if there are any remaining 
border pixels that are not part of the image. Press the ‘return/enter’ key on the keyboard to complete 
the cropping action. Alternatively press the ‘esc’ key on the keyboard to cancel the crop.

Note > The marquee tool is programmed to snap to the edges of the document as if they 
were magnetised. This can make it difficult to remove a narrow border of unwanted pixels. 
To overcome this problem you will need to go to the ‘View’ menu and switch off the ‘Snap 
To’ option.
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STEP 6 – CLEAN
The primary tools for removing dust and scratches are the ‘Clone Stamp Tool’ and the ‘Healing 
Brush Tool’ (Photoshop 7 and 8 only). The clone stamp is able to paint with pixels selected or 
‘sampled’ from another part of the image. The healing brush is a sophisticated version of the clone 
stamp tool that not only paints with the sampled pixels but then ‘sucks in’ the colour and tonal 
characteristics of the pixels surrounding the damage. The following procedures should be taken to 
work with either the Healing Brush or Clone Stamp tool.

• Zoom in to get a close look at the damage that needs to be repaired.
• Choose an appropriate soft edged brush from the brushes palette that just covers the width of  
 the dust or scratch to be repaired.
• Select a sampling point by pressing the Option/Alt key and then clicking on an undamaged  
 area of the image that is similar in tone and colour to the damaged area.
• Move the mouse cursor to the area of damage.
• Click and drag the tool over the area to paint with the sampled pixels to conceal the damaged  
 area (a cross hair marks the sampling point and will move as you paint). 
• Save the image file before proceeding to the next stage.

Note > Deselect ‘Aligned’ if you want to return to the initial sampling point each time you 
start to paint. If a large area is to be repaired with the clone stamp tool it is advisable to 
take samples from a number of different points with a reduced opacity brush to prevent the 
repairs becoming obvious. 
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STEP 7 – SHARPEN
Sharpnening the image is the last step of the editing process. Many images benefit from some 
sharpening even if they were photographed and scanned with sharp focus. The ‘Unsharp Mask’ 
filter is used to sharpen the edges and corrects any blurring introduced during the digital process. 
The Unsharp mask increases sharpness by emphasising the edges where different tones meet. 

The Unsharp Mask works by increasing the contrast at the edges. The pixels along the edge on 
the lighter side are made lighter and the pixels along the edge on the darker side are made darker. 
Before you use the Unsharp Mask go to ‘View > Actual Pixels’ to adjust the screen view to 100%. 
To access the Unsharp Mask go to ‘Filter > Sharpen > Unsharp mask’.  Start with an average 
setting of 100% for ‘Amount’, a 1 pixel ‘Radius’ and a ‘Threshold’ of 3. The effects of the Unsharp 
Mask filter are more noticeable on-screen than in print. For final evaluation always check the final 
print and adjust if necessary by returning to the saved version from the previous stage. The three 
sliders control: 

Amount - this controls how much darker or lighter 
the pixels are adjusted. 80 to 180% is normal.

Radius - controls the width of the adjustment 
occurring at the edges. There is usually no need 
to exceed 1 pixel if the image is to be printed no 
larger than A4/US letter. A rule of thumb is to 
divide the image resolution by 200 to determine 
the radius amount, e.g. 200ppi ÷ 200 = 1.00.

Threshold - controls where the effect takes 
place. A zero threshold affects all pixels whereas 
a high threshold affects only edges with a high 
tonal difference. The threshold is usually kept 
very low (0 to 2) for images from digital cameras 
and medium or large format film. The threshold 
is usually set at 3 for images from 35mm. 
Threshold is increased to avoid accentuating 
noise, especially in skin tones.
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STEP 8 – SAVE, DUPLICATE, RESIZE AND SAVE AGAIN
Go to the ‘File’ menu and select ‘Save As’. Name the file, select ‘TIFF’ or ‘Photoshop’ as the file 
format and the destination ‘Where’ the file is being saved.  Check the ‘Embed Color Profile’ box 
and click ‘Save’

IMPORTANT. Always keep a backup of your work on a remote storage device if possible.

Duplicate your file by going to ‘Image 
> Duplicate Image’ command. Rename 
the file and select OK. Go to ‘Image 
> Image Size’. Check the ‘Constrain 
Proportions’ and ‘Resample Image’ 
boxes. Type in 600 pixels in the 
‘Height’ box. Anything larger may not 
fully display in the browser window of a 
monitor set to 1024 x 768 pixels without 
the viewer having to use the scroll or 
navigation bars. 

An alternative to using this image resizing approach is to use the crop tool. Typing in the 
dimensions 400 px and 600 px, dragging the crop marquee over the image and then committing 
the crop will also resize the image quickly and effectively. 

Note > The Internet browsers do not respect the resolution and document size assigned 
to the image by image editing software - image size is dictated by the resolution of the 
individual viewer’s monitor. Two images that have the same pixel dimensions but different 
resolutions will appear the same size when displayed in a web browser. A typical image 
resolution that is suitable for viewing on a monitor is often stated as being 72ppi but actual 
monitor resolutions vary enormously.

File Format

Destination

Profile
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JPEG FORMAT
Set the image size on screen to 100% (this is the size of the image as it will appear in a web 
browser on a monitor of the same resolution). Go to ‘File’ menu and select ‘Save As’. Select JPEG 
from the format menu. Label the file with a short name with no gaps or punctuation marks (use an 
underscore if you have to separate two words) and finally ensure the file carries the extension .jpg 
(e.g: portrait_one.jpg). Click ‘OK’ and select a compression/quality setting from the ‘JPEG Options’ 
dialog box. With the Preview box checked you can check to see if there is excessive or minimal 
loss of quality at different compression/quality settings in the main image window.

Choose a compression setting that will balance quality with file size (download time). Excessive 
compression leads to image artifacts, lowering the overall quality of the image. 

FILE PREPARATION OVERVIEW
1. Select an image with full detail.
2. Select appropriate ‘Color Settings’ in the image editing software.
3. Acquire the image from the capture device with sufficient pixels for quality printing.
4. Adjust the tonality and colour to ensure the histogram is optimised for quality output.
5. Remove any dust and scratches.
6. Apply the Unsharp Mask.
7. Save the image as a TIFF or Photoshop file.
8. Duplicate the file and resize for uploading to the web
9. Save the file as a JPEG with a suitable compression/quality setting.
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STAGE B – PRINTING TO AN INKJET PRINTER
Creating high quality prints when printing to a desktop inkjet printer can be a mystifying, painful 
and costly experience. If you are using an inkjet printer you can really only hope to get close to the 
quality of traditional analogue prints from a darkroom if you print on digital ‘Photo Paper’ using a 
‘6-ink’ inkjet printer (it is however possible to achieve reasonable print quality using a ‘4-ink’ inkjet 
printer and ‘Photo Quality’ or ‘High Resolution’ paper). High quality photo paper/film ensures that 
images appear sharp, with small ink dots and richly saturated colours. Ink dots from an inkjet 
printer are most noticeable in the highlights of an image. The addition of light cyan and light 
magenta inks to the normal 3-ink colour cartridge ensures smooth photographic quality highlights. 
Epson 6-ink printers retail under the ‘Epson Stylus Photo’ name, whilst Canon’s 6-ink models are 
referred to as ‘bubble-jet’ printers.

RBG TO CMYK 
Colour on a computer’s monitor is 
created by mixing red, green and 
blue light (RGB) whilst the reflected 
light from cyan, magenta, yellow 
and black inks create colour on the 
printed page. A perfect match is 
therefore very difficult, as the range 
or ‘gamut’ of colours capable of being 
reproduced by each of the two display 
mediums is similar but different. The 
colours present in a digital image file 
have to be translated or converted to 
fit the gamut or ‘colour space’ of each 
output device or printer.

PROFILES
The accuracy of colour translation has been helped in recent years by the introduction of ‘ICC 
profiles’, e.g. ‘sRGB’ and ‘Adobe RGB (1998)’. These can be tagged onto an image by capture 
devices and some image editing programmes as a way of recording how the colours in the digital 
image file actually appear to a specific capture device or when displayed on a particular type 
of monitor. In order to ensure this new level of visual consistency across all users we must first 
ensure that our monitor’s contrast, brightness and colour is within an acceptable range itself. The 
process of standardising the monitor’s display characteristics is called ‘monitor calibration’.
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CALIBRATING YOUR MONITOR
The default settings or ‘colour temperature’ of a new monitor are most likely to be too bright and 
too blue for digital printing purposes (9300). When you intend to print you will need to reset the 
‘Target White Point’ (sometimes referred to as ‘Hardware White Point’) of your monitor to D65 
or 6500, which is equivalent to daylight (the same light you will use to view your prints). 

You can reset the monitor’s white point quickly using ‘Adobe Gamma’ (from the ‘Control Panel/s’ 
in Windows and Mac OS 9) or ‘Display Calibrator’ (from the ‘Utilities’ folder in Mac OS X). The 
software will also guide the user to calibrate the contrast, brightness and ‘gamma’. If using Adobe 
Gamma to calibrate your monitor choose 6500 for both the ‘Hardware White Point’ and ‘Adjusted 
White Point’ settings. The software will invite you to save the newly calibrated monitor settings by 
giving it a profile name. It is advised that when you name this profile you include the date that you 
carried out the calibration. It is usual to check the calibration of a monitor every 6 months.

Note > When you choose 6500 as your target white point your monitor will initially appear 
dull and a little yellow compared to what you are used to seeing. 

SELECT AN APPROPRIATE COLOUR SETTING FOR THE SOFTWARE
To make optimum use of ICC image profiles select a ‘working space’ for Photoshop or Elements. 
The most suitable working space for printing is ‘Adobe RGB (1998)’. To implement this working 
space choose ‘Color Settings’ and set the workspace to ‘Adobe RGB (1998)’ (Photoshop) or ‘Full 
color management – optimised for Print’ (Elements).
Elements will now either use any existing profile to colour manage an image or save an untagged 
image (an image without a profile) with the Adobe RGB profile. When confronted with the 
‘Embedded Profile Mismatch’ or ‘Missing Profile’ alert when using Photoshop check the ‘Convert 
document’s colors to the working space’ or ‘Assign working RGB’ and then click ‘OK’.
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PRE-FLIGHT CHECK LIST
If colour consistency is important, check that your ink cartridges are not about to run out of ink and 
that you have a plentiful supply of good quality paper (same surface and same make). It is also 
worth starting to print when there is several hours of daylight left, as window light (without direct 
sun) is the best light to judge the colour accuracy of the prints. If you are restricted to printing in the 
evening it may be worthwhile checking out ‘daylight’ globes that offer a more ‘neutral’ light source 
than tungsten globes or fluorescent tubes. It is also important to position the computer’s monitor 
so that it is not reflecting any light source in the room (including the window light). 

KEEPING A RECORD
The settings of the translation process, the choice of paper, the choice of ink and the lighting 
conditions used to view the print will all have enormous implications for the colour that you see on 
the printed page. The objective when you have achieved a colour match is to maintain consistency 
over the process and materials so that it can be repeated with each successive print. It is therefore 
important to keep a track of the settings and materials used. There is only one thing more infuriating 
than not being able to achieve accuracy, and that is achieving it once and not being sure of how 
you did it. Some words of advice … WRITE IT DOWN!

QUALITY PRINTS FROM QUALITY FILES
As a starting point it is advisable to choose a portrait image with highlight and shadow detail and 
a good range of saturated and desaturated colours. Check the image’s histogram to ensure the 
image has a full tonal range and make adjustments if required. 

Note > You can add a ‘grayscale’ or ‘step wedge’ to one side of the image to further aid 
colour assessment. Fill rectangular selections with specific tones/levels of gray.
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STEP 9 – PRINT PREVIEW 
Start the printing process by selecting ‘Print Preview’ from the file menu. 

    1. Check the ‘Show More Options’ box in the corner of the print dialog box and select   
 ‘Colour Management’ from the pull-down menu. 
    2. Select the profile for the printer and media type you are using from the ‘Profile’ menu. 
 The ‘Source Space’ indicates the current profile of the image you are about to print. 
    3. Choose ‘Perceptual’ as the ‘Intent’ and check the ‘Use Black Point Compensation’ box.  
 These instructions will guide Adobe to make the required translation from the source to the  
 output colour space. 
    4. Click on ‘Page Setup’ to select the paper size and orientation (horizontal or vertical).
    5. Deselect the ‘Center Image’ box to move the print to the corner of the page.

Note > To print just a portion of the image to test the colour accuracy make a selection and 
click on the ‘Print Selected Area’ option in the print preview dialog box. If this is not possible 
create a rectangular selection around a portion of the image containing important tonal and 
colour information and then copy and paste this selection to its own layer. Switch off the 
visibility of the background layer and then proceed to select ‘Print Preview’ as before.

1

2
3

4

5
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STEP 10 – PRINTER SETTINGS
When you click on ‘Print’ in ‘Print Preview’ the printer dialog box opens. The ‘Automatic’ and 
‘Custom’ settings will override Adobe’s colour management. The secret to success when using 
Adobe image editing programs is to select the media type and ‘No Color Adjustment’ from the 
‘Color Management’ controls within the printer software (if using a Canon printer go to ‘Colour > 
Colour Control > None’).

Select the ‘Media Type’ you are using and then click ‘Print’. View the print using soft window 
light and try to ascertain any differences between the print and the screen image in terms of hue 
(colour), saturation and brightness. Any differences can be attributed to inaccuracies in your initial 
monitor calibration and/or the profile that was shipped with your printer (sometimes referred to 
as a ‘canned’ profile). More accurate profiles of the monitor and printer can be achieved by using 
profiling software and hardware, which is still expensive at this point in time. 

CREATING A ‘PREVIEW MASTER’
Use the following technique to reduce the difference between the screen and printed image: 

1.  Create a new adjustment layer in the layers palette and position it at the top of the layer stack. 
2.  Use this adjustment layer to modify the screen image until it more closely resembles the  
 printed image (view the printed image using daylight). 
3.  Name this adjustment layer as your ‘preview master’ and leave the visibility ON.
4.  Create another adjustment layer and modify the colour and tone of the image until the image  
 again looks correct. 
5.  Switch the preview master ‘OFF’ prior to printing a second print.

Note > It is possible to use the preview master for every new image you intend to print 
that uses the same printer, ink and paper combination. Simply drag this preview master 
adjustment layer into each new image you wish to edit.
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CREATING A RINGAROUND
It is advisable to limit the variables once colour consistency has been achieved. When changing 
an ink cartridge it is recommended that you run a test from the same image used to initiate the 
colour consistency and then modify the preview master adjustment layer accordingly.

Alternatively it is possible to set up a ‘ringaround’ 
or variations print. This involves creating a 
series of adjustment layers that apply variations 
of hue, brightness and saturation to a test strip 
sampled from your image. Layer masks can 
be used to shield all but a small section of the 
print from the effects of each adjustment layer. 
Although initially time consuming to set up the 
adjustment layers can be used on any image 
you wish to test in the future. If one of the 
adjustment hits the target drag it to the master 
image, remove the layer mask of the adjustment 
layer and proceed to print.

PRINTING OVERVIEW
Materials
Start by using the printer manufacturer’s recommended ink and paper.
Use premium grade ‘Photo Paper’ for maximum quality.

Monitor
Position your monitor so that it is clear of reflections.
Select a target white point or colour temperature of 6500.
Set contrast, brightness and ‘Gamma’ using ‘Adobe Gamma’ or ‘Monitor Calibrator’ 
software.

Adobe 
Set the Color Settings of the Adobe software.
Select printer profile from ‘Proof Setup’ (View menu).
Select the ‘Print Space’ (printer profile) from ‘Print Preview’ prior to printing.

Printer
Use a 6-ink inkjet printer for maximum quality.
Select the ‘Media Type’ in the printer software dialog box.
Select ‘No Colour Management’.

Proofing
Use daylight to assess colour accuracy of print.
Create a ‘preview master’ adjustment layer if required.
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DARKROOM DESIGN
Constructing a darkroom does not have to be expensive or complicated.  An available room can 
be modified quickly and effectively if the following are present:

1. A sink with running water.
2. An electricity supply.
3. An extractor fan to supply adequate ventilation.

PREPARING THE ROOM
The dry surface - A dry surface is needed where the enlargers have access to a power supply.  
In an ideal environment each enlarger has its own power supply just above the work surface.  
Each enlarger needs about one metre of available work surface and these can be partitioned off 
up to the height of the enlarger being used.  Although this is useful to prevent the light from one 
student’s enlarger fogging the paper of another, it is by no means essential if students take care 
to switch off their enlarger whilst removing the negative carrier. 
The wet surface - A wet surface for the processing of printing paper is also required.  If the 
money is available a flat bottomed PVC sink long enough to contain the four processing trays on 
a rack placed inside the sink is ideal but not essential. The first three trays can be placed directly 
onto a washable surface and the final wash tray can be placed in the adjacent sink where it can 
have access to running water via a flexible hose.  The water is allowed to overflow this final tray 
in the washing process.  Precautions can be taken to avoid flooding caused by small pieces of 
photographic paper or paper towels blocking the plug hole by inserting a small plastic tube into the 
plug hole thereby raising the water outlet to the sink.
The entrance - The most convenient entrance to a darkroom is a light trap painted matt black.  
This allows people to enter and leave the darkroom without the need for others to put away light 
sensitive materials.  The alternatives to a light trap are double doors or a revolving door which 
although less convenient will take up less space.

Ventilation -  A light trap will allow free circulation of air but doors must be provided with a light 
tight grill.  The extractor fan must also be light proof.  Any materials used to prevent direct light 
entering the darkroom should be painted with matt black paint.

Two examples of a darkroom light trap
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Safelight - The most convenient form of safelight available are special red fluorescent tubes 
that fit directly into the existing fittings.  If more than one fitting is available on separate switches 
one can be left with the original tube to provide bright illumination for preparation of chemicals 
and clearing up at either end of the day.  Safelights can also be bought which screw into existing 
bayonet type fittings.  When choosing the type of safelight you will also need to consider whether 
you will be handling certain types of film which can also be handled in safelight conditions.  If you 
are not sure as to which safelight you will need for the long term you are advised to choose red 
lights rather than orange as these will allow students to use all black and white materials that can 
be handled in safelight conditions.
Towel dispenser - Students will need the use of towels to dry hands after washing and mop any 
spillage of water or chemicals.

ESSENTIAL EQUIPMENT
Enlargers  -  Enlargers should be bought that can use filters to alter the contrast of multigrade 
paper.  These can either be equipped with a multigrade head, colour head or have a filter draw.  
When purchasing the enlarger enquiries should be made as to whether it comes with a 50mm lens 
suitable for enlarging from a 35mm negative. 
Developing trays, printing tongs and rubber gloves  -  The trays should be slightly larger than 
the printing paper you intend to use.  The printing tongs and rubber gloves are essential to allow 
students to transfer prints which are wet with chemicals between trays.
Mixing cylinders and funnel  -  These are necessary for diluting the concentrate and returning 
diluted chemicals to containers for storage.
Eye protection  -  Students must wear eye protection if they are expected to pour chemicals.
Clock  -  A large wall mounted clock with a sweeping second hand should be mounted on a wall 
that is easily visible by all the students working in the darkroom.  This will be of use for timing 
operations where there is a lack of individual timers and will also make sure that students do not 
overrun photographic sessions.

NON-ESSENTIAL EQUIPMENT
Enlarger timers  -  These are useful and accurate but again are not essential.  In-line switches 
on the power cables to the enlargers can be fitted to switch the enlarger light on and off.  Students 
can be taught to use exposure times longer than 10 seconds and count accurately by speaking the 
same word between each number, e.g. one-potato-two-potato-three etc.
Printing easels  -  These are used to hold printing paper flat and in the right position on the 
baseboard.  They are, however, a luxury and are easily damaged.  Modern resin coated printing 
paper will lie flat without the use of an easel.  A separate board with a white sticky-back plastic 
oblong the same size as the printing paper can be used to frame the projected image and provide 
positioning for the photographic paper.  If borders are required on the photographic paper a 
window mount can be cut from card and used together with a baseboard which will register both 
the paper and the window mount.
Supplementary equipment  -  Focus finders, rotary trimmer, drying rack.  These make life easier 
in the darkroom but can be added after the darkroom is already established.
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DIGITAL SET-UP
Adobe is the most popular choice for image editing software. Both Photoshop and Elements afford 
precise control over images that will be viewed on screen and in print. In order to maximise this 
control it is necessary to spend some time setting up the software and hardware involved in the 
imaging process in order to create a predictable and efficient workflow. 

This chapter will act as a pre-flight 
checklist so that the user can create the 
best possible working environment for 
creative digital image editing. The degree 
of sophistication that Adobe offers can 
appear daunting for the novice digital 
image-maker, but the time required 
setting up the software and hardware in 
the initial stages will pay huge dividends 
in the amount of time saved and the 
quality of the images produced.

COMMANDS AND SHORTCUTS
This chapter will guide you to select various options 
from a list of menus on your computer. If a command 
or dialog box is to be found in a submenu which in 
turn is to be found in a main menu it will appear as 
follows: ‘Main menu > Submenu > Command’. Many 
of the commands can be executed by pressing one 
or more of the keyboard keys (known as ‘Keyboard 
shortcuts’). 

Keyboards: Mac and PC keyboards have different layouts. The ‘Alt’ key on a PC is the 
‘Option’ key on a Mac. The functions assigned to the ‘Control’ key on a PC are assigned 
to the ‘Command’ key on a Mac (the key next to the spacebar with the apple on it). When 
the text lists a keyboard command such as ‘Ctrl/Command + Spacebar’ the PC user will 
press the Control key and the spacebar whilst the Mac user is directed to press only the 
Command key together with the spacebar.
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MONITOR SETTINGS
Resolution and colours
Set the monitor resolution to ‘1024 x 768’ pixels or greater and the monitor colours to ‘Millions’. If 
the ‘Refresh Rate’ is too low the monitor will appear to flicker. The best monitors will enable a high 
resolution with a flicker-free or stable image. It is possible to use a monitor resolution of 800 x 600 
but the size of the palettes, and the lack of a ‘palette well’ in which to store these palettes, results in 
a lack of ‘screen real estate’ or monitor space in which to display the image you are working on.

Colour temperature - selecting a white point
The default ‘colour temperature’ of a new monitor is most likely to be too bright and too blue 
for digital printing purposes (9300). Reset the ‘Target White Point’ (sometimes referred to as 
‘Hardware White Point’ or ‘Colour Temperature’) of your monitor to ‘D65’ or ‘6500’, which is 
equivalent to daylight (the same light you will use to view your prints). Setting the white point is 
part of the ‘calibration’ process that ensures colour accuracy and consistency.

Calibration
Full monitor calibration is not recommended until a new monitor has had time to ‘bed-in’ or ‘settle 
down’. You should however select an appropriate colour temperature for the monitor from the 
start. This can be adjusted using either the software ‘Adobe Gamma’ or ‘Monitor Calibrator’.
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Once a new monitor has had time to ‘bed-in’ you should complete a full monitor calibration. Switch 
on the monitor and allow the image to stabilise for at least half an hour. Then set the brightness, 
contrast, gamma and colour temperature of the monitor using calibration software. This will ensure 
that the appearance of an image on your screen will be the same on any other calibrated screen. 
Monitor calibration will also ensure that your prints will appear very similar to your screen image. 

When using an older Macintosh operating system (OS 9) or Windows open the software ‘Adobe 
Gamma’ (found in the ‘control panel’ or ‘control panels’ on a PC and Mac). Alternatively go to 
‘System Preferences > Displays > Color > Calibrate’ when using Macintosh OS X. This will launch 
the monitor calibrator software. Choose ‘6500’ as the ‘Target White Point’ or the ‘Hardware White 
Point’ and ‘Adjusted White Point’ if using Adobe Gamma. The software will also guide the user to 
set the contrast, brightness and ‘gamma’ of the monitor. On completion of the calibration process 
you must save the newly calibrated monitor settings by giving it a profile name. It is advised that 
when you name this profile you include the date that you carried out the calibration. It is usual to 
check the calibration of a monitor every 6 months.

Note > When you choose 6500 as your target white point your monitor will initially appear 
dull and a little yellow compared to what you are used to seeing. 
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DESKTOP PICTURE
Although images of tropical beaches and sunsets may look pretty relaxing, splashing them on 
your screen when editing digital images is not recommended. Any colours we see on the monitor 
- including the richly saturated colours of our desktop picture, will influence our subjective analysis 
of colour, and our resulting image editing. It is therefore highly recommended to replace the 
desktop picture with a solid tone of grey. When using Mac OS X select desktop from the System 
Preferences. 

Note > If you do not have a solid grey image in your ‘Desktop Pictures’ folder you can 
create one using the image editing software. 

DESKTOP ALIAS OR SHORTCUT 
Create an alias or shortcut for your software so 
that it is quick to launch from the desktop, Apple 
menu or ‘Dock’. Open the Photoshop folder in 
the applications folder to locate the Photoshop 
application icon. Select the Photoshop application 
icon and right-click in the destination you wish 
to create the shortcut. When using a Mac drag 
the application icon into the ‘Dock’ in OS X to 
automatically create an alias. To create an alias 
anywhere else on a Macintosh (such as the ‘Apple 
Menu Items’ in the ‘System Folder’ on OS 9) simply 
hold down the command and option keys as you 
move the Photoshop icon. Dragging images onto 
the Adobe alias/shortcut will automatically open 
them in the software.
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MANAGING YOUR PHOTOS
There are many software applications available (such as ‘Photoshop Album’ or ‘iPhoto’) to help 
catalogue and index image files so they are quick to access, edit, output and archive. Searching 
for an image file that is over a year old, with a file name you can only begin to guess at is a task 
best avoided. The software enables ‘Keywords’ to be assigned to the image so that a year down 
the track you can search for your images by, date, name or content to simplify the task.  
For the Mac OS X user it is advised that all images are stored in the ‘Pictures’ folder associated 
with each ‘User’. Many of the software packages available allow you to assign an image-editing 
programme in the preferences so that the image opens in this software when double-clicked.

GETTING STARTED WITH ELEMENTS AND PHOTOSHOP
If all of the information and control relating to a single image were on display there would be no 
room left on a standard monitor for the image itself. Most of the features of the editing software 
therefore are hidden from view but can be quickly accessed once the user starts to understand 
how the software is organised. The Adobe interface consists of the:

• Main menu
• Toolbox
• Options bar 
• Image window
• Palettes
• Palette well
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The main menu 
The main menu gives you access to the main commands. The menu is subdivided into main 
categories. Clicking on each menu category gives you access to the commands in this section. A 
command may have a submenu for selecting different options or for launching various ‘dialogue 
boxes’. Many of the commands can be accessed without using the menu at all by simply pressing 
a key combination on the keyboard called a ‘shortcut’.

The toolbox
To select a tool to work on your image you simply click on it in the toolbox. If you leave your 
mouse cursor over the tool Photoshop will indicate the name of the tool and the keyboard shortcut 
to access the tool. Some of the tools are stacked in groups of tools. A small black arrow in the 
bottom-right corner of the tool indicates additional tools are stacked behind. To access any of the 
tools in this stack hold the mouse clicker down on the uppermost tool for a second.
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The options bar
The ‘Options’ bar gives you access to the controls or specifications that affect the behaviour of the 
tool selected. The options available vary as different tools are selected.

The image window
The file name, magnification, colour mode and document size are all indicated by the image 
window. If the image is larger than the open window the scroll bars can control the section of the 
image that is visible.

The palettes
The palettes provide essential information and control over the image editing process. They can 
be arranged in stacks and moved around the screen. Icons at the base of each palette provide 
access to frequently used commands whilst additional options are available from the palette fly-
out menu. Double-clicking the palette tabs or title bars will collapse the palettes to save additional 
screen real estate. Pressing the ‘Tab’ key will temporarily hide the palettes. If you want to open a 
palette that has been closed it can be launched from the ‘Window’ menu.

Note > Pressing the ‘Tab’ key will hide the palettes and Toolbox from view. Pressing the Tab key 
again returns the palettes and toolbox. Holding down the Shift key whilst pressing the Tab key will 
hide all the palettes but keep the toolbox on the screen.

The palette well
Palettes can be dragged to the ‘palette well’ so that maximum screen space is available for the 
image window. Clicking on a tab in the palette will temporarily open the palette. Clicking away from 
the palette will automatically collapse the palette back into the well. 
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SETTINGS AND PREFERENCES
Before you start working with an image it is important to set the ‘color settings’ (see ‘Digital 
Darkroom’) and ‘preferences’ in the software. This will not only optimise the software for your 
individual computer but also ensure that you optimise images to meet the requirements of 
your intended output device (monitor or print). These settings are accessed through either the 
‘Photoshop (Elements)’ or ‘Edit’ menu from the main menu at the top of the screen.

MEMORY (THE NEED FOR SPEED)
If you have a plentiful supply of RAM (256 RAM or greater) you have to give permission for 
Photoshop or Elements to tap into these RAM reserves to a greater or lesser extent when using 
OS 9 or OS X. 75% of the available RAM will automatically be assigned to Photoshop and 
Elements when using a PC. The best advice is to close all none essential software when you are 
using Photoshop and allocate more RAM from the ‘Memory & Image Cache’ preferences (70% 
is a good starting point).

IMAGE CACHE
The Image cache setting controls the speed of the screen redraw (how long it takes an image 
to reappear on the screen after an adjustment is made). If you are working with very high-
resolution images and you notice the redraw is very slow you can increase the redraw speed by 
raising the image cache setting (it can be raised from the default setting of 4 up to 8 depending 
on the speed required). The drawback of raising this setting is that the accuracy of the redraw is 
less accurate on screen images that are not displayed at 100%. 

Macintosh OS 9: If you are using Macintosh OS 9 you will need to allocate more memory. In 
order to allocate this additional memory you must select the application icon in the application 
folder and then go to ‘File > Get Info > Memory’. You cannot allocate the total amount of 
RAM you have installed to either Photoshop or Elements as the operating system requires 
a proportion of this RAM. If RAM is not plentiful you will also need to switch the operating 
system’s ‘Virtual Memory’ on (go to ‘Control Panels > Memory > Virtual Memory’). Choose a 
figure that is greater than the installed amount of RAM (256M or greater is recommended).
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DEFAULT SETTINGS
It is possible to reset all of the software preferences to their default settings at the time of opening. 
Press and hold Alt + Control + Shift (Windows) or Option + Command + Shift (Mac OS) as the 
software is launching. A screen prompt will invite you to delete the current settings. This is useful 
when using a shared computer so that each tool behaves as you would expect it to.

PAGE SETUP
Select the paper size and orientation (vertical or horizontal) by going to File > Page Setup. When 
you have chosen the paper size you can quickly gain an idea of how large your image will be 
printed by holding down the Alt/Option key and clicking on the document size at the base of the 
image window. The window that springs open shows the relationship between the paper and the 
image (represented by a rectangle with a large cross). 

Note > A shaded area around the edge of the paper indicates the portion of the paper that cannot 
be printed (older style printers).

OPENING IMAGES
Double-clicking an image on the desktop should 
automatically open the file into image editing software. If 
the file does not open into the image editing software you 
can launch it by going to the ‘File > Open’ menu in the 
software programme. If you prefer your Adobe software 
to handle all of your image files you should select it as the 
default image editing software in your system preferences. 
In OSX click once to select a file that would normally be 
opened in software other than Adobe, e.g. QuickTime. 
Then select ‘Get Info’ from the ‘File’ menu of the ‘Operating 
System’ menu. Choose the Adobe software programme 
in the ‘Open With’ submenu. Then select the ‘Change All’ 
button for all future documents of a similar format and file 
type to be opened by Adobe automatically.
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The fastest way to open a file from your picture library is to use the ‘File Browser’ from the Window 
menu. Multiple files can be selected by successively dragging them into the preview window. 

NAVIGATION AND VIEWING MODES
When viewing a high-resolution image suitable for printing it is usual to zoom in to check the image 
quality and gain more control over the editing process. There are numerous ways to move around 
an image and each user has their preferred methods to speed up the navigation process.

The Navigator palette
The Navigator palette is simple and effective to use. 
You can use it to both zoom in and out of the image 
and move quickly to new locations within the enlarged 
image. The rectangle that appears in the image 
shows the area visible inside the image window. This 
rectangle can be dragged to a new location within 
the image. Using the slider directly underneath the 
preview window or clicking on the icons either side 
of the slider controls magnification. It is also possible 
to type in a specific magnification and then press the 
enter/return key.
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The ‘Zoom’ and ‘Hand’ tools
These tools offer some advantages over the Navigator palette. They can be selected from within 
the toolbox or can be accessed via keyboard shortcuts. Clicking on the image with the zoom tool 
selected zooms into the image around the point that was clicked. The zoom tool options can be 
selected from the options bar beneath the main menu. Dragging the zoom tool over an area of the 
image zooms into that area with just the one action (there is no need to repeatedly click). 

When you are zoomed into an area you can move the view with the ‘Hand’ tool. Dragging the 
image with the hand tool selected moves the image within the image window (a little like using 
the scroll bars). The real advantage of these tools is that they can be selected via shortcuts. The 
spacebar temporarily accesses the hand tool no matter what other tool is selected at the time (no 
need to return the cursor to the toolbox). The zoom tool can be accessed by pressing the Control/
Command + Spacebar to zoom in or the Alt/Option + spacebar to zoom out.

Note > When you are making image adjustments and a dialog box is open, the keyboard shortcuts 
are the only way of accessing the zoom and move features.

Additional shortcuts
Going to the View menu in the main menu will reveal the keyboard shortcuts for zooming in 
and out. You will also find the more useful shortcuts for ‘Fit on Screen’ and ‘Actual Pixels’ 
(100 per cent magnification). These very useful commands can also be accessed via the 
toolbox by either double-clicking on the hand tool (Fit on Screen) or double-clicking the 
zoom tool (Actual Pixels) in the toolbox itself.
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MAC OR PC?
Photoshop was originally written as a Macintosh only application back in 1990 and became 
available for PC with the release of version 2.5. Photoshop now happily works out of either 
platform. Most commercial image-makers, who have to deal with the printing industry 
however, are still using Apple Macintosh computers. Macs dominate the industry but they 
are not necessarily any better than PCs at image making tasks. Commercial image-makers 
tend to purchase them because their colleagues within the industry are using them. It is 
really just a communication issue. Macs and PCs can talk to each other if required, e.g. 
Photoshop operating on either platform can open the same image file. The bottom line 
however is that small, but annoying, communication issues can often arise when files are 
passed ‘between’ the two platforms. Image-makers who are thinking of choosing the PC 
platform need to think carefully how, if at all, these communication issues will impact upon 
them. The biggest communication problem that exists to date is that an image file on a 
Macintosh formatted disk cannot be accessed easily, or at all, by a PC user. 

USE-BY DATE
When choosing a computer for commercial digital imaging it is worth noting that most 
systems are usually past their use-by date before three years have expired. This may 
continue to be the case although the whole issue of speed is largely becoming academic for 
stills image editing. The days of waiting for extended periods whilst Photoshop completed a 
command are largely over, even using an entry-level computer. The issue of speed however 
is still very much of an issue for creators of DVD (digital video) where disk write speeds are 
still slow and file sizes are measured in Gigabytes instead of Megabytes.
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CONTROLLED TEST
Your completed work must include contact sheets and research work as well as your finished 
presentation piece.  You should give clear evidence of how you have approached your work and 
how your ideas have developed during the course of the test.  Any experimentation into style and 
technique should be recorded clearly on the research sheets.  The final work should be mounted 
on sturdy card.  

Note.  You are encouraged to make full use of the range of techniques and skills covered 
by the course wherever appropriate.  

ANSWER ONE QUESTION ONLY.
1.  Manual labour   You have been commissioned by the council to present a visual documentary 
about manual labour.  Your piece could focus on a man, woman, group or team.  Your work should 
emphasise the interaction between people and their surroundings, with particular reference to the 
supporting objects and images associated with their occupations and pastimes.

2.  Theatre workshop   Produce a set of promotional photographs for a theatre workshop that 
shows the company are encouraged to develop a wide variety of acting styles.  Your photographs 
should demonstrate a variety of moods and emotions using one or more people.  It is recommended 
that you stage the lighting and poses specifically for the camera.  The moods and emotions might 
include happiness, sadness, curiosity, contemplation, boredom, excitement, friendliness, hostility, 
arrogance, delight, fear, satisfaction, anticipation, anger, peace, concentration, uncertainty, and 
frustration.

3.  Pressure group   Produce a set of promotional photographs that would be suitable for use by a 
pressure group, e.g. Greenpeace, Friends of the Earth, Campaign for Nuclear Disarmament, Anti 
Nazi League or one of your own choice.  The images you produce should promote the principal 
objectives or symbolism related to the particular group.

4.  Illustration   Produce a set of images that illustrates a poem, book extract, song lyric or 
newspaper article.  You may incorporate the text into the finished piece of work.

5.  Surreal story   Produce a sequence of images that communicates a surreal short story.  The 
source of your imagery could be a recent dream or daydream that you may have experienced.

6.  Hands   Photograph hands in expressive postures or engaged in interesting activities.  You 
may photograph one hand by itself, both hands of one person or the hands of several people 
together.  Do not include a full face with the hands, although part of a face is acceptable.

7.  Still life   Produce a set of still life photographs that explores a range of old objects, things that 
are worn out from age or use.  The final work can be either abstract or commercial. 

8.  Shadows   Photograph an object (or part of it) along with its shadow, exploring how the shadow 
can add visual interest to an image.
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PROGRESS REPORT   

Student Name ................................ Class ................. Date ................ Time...........

ASSIGNMENT FEEDBACK
Creativity ..................................................................................................................
Composition  ............................................................................................................
Presentation  .............................................................................................................

Exposure  .................................................................................................................
Processing  ............................................................................................................... 
Focusing   .................................................................................................................
Contrast   ..................................................................................................................

Attendance   ....................  Punctuality   ......................  Deadlines   .......................

GENERAL PROGRESS
Creative approach to design activities .....................................................................
Management of time ................................................................................................
Technical competency ..............................................................................................
Appropriate use of the study guides to aid research  ...............................................
Points raised by student
..........................................................................................................................................................
..........................................................................................................................................................
Points raised by tutor .......................................................................................................................
..........................................................................................................................................................
Negotiated statement on progress
..........................................................................................................................................................
..........................................................................................................................................................
..........................................................................................................................................................

Necessary action agreed to be undertaken
..........................................................................................................................................................
..........................................................................................................................................................

..............................................................................................................................................

Signature of student ............................................................................

Signature of tutor ................................................... Date ...................                                 
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WORK SHEET

Student Name .............................................Year .................... Group .......................
Assignment ................................................................................................................

Research
 1.  What is it you like about the images you have been looking at?  .................
 ............................................................................................................................
 ............................................................................................................................
 2.  What techniques has the photographer used?  ............................................
 ............................................................................................................................
 ............................................................................................................................

Preliminary work
 1.  Which images do you like from your first proof sheets?   ..............................
 ............................................................................................................................
 ............................................................................................................................
 2.  How could you improve upon these images?  ..............................................
 ............................................................................................................................
 ............................................................................................................................

Plans and ideas
 1.  What elements from your research can you use in your own work?.............
 ............................................................................................................................
 ............................................................................................................................
 ............................................................................................................................

 2.  What ideas do you have to develop a theme? ..............................................
 ............................................................................................................................
 ............................................................................................................................
 ............................................................................................................................
 ............................................................................................................................

Organisation of final shoot
 Location  ........................................  Time and date  .........................................
 Estimated time needed for shoot  ......................................................................
 Permission or tickets required  .....................  Contact name  ...........................
 Equipment needed  ............................................................................................
 Props needed  ....................................................................................................
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SUMMER PROJECT

INTRODUCTION
The word ‘summer’ can conjure up many different images: strawberries and cream, hot lazy days, 
rain soaked day trippers, excited holidaymakers, bored school children, cricket on the village 
green, discarded ice-creams in the sand, littered beaches etc.

ASSIGNMENT
In this assignment you must record one aspect of your summer this year, something that has 
attracted your visual curiosity.  Do not necessarily choose a stereotypical view of summer, i.e. a 
picture postcard shot of the beach or family snap shots.
The images that you choose should relate with each other in some way and portray a theme or 
aspect of summer that you would like to convey.  The photographs may be abstract, documentary 
shots from real life or shots that have been set up to convey a message.
You may work in black and white or colour and will be expected to have taken at least two rolls of 
film.  It is not expected that you will process or print your own images over the summer.  You may 
have your films processed and printed commercially.  If you decide to work in black and white you 
will find that the film Ilford XP2 or Kodak T 400 CN can be processed quickly and cheaply through 
most photographic high street minilabs.
Edit your prints down to six images and present them on one sheet of card no larger than A3 in 
size.  The deadline for this project is the first week of term.

 ASSESSMENT CRITERIA
 Your work will be assessed using the following criteria:

 1.  Arrangement and composition of subject matter within the frame.
 2.  Use of light to create appropriate mood.
 3.  Sympathetic use of viewpoint and creative use of shutter speed.
 4.  Visual clarity of idea and theme.
 5.  Presentation.
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Shaun Guest



GLOSSARY
The display of a digital image where a curved line appears jagged 
due to the square pixels.
The natural or artificial continuous light that exists before the 
additional lighting is introduced.
To examine in detail. 
The process of smoothing the appearance of a curved line in a digital 
image.
A circular opening in the lens that controls light reaching the film.

A subject illuminated from behind.
A harmonious or stable relationship between elements within the 
frame.
Short for binary digit, the basic unit of the binary language.
An image or sections of an image that are not sharp.  This can be 
caused through inaccurate focusing, shallow depth of field or a slow 
shutter speed.
Over- and underexposure either side of a meter-indicated exposure.
The shutter speed setting B allows the shutter to stay open as long as 
the shutter release remains pressed. 
Lighting that is reflected off a surface before reaching the subject.
8 bits. The standard unit of binary data storage containing a value 
between 0 and 255.

A cable that allows the shutter to be released without shaking the 
camera when using slow shutter speeds.
Blurred image caused by camera movement during the exposure.
Charge coupled device.  A solid state image pick-up device used in 
digital image capture.
A method of separating a digital colour image into primary or 
secondary colours.
A tool used for replicating pixels in digital photography.
A one element lens that is attached to the front of the camera’s lens. 
This allows the image to be focused when the camera is close to a 
subject.
A term referring to the action of making the lens aperture smaller.
Cyan, magenta, yellow and black. The inks used in four colour 
printing.

Aliasing

Ambient light

Analyse/Analysis 
Anti-aliasing

Aperture

Backlit 
Balance 

Bit
Blurred

Bracketing
B setting

Bounced light
Byte

Cable release 

Camera shake
CCD

Channels

Cloning tool
Close-up lens

Close down
CMYK
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The arrangement of shape, tone, line and colour within the boundaries 
of the image area.
A method of reducing the file size when a digital image is closed.
Retain the proportional dimensions of an image when changing the 
image size.
A print created by placing objects or negatives in direct contact with 
photographic paper and exposing this paper to light. 
The circumstances relevant to something under consideration. 
The difference in brightness between the darkest and lightest areas 
of the image or subject.
Central processing unit used to compute exposure.
Reduce image size to enhance composition or limit information.
Control for adjusting tonality and colour in digital photography.

The moment when the arrangement of the moving subject matter 
in the viewfinder of the camera is composed to the photographer’s 
satisfaction.
A flash unit that is fully linked to the camera’s electronics and uses 
the camera’s own TTL light meter to calculate correct exposure.
The action of removing the edge pixels of a selection.
The measure of opacity of tone on a negative.
The zone of sharpness variable by aperture, focal length or subject 
distance.  
A slanting line that is neither horizontal nor vertical.  
Use of focus to highlight specific subject areas 
Light that is dispersed (spreads out) and is not focused.
Material used to disperse light.
A computer-generated photograph composed of pixels (picture 
elements) rather than film grain.  
A sense of depth in a two-dimensional image provided by the reduced 
size of subjects as they recede into the distance.
Term for close-up lenses.
To cut into pieces.  The edge of the frame can dissect a familiar 
subject into an unfamiliar section.
Dots per inch. A measurement of resolution.
An image which lacks either balance or harmony and where visual 
elements cause the eye to move out of the image.
Bar coded film speed rating.

Select images from a larger collection to form a sequence or theme.
Light sensitive layer on film or paper.

Composition

Compression
Constrain proportions

Contact print

Context 
Contrast

CPU
Crop
Curves

Decisive moment

Dedicated flash 

Defringe
Density 
Depth of field 

Diagonal
Differential focusing
Diffused light
Diffuser
Digital image

Diminishing
perspective
Dioptres
Dissect

Dpi
Dynamic tension

DX coding

Edit
Emulsion
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Evaluate
Exposure

Exposure 
compensation
Exposure meter
Extreme contrast

F-numbers

Fast film

Feather
Field of view
Figure and ground
Fill flash

Fill 
Film speed

Filter 

Filter factor

Flare 

Focal length

Focal plane shutter
Focal point
Focusing

Format
Frame

Golden section

Assess the value or quality of a piece of work.
Combined effect of intensity and duration of light on a light sensitive 
material.
To increase or decrease the exposure from a meter-indicated 
exposure to obtain an appropriate exposure.
Device for the measurement of light.
A subject brightness range that exceeds the film’s ability to record 
detail in all tones.

A sequence of numbers given to the relative sizes of aperture 
opening.  F-numbers are standard on all lenses.  The largest number 
corresponds to the smallest aperture and vice versa.  
A film that is very light sensitive compared to other films.  Fast film 
has a high ISO number and can be used when the level of ambient 
light is low.
The action of softening the edge of a digital selection.
The area visible through the camera’s viewing system.
The relationship between subject and background.
Flash used at a reduced output to lower the subject brightness 
range. 
Use of light to increase detail in shadow area.
A precise number or ISO rating given to a film indicating its degree of 
light sensitivity.  See ‘Fast film’ and ‘Slow film’.   
Treated or coloured glass or plastic placed in front of the camera 
lens to alter the transmission of different wavelengths of light thereby 
altering the final appearance of the image.
A number used to indicate the effect of the filter’s density on 
exposure.
Unwanted light, scattered or reflected within the lens assembly 
creating patches of light and degrading image contrast.
Distance from the optical centre of the lens to the film plane when 
the lens is focused on infinity.  A long focal length lens (telephoto) 
will increase the image size of the subject being photographed.  A 
short focal length lens (wide-angle) will decrease the image size of 
the subject.
A shutter directly in front of the film plane.
Point of focus at the film plane or point of interest in the image.
The action of creating a sharp image by adjusting either the distance of 
the lens from the film or altering the position of lens elements.
The size of the camera or the orientation/shape of the image. 
The act of composing an image.  See ‘Composition’.

A classical method of composing subject matter within the frame.
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Tiny particles of silver metal or dye which make up the final image.  
Fast films give larger grain than slow films.  Focus finders are used 
to magnify the projected image so that  the grain can be seen and an 
accurate focus obtained.
Card which reflects 18% of incident light.  The resulting tone is used 
by light meters as a standardised mid-tone.
A measurement of the power of flash relative to the film speed being 
used.  Divide the guide number  by the maximum aperture available 
to find the maximum working distance in metres for 100 ISO film.

A system of reproducing the continuous tone of a photographic print 
by a pattern of dots printed by offset litho.
A print.
Memory facility which is capable of retaining information after the 
computer is switched off.
A light source which appears small to the human eye and produces 
directional light giving well-defined shadows, e.g. direct sunlight or a 
naked light bulb.
An image where light tones dominate.  
Area of subject receiving highest exposure value.
A graphical representation of a digital image indicating the pixels 
allocated to each level.
A line that is parallel to the horizon.
Plug in socket for on-camera flash.

A measurement of the intensity of light falling on a subject.
A method of increasing the apparent resolution of an image by adding 
pixels of an average value to adjacent pixels within the image.
International Standards Organisation.  A numerical system for rating 
the speed or relative light sensitivity of a film.
A film which is sensitive to wavelengths of light longer than 720nm 
but which are invisible to the human eye. 

Joint Photographic Experts Group. Popular image compression file 
format.
Placing objects or subjects within a frame to allow comparison.   

The main light casting the most prominent shadows.
1024 bytes.

Selection tool used in digital editing.
Ability of the film to record the brightness range of the subject.

Grain

Grey card

Guide number

Half-tone

Hard copy
Hard drive

Hard light

High key 
Highlight
Histogram

Horizontal
Hot shoe 

Incident light reading
Interpolation 

ISO

Infrared film

JPEG (.jpg)

Juxtapose

Key light
Kilobyte

Lasso tool
Latitude
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Layers

LCD
LED

Lens

Levels
Light meter    

Long lens
Low key

Macro
Magic wand tool
Marching ants
Matrix metering

Marquee tool
Maximum aperture
Megabyte
Megapixels
MIE
Minimum aperture
Mode (digital image)

Multiple exposure

Negative

Neutral density filter

Objective
ODR
Opaque
Open up
Overall focus

Pan

A composite digital image where each element is on a separate  layer 
or level.
Liquid crystal display.
Light-emitting diode.  Used in the viewfinder to inform the photographer 
of exposure settings.
An optical device usually made from glass that focuses light rays to form 
an image on a surface.
The method of assigning a shade of lightness or brightness to a pixel.
A device that measures the intensity of light so that the optimum 
exposure for the film can be obtained.
Lens with a reduced field of view to normal.
An image where dark tones dominate.

Extreme close-up.
Selection tool used in digital editing.
A moving broken line indicating a digital selection of pixels.
A reflected light meter reading which averages the readings from 
a pattern of segments over the subject area. Bias may be given to 
differing segments according to preprogrammed information.
Selection tool used in digital editing.
Largest lens opening.
A unit of measurement for digital files. 1024 kilobytes.
More than a million pixels.
Meter-indicated exposure. 
Smallest lens opening.
RGB, CMYK etc. The mode describes the tonal and colour range of the 
captured or scanned image.
Several exposures made onto the same frame of film or piece of 
paper.

An image on film or paper where the tones are reversed, e.g. dark tones 
are recorded as light tones and vice versa.
Reduces the amount of light reaching the film, enabling the  
photographer to choose large apertures in bright conditions or  extend 
exposure times.

A factual and non-subjective analysis of information.
Output device resolution.
Not transmitting light.
Increasing the lens aperture to let more light reach the film.
An image where everything appears sharp.

To follow a moving subject.
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The apparent relationship of distance between visible objects thereby 
creating the illusion of depth in a two-dimensional image.
Flattened perspective created by the use of a telephoto lens and 
distant viewpoint.
Tungsten studio lamp with a colour temperature of approximately 
3400K.
The smallest square picture element in a digital image.
A grey looking filter used to block polarised light.  It can remove or 
reduce unwanted reflections from some surfaces and can increase 
the colour saturation and darken blue skies.    
A telephoto lens used to capture non-distorted head and shoulder 
portraits with shallow depth of field.
A programmed exposure mode that ensures shallow depth of field.
The ability to decide what the photographic image will look like before 
exposure.
The capability of the computer’s CPU measured in megahertz.
The film speed on the camera’s dial is increased to a higher number for 
the entire film.  This enables the film to be used in low light conditions.  
The film must be developed for a longer time to compensate for the 
underexposure.
Increasing development to increase contrast or to compensate for 
underexposure of films that have been rated at a higher speed than 
recommended.

Random access memory, the computer’s short-term or working 
memory.
A surface used to reflect light in order to soften harsh shadows.
The change in direction of light as it passes through a transparent 
surface at an angle.
Alter the total number of pixels describing a digital image. 
A measure of the degree of definition, also called sharpness.
Red, green and blue. The three primary colours used to display 
images on a colour monitor.
A tool used for replicating pixels in digital imaging.
An imaginary grid that divides the frame into three equal sections 
vertically and horizontally.  The lines and intersections of this grid are 
used to design an orderly composition.

Intensity or richness of colour hue.
A ratio of size. 

Perspective

Perspective 
compression
Photoflood

Pixel
Polarising filter

Portrait lens

Portrait mode 
Previsualise

Processor speed
Pushing film

Push-processing

RAM

Reflector
Refraction

Resample image
Resolution
RGB

Rubber stamp
Rule of thirds

Saturation (colour)
Scale
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Selective focus

Self-timer

Sharp
Shutter
Shutter-priority

Silhouette
Skylight filter

Sliders

Slow film 

SLR camera

Soft light

Software 
Standard lens
Steep perspective

Stop down
Straight photography
Subjective analysis

Symmetry

Sync lead

Sync speed

System software

The technique of isolating a particular subject from others by using a 
shallow depth of field.
A device which delays the action of the shutter release.  This can be 
used for extended exposures when a cable release is unavailable.
In focus.  Not blurred.
A mechanism that controls the accurate duration of the exposure.
Semi-automatic exposure mode.  The photographer selects the 
shutter speed and the camera sets the aperture.
The outline of a subject seen against a bright background.
Used to reduce or eliminate the blue haze seen in landscapes.  It 
does not affect overall exposure so it is often used to protect the front 
lens element from damage.
A sliding control in digital editing software used to adjust colour, tone, 
opacity etc.
A film that is not very sensitive to light when compared to other films 
with a higher ISO number.  The advantage of using a slow film is its 
smaller grain size.
Single Lens Reflex camera. The image in the viewfinder is essentially 
the same image that the film or sensor will see.  This image, prior to 
taking the shot, is viewed via a mirror which moves out of the way 
when the shutter release is pressed.
This is another way of describing diffused light which comes from a 
broad light source and creates shadows that are not clearly defined.
A computer program.
A lens that gives a view that is close to normal visual perception.
Exaggerated diminishing perspective created by a viewpoint in close 
proximity to the subject with a wide-angle lens.
Decreasing the aperture of the lens to reduce the exposure.
Photographic images that have not been manipulated.
Personal opinions or views concerning the perceived communication 
and aesthetic value of an image.
Duplication of information either side of a central line to give an image 
balance and harmony.
A lead from the camera to the flash unit which synchronises the firing 
of the flash and the opening of the shutter.
The fastest shutter speed available, for use with flash, on a camera 
with a focal plane shutter.  If the sync speed of the camera is exceeded 
when using flash the image will not be fully exposed.
Computer operating program, e.g. Windows or Mac OS.
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A long focal length lens.  Often used to photograph distant subjects 
which the photographer is unable to get close to.  Also used to flatten 
apparent perspective and decrease depth of field.
A set of images with a unifying idea.
Tagged Image File Format. Popular image file format for desktop 
publishing applications.
A tint of colour or shade of grey.
Allowing light to pass through.
Through-the-lens reflective light meter.  This is a convenient way to 
measure the brightness of a scene as the meter is behind the camera 
lens.
A common type of electric light such as that produced by household 
bulbs and photographic lamps.  An 80A blue filter may be used to 
prevent an orange cast.

A filter for increasing apparent sharpness of a digital image.
The action of ‘pushing’ the film, i.e. the film speed on the camera’s dial 
is increased to a higher ISO for the entire film. This enables the film 
to be used in low light conditions.  Development must be increased to 
compensate for the underexposure.   
A filter used to absorb ultraviolet radiation.  The filter appears 
colourless and may be left on the lens permanently for protection. 

A position in relation to the subject which enables the photographer 
to compose a good shot.
At right angles to the horizontal plane.
Hard drive memory allocated to function as RAM.
To imagine how something will look once it has been completed.   

A lens with an angle of view greater than 60o.  Used when the 
photographer is unable to move further away or wishes to move 
closer to create steep perspective. 

Synchronisation setting for electronic flash.
A socket on the camera or flash unit which enables a sync lead 
to be attached.  When this lead is connected the flash will fire in 
synchronisation with the shutter opening.

A variable focal length lens. Zoom lenses have comparatively smaller 
maximum apertures than fixed focal length lenses.
This is a technique where the focal length of a zoom lens is altered 
during a long exposure.  The effect creates movement blur which 
radiates from the centre of the image.

Telephoto lens

Thematic images
TIFF 

Tone
Transparent
TTL meter 

Tungsten light

Unsharp mask
Uprating film

UV filter

Vantage point

Vertical
Virtual memory
Visualise

Wide angle lens

X
X-sync (pc socket)

Zoom lens

Zooming 
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Action image, 119

Adobe Elements and Photoshop, 198, 202–8

 ‘Hand’ tool, 208

 Image cache, 205

 image window, 204

 main menu, 203

 memory, 205

 navigation and viewing modes, 207–8

  Navigator palette, 207

 opening images, 206–7

 Options bar, 204

 Page Setup, 206

 Palette Well, 204

 palettes, 204

 Photoshop format, 170

 settings and preferences, 205

  default settings, 206

 Toolbox, 203

 ‘Zoom’ tool, 208

 See also Digital set-up

Adobe Gamma, 190, 199–200

Adobe RGB, 190

Advertising:

 ambiguity in, 132

 glamour in, 131

Alias, 201

Aliasing, 215

Alternative realities, 93

Ambient light, 215

Ambiguity, in advertising, 132

Anti-aliasing, 215

Aperture, 146, 215

 depth of field and, 33

 slow-sync flash and, 46

Aperture priority (Av), 149

Artificial light, 74

Atmosphere, creation of, 28

Automatic cameras, 140, 144

Automatic flash, 45

B setting, 215

Backing up, 187

INDEX
Balance, 19, 215

Beauty, images of, 53

Berger, John, 130

Bit depth, 167

Bits, 165, 215

Blending, 83

Blur, 215

 movement blur, 41

Bounced light, 215

Bracketing, 215

Brightness, 168

 adjustment, 181

Broken line, 20

Burning in, 160

Bytes, 165, 215

Cable release, 215

Camera shake, 41, 215

Cameras, 140–5

 automatic cameras, 140, 144

 care of, 140

 digital cameras, 145, 179

 manual cameras, 140

 shutter, 146

 SLR cameras, 140, 141, 221

Captions, 10, 129

Cartier-Bresson, Henri, 38

CCD (charge coupled device), 215

Centre-weighted metering, 147

Channels, 166, 215

Character studies, 106, 109

Clone Stamp Tool, 185

Cloning tool, 215

Close down, 215

Close-up image, 120

Close-up lens, 215

Closed landscape, 95

CMYK colour mode, 166, 189, 215

Colour, 166–8

 adjustment of, 182–3

  monitor, 190, 199–200

 bit depth, 167
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 CMYK mode, 166

 hue, saturation and brightness, 168

 primary colours, 168

 RGB mode, 166

 secondary colours, 168

Coloured filters, 94

Colouring of prints, 75

Comfort zone, 117

Composition, 15–23, 25, 129, 216

 balance, 19

 depth, 23

 filling the frame, 16

 framing the subject, 15

 landscape, 95

 line, 20–1

 portraiture, 103–5

  two or more people, 104

 subject placement, 18

 vantage point, 22, 96, 222

Compression, 216

 digital files, 165, 188

  file formats, 170

 perspective, 220

Computer manipulation, See Digital manipulation

Computers, See Digital photography; Digital set-up

Conformity, 54–5

Constructed environment, 97

Contact prints, 216

Context, 8, 17

Continuous tone, 164

Contrast, 31, 216

 adjustment, 181

 control of, 157

 extreme, 217

CPU (central processing unit), 216

Cropping, 129, 183–4, 216

Curves, 21, 216

Darkroom design, 196–7

 equipment, 197

Decisive moment, 38, 216

Dedicated flash, 45, 216

Defringe, 216

Depth, 23

 landscapes, 96

Depth of field, 33, 73, 74, 216

 portraiture, 105

 preview, 33

Design, 2

 portraiture, 103–5

Desktop picture, 201

Detail image, 120

Diagonal lines, 21, 25, 216

Differential focusing, 72, 74, 216

Diffused light, 216

Diffuser, 216

Digital cameras, 145, 179

Digital darkroom, 178–94

 cleaning, 185

 cropping, 183–4

 image capture, 178–80

 printing to an inkjet printer, 189–94

  colour setting selection, 190

  monitor calibration, 190, 199–200

  preview master creation, 193

  print preview, 192

  printer settings, 193

  profiles, 189

  RBG to CMYK, 189

  recording settings, 191

  ringaround creation, 194

 save, duplicate, resize and save again, 187

 sharpening the image, 186

 tonality adjustment, 180–2

  weak histogram correction, 182

 See also Digital manipulation; Digital 

photography; Digital set-up

Digital manipulation, 77–83

 blending, 83

 cut, copy and paste, 77

 digital montage, 78–80

 digital posterization, 81

  colour image, 81

 digital Sabattier effect, 82

 photographic stories and, 123

 See also Digital darkroom; Digital photography

Digital photography, 164–76

 bit depth, 167



>>
>

FO
U

N
D

AT
IO

N
S

Index
Ph

o
to

gr
ap

hy
 >>>

>>
>

225

 file formats, 170, 175, 188

 file size, 165

 hue, saturation and brightness, 168

 image capture, 178–80

  digital cameras, 145, 179

  scanning, 179–80

 levels, 164

 modes and channels, 166

 pixels, 164, 171

  pixel dimensions, 172

 resolution, 171–6

  optimum image resolution calculation, 175

  output resolution, 172, 173

  print quality and, 171

  scanning resolution, 176

 See also Digital darkroom; Digital manipulation; 

Digital set-up

Digital set-up, 198–210

 commands and shortcuts, 198

 desktop alias or shortcut, 201

 desktop picture, 201

 image management, 202

 Mac versus PC, 209

 monitor settings, 199–200

  calibration, 190, 199–200

  colour temperature, 199

  resolution, 199

 See also Adobe Elements and Photoshop; 

Digital darkroom; 

Digital photography

Diminishing perspective, 216

Display Calibrator, 190

Distortion, 72–83, 85–6

 in the darkroom, 75–6

  Sabattier prints, 76

 limits of, 72

 using the camera, 73–5

  depth of field, 74

  lens distortion, 73, 129

  lighting/film, 74

  reflection, 73

  refraction, 73

 See also Digital manipulation; Manipulation

Documentary photography, 91

Dodging, 160

Dominant tones, 149

Dots per inch (dpi), 173

DX coding, 216

Dynamic tension, 18, 216

Editing, 129

 photographic stories, 122

Effects light, 34

Elements, See Adobe Elements and Photoshop

Emerson, Peter Henry, 89

Enlargers, 197

Equipment, 2

 darkroom, 197

 See also Cameras

Ethics, photographic stories, 123

Exposure, 146, 217

 aperture priority (Av), 149

 exposure compensation, 31–2, 217

 quality control, 162

 shutter priority (Tv), 149, 221

 very long exposures, 42

Extreme contrast, 217

F64 group, 90

F-numbers, 33, 146, 217

Farm Security Administration (FSA), 115

Fast film, 217

Feather, 217

Feel good factor, 132

Field of view, 217

File format, 170, 175, 188

File size, 165

Fill flash, 217

Film:

 infrared, 74, 218

 processing, 152–5

 uprating, 222

Film speed, 217

 fast film, 217

 slow film, 221

Filters, 94, 217

 coloured filters, 94

 filter factor, 217
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 neutral density filter, 219

 polarising filter, 94, 220

 skylight filter, 221

 UV filter, 222

Flare, 217

Flash photography, 45–6

 fill flash, 217

 slow-sync flash, 46, 48

Focal length, 217

 portraiture, 105

Focal point, 217

Focusing, 129, 217

 differential focusing, 72, 216

 selective focus, 221

 See also Depth of field

Format, 95, 217

 output file, 170, 175, 188

 portraiture, 103

Framing, 15–16, 129

Glamour, in advertising, 131

Golden section, 18, 217

Goldsworthy, Andy, 97

Grain, 218

Grayscale mode, 166

Grey card, 218

Guide number, 218

Half-tone, 218

Hard copies, 164, 218

Hard drive, 218

Hard light, 29, 36, 218

Hardware White Point, 190, 199–200

Healing Brush Tool, 185

Heartfield, John, 62

Highlight, 218

Histogram, 218

 weak histogram correction, 192

Hockney, David, 66

Holding back, 160

Horizon line, 20, 95

Horizontal lines, 20

Hot shoe, 218

Hue, 168

 See also Colour

ICC profiles, 189

Infrared film, 74, 218

Inkjet printer settings, 193

 See also Digital darkroom

Interpolation, 173, 218

Interpretation, 8

ISO (International Standards Organisation), 218

Joiners, 66

Jpeg format, 170, 175, 188, 218

Juxtaposition, 218

 See also Photomontage

Kennard, Peter, 62, 132

Keyboards, 198

Kilobytes, 165, 218

Landscape, 88–97

 closed landscape, 95

 constructed environment, 97

 documentary, 91

 early landscape images, 88

 expressive techniques, 94–6

  composing the landscape, 95

  depth, 96

  filters, 94

  recording the sky, 94

  vantage point, 96

 naturalism, 89

 personal expression, 92–3

  alternative realities, 93

 pictorial photography, 89

 realism, 90

Latitude, 218

Layers, 219

Legal issues, photographic stories, 123

Lens, 219

Lens distortion, 73, 129

Levels, 164, 219

 adjusting the levels, 181, 182

Light, 27–34, 36

 ambient light, 215
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 artificial light, 74

 bounced light, 215

 contrast, 31

 creation of atmosphere, 28

 diffused light, 216

 direction of, 30

 exposure compensation, 31–2, 217

 hard light, 218

 quality of, 29

 soft light, 29, 221

 studio lighting, 34

 See also Flash photography

Light meters, 219

 See also Through the lens (TTL) light meters

Line, 20–1

Long lenses, 73, 219

LZW compression, 170

McBean, Angus, 65

Macintosh OS9, 205

Magic wand tool, 219

Magnum, 115

Manipulation, 64

 print manipulation, 44

 techniques, 129–30

 See also Digital manipulation; Distortion

Marching ants, 219

Marquee tool, 219

Matrix metering, 147, 219

Media images, 10

Megabytes, 165, 219

Megapixels, 219

Memory allocation, 205

Metaphors, 9

Modes, 166, 219

Moholy-Nagy, Laszlo, 65

Monitor settings, 199–200

 calibration, 190, 199–200

 colour temperature, 199

 resolution, 199

Montage, digital, 78–80

 See also Photomontage

Movement blur, 41

Multiple exposures, 43, 75, 219

Naturalism, 89

Negative prints, 75

Negatives, 219

 making a proof sheet, 158

 quality control, 162

 sandwiching, 75

Neutral density filter, 219

Objective analysis, 6

Output file formats, 170, 175, 188

Output resolution, 173

 pixel size and, 172

Panning, 40

PDF format, 175

Peach-Robinson, Henry, 61

Pentaprism, 140

Personal expression, 92–3

 alternative realities, 93

Perspective, 20, 220

 compression, 220

 diminishing perspective, 216

 steep perspective, 73, 221

Photoflood, 220

Photographic agencies, 115

Photographic stories, 114–23

 capturing a story, 118–20

  action image, 118

  close-up/detail image, 119

  establishing image, 119

  portraits, 119

 creating a story, 121

 editing work, 122

 ethics, 123

 Farm Security Administration (FSA), 115

 history, 114–15

 legal issues, 123

 photographic agencies, 115

 visual communication, 116–17

  choosing a subject, 116

  the comfort zone, 117

Photomontage, 60–6, 129

 definition, 60

 history, 60–1



Photography: Foundations for Art & Design
FO

U
N

D
AT

IO
N

S
>>

>
P

h
o

to
gr

ap
hy
 >>>

>
>

>

228

  developments, 61

  examples, 61

 in art, 65–6

  joiners, 66

  surrealism, 65

 in the media, 64

 political, 62–3

  techniques, 63

Photoshop format, 170

 See also Adobe Elements and Photoshop

Pictorial photography, 89

Pixellated image, 173

Pixels, 164, 171, 220

 pixel dimensions, 172

 pixels per inch (ppi), 171

Polarising filters, 94, 220

Political photomontage, 62–3

 techniques, 63

Portable Document Format (PDF), 175

Portraiture, 102–9

 design, 103–5

  composing people, 104

  depth of field, 105

  focal length, 105

  format, 103

 directing the subject, 108

 in photographic stories, 120

 photographing strangers, 107

 portrait lens, 220

 portrait mode, 105, 220

 revealing character, 106, 109

Posterization, digital, 81

 colour image, 81

Presentation, 8

 of finished work, 4

 of research, 4

Preview master creation, 193

Previsualise, 220

Primary colours, 168

Print manipulation, 44

Print preview, 192

Printers:

 optimum image resolution calculation, 175

 output file formats, 175

 output resolution, 173

 settings, 193

Printing, 160–1

 burning in, 160

 holding back/dodging, 160

 See also Digital darkroom; Processing

Prints:

 negative, 75

 Sabattier, 75, 76

Processing:

 film, 152–5

 print, 156–7

  contrast control, 157

  health and safety, 156

  resin coated (RC) paper, 156

  test strips, 157

 push-processing, 220

 quality control, 162

Processor speed, 220

Proof sheets, 158–9

Publicity, 10

Push-processing, 220

Random access memory (RAM), 220

Reaction, 8

Realism, 90

Reflection, 73

Reflector, 220

Refraction, 73, 220

Rejlander, Oscar Gustave, 61

Resampling image, 220

Research, 3

 presentation of, 4

Resin coated (RC) paper processing, 156

Resolution, 171–6, 220

 monitor, 199

 output resolution:

  optimum image resolution calculation, 175

  pixel size and, 172

 print quality and, 171

 scanning resolution, 176

Resources, 3

RGB (red, green and blue) images, 166, 189, 220

Riis, Jacob, 114
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Ringaround creation, 194

Rothstein, Arthur, 97

Rubber stamp tool, 220

Rule of thirds, 18, 25, 220

Sabattier effect, 75

 digital, 82

Sabattier prints, 76

Safelight, 197

Sandwiching negatives, 75

Saturation, 168, 220

Saving images, 187

Scanning, 179–80

 resolution, 176

 specifications, 179–80

Secondary colours, 168

Selective developing/fixing, 75

Selective focus, 221

Self image, 51–5

 beauty, 53

 classifications, 52

 conformity, 54–5

Self-expression, 9

Self-timer, 221

Sharpening the image, 186

Shortcuts, 198, 201, 208

Shutter, 146, 221

Shutter priority (Tv), 149, 221

Shutter speed, 146

 equipment limitations, 39

 fast shutter speeds, 39, 42, 48

 slow shutter speeds, 41, 42, 48

Silhouette, 221

Similes, 9

Sky, recording of, 94

Skylight filter, 221

Sliders, 221

Slow film, 221

Slow-sync flash, 46, 48

SLR (single lens reflex) cameras, 140, 141, 221

 automated features, 144

Smith, W. Eugene, 115

Soft light, 29, 221

Standard lens, 221

Steep perspective, 73, 221

Stieglitz, Alfred, 90, 92

Stopping down, 33, 221

Storage of work, 4

Stories, See Photographic stories

Story-board, 121

Strand, Peter, 90

Strangers, photographing, 107

Stryker, Roy, 91

Studio lighting, 34

Subject, 14

 directing, 108

 photographic stories, 116

 placement of, 18

Subjective analysis, 5, 221

Suggested line, 20

Surrealism, 65

Symbols, 9

Symmetry, 19

Sync lead, 221

Sync speed, 221

 slow-sync flash, 46, 48

System software, 221

Target White Point, 190, 199–200

Telephoto lenses, 73, 222

Test strips, 157, 158

Through the lens (TTL) light meters, 147–9, 222

 automatic TTL exposure modes, 147

 centre-weighted metering, 147

 dominant tones, 149

 matrix metering, 147

Thyristor, 45

Tiff format, 170, 175, 222

Time, 37–46

 darkroom manipulation, 44

 decisive moment, 38, 216

 equipment limitations, 39

 fast shutter speeds, 39, 42, 48

 multiple exposures, 43

 panning, 40

 semi-automatic limitations, 44

 slow shutter speeds, 41, 42, 48

 slow-sync flash, 46, 48
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 very long exposures, 42

 zooming, 44

Tonality adjustment, 180–2

 weak histogram correction, 182

Toning, 75

Tungsten light, 222

Unsharp Mask filter, 186, 222

Uprating film, 222

UV filter, 222

Vantage point, 22, 25, 129, 222

 use of in landscapes, 96

Variations, 182, 183

Vertical lines, 20, 222

Virtual memory, 222

Visual communication, 116–17

Wide-angle lenses, 73, 222

Working space, 190

X-sync, 222

Zip drive, 165

Zoom lens, 222

Zooming, 44, 73, 222
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